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Legal Notice 
©2018 Orion Health Group of Companies. All rights reserved. Trademarks displayed in 
this document are the property of Orchestral Developments Limited or their respective 
owners, and may not be used without written permission of the owner. 

Oracle®, Sun®, Solaris®, Java®, JavaScript™ and iPlanet™ are either registered 
trademarks or trademarks of Oracle Corporation and/or its affiliates. Microsoft®, 
Windows®, Windows® NT, Visual Basic®, Internet Explorer®, Microsoft® Edge, Visual 
Studio®, SQL Server®, ActiveX® and Windows Server® are either registered trademarks 
or trademarks of Microsoft Corporation in the U.S. and/or other countries. UNIX® is a 
registered trademark of The Open Group. Adobe®, Acrobat®, Reader® and Flash® 
Player are either registered trademarks or trademarks of Adobe Systems Incorporated in 
the U.S. and/or other countries. Linux® is a registered trademark of Linus Torvalds in the 
U.S. and other countries. IBM®, AS/400®, AIX® and WebSphere® are registered 
trademarks of International Business Machines Corporation in the U.S. and other 
countries. Mozilla® and Firefox® are registered trademarks of the Mozilla Foundation. Mac 
OS®, Apple®, iPad®, iPhone®, iPod touch®, iTunes®, iCloud®, App Store® and Safari® 
are trademarks or service marks of Apple Inc., registered in the U.S. and other countries. 
IOS® is a registered trademark of Cisco in the U.S. and other countries and used under 
license by Apple Inc. Android™, Google Play™ and Chrome™ are trademarks of Google 
Inc. SPARC® is a registered trademark of SPARC International, Inc. Products bearing 
SPARC trademarks are based on an architecture developed by Sun Microsystems, Inc.  
Citrix®, MetaFrame® and ICA® are registered trademarks of Citrix Systems, Inc. and/or 
one or more of its subsidiaries, and may be registered in the U.S. Patent and Trademark 
Office and in other countries. Sybase® is a registered trademark of SAP SE in Germany 
and in several other countries. InstallAnywhere® is a registered trademark of Flexera 
Software LLC. PathSpeed™ is a trademark of General Electric Company or its 
subsidiaries. Micro Focus® and Verastream® are trademarks or registered trademarks of 
Micro Focus (IP) Limited or its subsidiaries in the U.K., U.S. and other countries. Nuance® 
and SpeechMagic™ are either registered trademarks or trademarks of Nuance 
Communications, Inc. in the U.S. or other countries. OpenIAM™ is a trademark of 
OpenIAM LLC. SentriNET™ is a trademark of Informer Systems Limited. Red Hat® is a 
registered trademark of Red Hat, Inc. in the U.S. and other countries. Novell® is a 
registered trademark of Novell, Inc., in the U.S. and other countries. HP is a registered 
trademark that belongs to Hewlett-Packard Development Company, L.P. Ubuntu® is a 
registered trademark of Canonical Ltd, Elasticsearch is a trademark of Elasticsearch BV, 
registered in the U.S. and in other countries. 

Orion Health™ documentation is an independent publication and has not been authorized, 
sponsored, or otherwise approved by Apple Inc., Google Inc. or any other third party. 

This document is provided subject to the terms of the license and support agreement 
relating to the software application. Orchestral Developments Limited has made 
reasonable efforts to ensure that all information contained in this document is accurate, 
but no liability is accepted by Orchestral Developments Limited, its agents or suppliers for 
use of the documentation by the end user or any other party. 

Orion Health™ applications employ third party software components, each of which is 
subject to its own license terms. These licenses and any associated documentation are 
included with the installed product. 
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The UMLS Metathesaurus License (or such other licenses as may be required by local 
terminology vendors) may apply to the use of data accessed by this software application. 
Please refer to https://uts.nlm.nih.gov/license.html for the UMLS Metathesaurus License 
text. 

Questions or concerns relating to this documentation should be addressed to the supplier 
from whom the product was obtained. 

Disclaimer 

All patient identifiers, contact details and medical conditions represented in the 
screenshots and presentations shown in this document are fictitious to the best 
knowledge of Orion Health™, and do not relate to a real person or persons. 

The screenshots and presentations shown are intended as examples only, and may 
differ from the actual screenshots and presentations generated by the released 
product in commercial production. 

 

  

https://uts.nlm.nih.gov/license.html
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Revision Summary 

Software 
Release 

Document 
Version 

Date Nature of Amendment 

7.3 1.0 May 8, 
2018 

General Availability release. 

• Added Metrics. 

• Added Configuring Metrics for Notifications. 

• Added Configuring Communicate Webmail 
for Notifications. 

• Added Notifications Workflow of a Typed 
Clinical Event with Multiple Event Types. 

• Updated the diagram in Notifications 
Workflow of an Event with Multiple 
Notification Types. 

• Updated diagram and instructions in 
Enabling Performance Monitoring Using 
JAMon. 

 

Refer to Printable Documents to download printable versions of the documentation. 

 

https://doki.orionhealth.com/display/NOT73/Printable+Documents
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Introduction to the Administration Manual 

This manual is aimed at systems administrators who have to configure and maintain the 
Notifications application as part of the HIE Solution Package. 
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About this Manual 

This manual describes Notifications and how to configure and maintain addresses, 
relationships, delivery channels, events, notifications, standard subscriptions, and 
receiving EMR systems. It is aimed at Systems Administrators who have to manage and 
configure Notifications. It is assumed that readers: 

• Have basic database administration skills. 

• Are familiar with the configuration and management of Clinical Portal. 

Typographical Conventions. The following typographical conventions are used throughout 
this manual and in the application's help screens. 

Convention Description 

< > Angle brackets identify variables that you must supply. Do not type the angle 
brackets. 

[ ] Square brackets represent an optional item. If an item is not marked with 
square brackets, it is required. Do not type the square brackets. 

monospace Monospace type indicates directory names, path names and file names. 

bold Boldface type indicates button names and menu commands. 

 Points out Important information. 

 Cautionary advice to take note of something crucial. 

 Highlights additional information which may be relevant or noteworthy. 

 Highlights a helpful tip. 

 

Save 

Save 
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About Notifications 

 

Notifications enables healthcare organizations to notify recipients of specified events for 
patients. For example, when the patient visits the organization or has new results or 
documents. Recipients can be an internal or external healthcare provider, patient, or 
patient's guardian. 

The recipients control the notification by subscribing to events they wish to be notified 
about and determining the delivery method for each subscription. The recipient can also 
decide whether to receive summary notifications instead of individual notifications. 

The purpose of providing Notifications to recipients is to keep them informed of the 
patient's progress and availability of some patient records, thus encouraging the recipients 
to refer their patients to the organization. 

The administrator modifies Clinical Portal users and groups in Clinical Portal. Refer to 
Integration with Providers in Clinical Portal for details. 

All other administration tasks are carried out in Orion Health™ Platform (Platform). 

Quick Guide 

I want to ... 

• Configure a Relationship Type 

• Configure the Delivery Channel 

• Configure the Event Types 

• Configure the Notification 

• Configure the Notification Message 

• Configure Rhapsody to support the new notification 

 

 

 

Clinical Event Models 

Notifications includes new clinical event models for Encounter, ImagingReport, 
LaboratoryObservation, and TranscribeDocument events. These clinical event models are 
part of the default configuration for Notifications and are distinguished from the old models 
by Event 8.7 or LabEvent 8.7 appended to the event name. The legacy event models 

come as an attachment that can be manually imported. 

Dictionary-Based Event Types Clinical Event-Based Event Types 

Appointment  
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Dictionary-Based Event Types Clinical Event-Based Event Types 

Encounter (legacy) EncounterEvent 8.7 

ImagingReport (legacy) ImagingReport - LabEvent 8.7 

LaboratoryObservation (legacy) LaboratoryObservation - LabEvent 8.7 

TranscribeDocument (legacy) TranscribeDocument - LabEvent 8.7 

The Clinical Event Bus enables the health component responsible for storing patient data 
to publish events and describe the change in data in the form of Clinical Events. Other 
components connected to the bus can then monitor these event, and remain up-to-date 
with any change in patient data. 

For the most part, the new clinical event models contain the same attributes as their 
matching legacy event models with only a few instances where legacy fields are not 
available. Refer to the following sections for field mappings: 

• Mapping from Encounter to EncounterEvent 8.7 

• Mapping from ImagingReport to ImagingReport - LabEvent 8.7 

• Mapping from LaboratoryObservation to LaboratoryObservation - LabEvent 8.7 

• Mapping from TranscribeDocument to TranscribeDocument - LabEvent 8.7 

Rather than being mutable dictionary models, the clinical event models are created based 
on the structure of the underlying clinical event data and contains all fields stored by CDR. 
During processing, the clinical event models bypass Rhapsody when mapping an HL7 
message to an XML event model, removing the need to implement mappings of HL7 
messages to XML event model in Rhapsody. For CDR mappings of the HL7 message 
format to the clinical event model, refer to Encounter Clinical Event Mapping and 
Laboratory Report Event in the Clinical Data Repository Administration Manual. 

These tables are too wide to print in PDF format. A printable version is available as an 
Excel spreadsheet. Click here to download the spreadsheet. 

 

Mapping from Encounter to EncounterEvent 8.7 

Legacy 
Attribute 

Legacy 
Data Type 

Legacy 
HL7 
segments 

Current 
Attribute 

Current Data Type Current HL7 
segments 

Encounter
Type 

LOOKUP(en
counter_look
up) 

MSH-9 
Message 
Type 

encounter
Type 

LOOKUP(Encounte
rType) 

PV1-2 Patient Class 

PatientCla
ss 

LOOKUP(pa
tientclass_lo
okup) 

PV1-2 
Patient 
Class 

encounter
State.cod
e 

STRING ADT State Validation 

https://doki.orionhealth.com/display/CDR87/Encounter+Clinical+Event+Mapping
https://doki.orionhealth.com/display/CDR87/Laboratory+Report+Event
https://doki.orionhealth.com/display/NOT73/Printable+Documents
https://doki.orionhealth.com/display/CDR87/ADT+Encounter+Processing#ADTEncounterProcessing-ADTStateValidation


Notifications 7.3.0 | Administration Manual v1.0  

 
 ____________________________________________________________________________________________________________  

 

 ____________________________________________________________________________________________________________  

Printed copies of this document may be out of date. Please refer to https://doki.orionhealth.com for the latest updates. 

© Copyright 2018 Orion Health Group of Companies | All rights reserved 13 

Legacy 
Attribute 

Legacy 
Data Type 

Legacy 
HL7 
segments 

Current 
Attribute 

Current Data Type Current HL7 
segments 

Admission
DateTime 

DATE_TIME PV1-44 
Admit 
Date/Time 

admitDat
eTime 

DATE_TIME PV1-44 Admit 
Date/Time 

Discharge
DateTime 

DATE_TIME PV1-45 
Discharge 
Date/Time 

discharge
DateTime 

DATE_TIME PV1-45 Discharge 
Date/Time 

AdmitRea
son 

LOOKUP(ad
minreason_l
ookup) 

PV2-3 
Admit 
Reason 

admitRea
son 

LOOKUP(com.orch
estral.health.encou
nter.api_8_1.domai
n.AdmitReason) 

PV2-3 Admit Reason 

Discharge
Dispositio
n 

LOOKUP(di
schargedisp
osition_look
up) 

PV1-36 
Discharge 
Disposition 

N/A N/A N/A 

Location-
PointOfCa
re 

STRING PV1-3 
Assigned 
Patient 
Location 

ward LOOKUP(com.orch
estral.health.encou
nter.api_8_1.domai
n.Ward) 

PV1-3 Assigned 
Patient Location 

 

Mapping from ImagingReport to ImagingReport - LabEvent 8.7 

Legacy 
Attribute 

Legacy 
Data Type 

Legacy HL7 segments Current 
Attribute 

Current 
Data 
Type 

Current HL7 
segments 

Originating
System 

STRING MSH-3 
SendingApplication.Universal
ID^SendingApplication.Unive
rsalIDType 

authoring
Applicatio
n 

String MSH-3 
SendingAppli
cation.Univer
salID only 

PatientClas
s 

patientclas
s_lookup 

PV1-2 PatientClass N/A N/A N/A 

ReportNam
e 

STRING OBR-4 UniversalServiceID testCode Laborator
yTest 

OBR-4 
UniversalSer
viceID 

ReportType STRING OBR-4 UniversalServiceID testCode Laborator
yTest 

OBR-4 
UniversalSer
viceID 
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Legacy 
Attribute 

Legacy 
Data Type 

Legacy HL7 segments Current 
Attribute 

Current 
Data 
Type 

Current HL7 
segments 

Observation
DateTime 

DATE_TIM
E 

OBR-7 
ObservationDateTime 

collection
StartDate
Time 

PartialDat
e 

OBR-7 
Observation
DateTime 

ResultsRep
orted-
StatusChan
gedDateTi
me 

DATE_TIM
E 

OBR-22 Results Rpt/Status 
Chng - Date/Time 

reportedD
ateTime 

PartialDat
e 

OBR-22 
Results 
Rpt/Status 
Chng - 
Date/Time 

ReportStatu
s 

reportstatu
s_lookup 

OBR-25 Result Status resultStat
us 

Laborator
yResultSt
atus 

OBR-25 
Result 
Status 

Abnormality
Indicator 

abnormal_l
ookup 

Picks up the most serious 
indicator from all OBX-8 
AbnormalFlags 

Abnormal
Interpreta
tion 

Laborator
yInterpret
ation 

First of OBX-
8 
AbnormalFla
gs 

Diagnostics
ServiceSect
ionID 

Diagnostic
ServSect_l
ookup 

OBR-24 Diagnostic Serv 
Sect ID 

reportTyp
e 

String OBR-24 
Diagnostic 
Serv Sect ID 

Location-
PointOfCar
e 

STRING PV1-3 Assigned 
PatientLocation.PointOfCare 

N/A N/A N/A 

 

Mapping from LaboratoryObservation to LaboratoryObservation - 
LabEvent 8.7 

Legacy 
Attribut
e 

Legacy 
Data 
Type 

Legacy HL7 
segments 

Current 
Attribute 

Current Data Type Current 
HL7 
segments 

Originati
ngSyste
m 

STRING MSH-3 
SendingApplication.Uni
versalID^SendingAppli
cation.UniversalIDType 

authoring
Applicati
on 

String MSH-3 
SendingA
pplication.
UniversalI
D only 

PatientCl
ass 

Lookup 
(patientcl
ass_look
up) 

PV1-2 PatientClass N/A N/A N/A 
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Legacy 
Attribut
e 

Legacy 
Data 
Type 

Legacy HL7 
segments 

Current 
Attribute 

Current Data Type Current 
HL7 
segments 

ReportN
ame 

STRING OBR-4 
UniversalServiceID 

testCode Lookup 
(com.orchestral.health.r
esults.api_8_1.domain.
LaboratoryTest) 

OBR-4 
Universal
ServiceID 

ReportTy
pe 

STRING OBR-4 
UniversalServiceID 

testCode Lookup 
(com.orchestral.health.r
esults.api_8_1.domain.
LaboratoryTest) 

OBR-4 
Universal
ServiceID 

Observat
ionDateT
ime 

DATE_TI
ME 

OBR-7 
ObservationDateTime 

collection
StartDate
Time 

DATE_TIME OBR-7 
Observati
onDateTi
me 

ResultsR
eported-
StatusCh
angedDa
teTime 

DATE_TI
ME 

OBR-22 Results 
Rpt/Status Chng - 
Date/Time 

reported
DateTim
e 

DATE_TIME OBR-22 
Results 
Rpt/Status 
Chng - 
Date/Time 

ResultSt
atus 

Lookup 
(reportsta
tus_looku
p) 

OBR-25 Result Status resultStat
us 

Lookup 
(com.orchestral.health.r
esults.api_8_1.domain.
LaboratoryResultStatus
) 

OBR-25 
Result 
Status 

Abnorma
lityIndica
tor 

Lookup 
(abnorma
l_lookup) 

Picks up the most 
serious indicator from 
all OBX-8 
AbnormalFlags 

Abnormal
Interpreta
tion 

Lookup 
(com.orchestral.health.r
esults.api_8_1.domain.
LaboratoryInterpretation
) 

First of 
OBX-8 
Abnormal
Flags 

Diagnost
icService
SectionI
D 

Lookup 
(Diagnost
icServSe
ct_lookup
) 

OBR-24 Diagnostic 
Serv Sect ID 

service STRING OBR-24 
Diagnostic 
Serv Sect 
ID 

Location-
PointofC
are 

STRING PV1-3 Assigned 
PatientLocation.PointO
fCare 

N/A N/A  

Tests.Te
stName 

Lookup 
(laborator
ytest_loo
kup) 

OBX-3 Observation 
Identifier 

results.te
stCode 

com.orchestral.health.r
esults.api_8_1.domain.
LaboratoryTest 

OBX-3 
Observati
on 
Identifier 
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Legacy 
Attribut
e 

Legacy 
Data 
Type 

Legacy HL7 
segments 

Current 
Attribute 

Current Data Type Current 
HL7 
segments 

Tests.Te
stValue 

Composit
e 

OBX-5 Observation 
Value (more 
complicated 
processing, see 
Rhapsody mapping) 

results.va
lueDataT
ype 
results.va
lue 

String 
String 

OBX-2 
ValueTyp
e 
OBX-5 
Observati
on Value 

Tests.Ab
normalFl
ag 

Lookup 
(abnorma
l_lookup) 

OBX-8 Abnormal Flags 
(each flag mapped to 
one 
Tests.AbnormalFlag) 

results.pr
incipalInt
erpretatio
n 

Lookup 
(com.orchestral.health.r
esults.api_8_1.domain.
LaboratoryInterpretation
) 

First 
abnormal 
flag from 
OBX-8 
Abnormal 
Flags 

 

Mapping from TranscribeDocument to TranscribeDocument - LabEvent 
8.7 

Legacy 
Attribut
e 

Legacy 
Data Type 

Legacy HL7 
segments 

Curren
t 
Attribu
te 

Current Data Type Current 
HL7 
segment
s 

Originati
ngSyste
m 

STRING MSH-3 
SendingApplication.U
niversalID^SendingAp
plication.UniversalIDT
ype 

authori
ngAppli
cation 

STRING MSH-3 
SendingA
pplication
.Universal
ID only 

PatientC
lass 

LOOKUP(p
atientclass_
lookup) 

PV1-2 PatientClass N/A N/A N/A 

ReportN
ame 

STRING OBR-4 
UniversalServiceID 

testCo
de 

LOOKUP(com.orchestral.
health.results.api_8_1.do
main.LaboratoryTest) 

OBR-4 
Universal
ServiceID 

ReportT
ype 

STRING OBR-4 
UniversalServiceID 

testCo
de 

LOOKUP(com.orchestral.
health.results.api_8_1.do
main.LaboratoryTest) 

OBR-4 
Universal
ServiceID 

Oberser
vationDa
teTime 

DATE_TIM
E 

OBR-7 
ObservationDateTime 

collecti
onStart
DateTi
me 

DATE_TIME OBR-7 
Observati
onDateTi
me 
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Legacy 
Attribut
e 

Legacy 
Data Type 

Legacy HL7 
segments 

Curren
t 
Attribu
te 

Current Data Type Current 
HL7 
segment
s 

Results
Reporte
d-
StatusC
hanged
DateTim
e 

DATE_TIM
E 

OBR-22 Results 
Rpt/Status Chng - 
Date/Time 

reporte
dDateT
ime 

DATE_TIME OBR-22 
Results 
Rpt/Statu
s Chng - 
Date/Tim
e 

ReportSt
atus 

LOOKUP(re
prtstatus_lo
okup) 

OBR-25 Result 
Status 

resultSt
atus 

LOOKUP(com.orchestral.
health.results.api_8_1.do
main.LaboratoryResultSt
atus) 

OBR-25 
Result 
Status 

Diagnost
icServic
eSection
ID 

LOOKUP(Di
agnosticSer
vSect_looku
p) 

OBR-24 Diagnostic 
Serv Sect ID 

reportT
ype 

STRING OBR-24 
Diagnosti
c Serv 
Sect ID 

Location
-
PointOf
Care 

STRING PV1-3 Assigned 
PatientLocation.Point
OfCare 

N/A N/A N/A 

 

Notifications Workflow Process 

This section provides an overview of the Notifications workflow. 

 

The following workflow applies to Notifications with Clinical Event support: 

1. A health component stores or changes a patient's data and publishes a clinical 
event describing the current status of this patient's data. 

2. Notifications listens to all clinical events. If there is an Event Type configured for 
Clinical Event that was sent (refer to Configuring Event Types for details), the 
processing continues. Otherwise, the Clinical Event is ignored and processing of 
the Clinical Event stops here. 

3. The Clinical Event is consecutively converted to all Event Types that are configured 
for it, and these Event Types are processed individually. 
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The following workflow applies to Notifications without Clinical Event support 
(assumes patient-centric notifications): 

1. Notifications receives a trigger message from Rhapsody. 

2. Notifications attempts to match the trigger message against the Event Types 
(based on their underlying Dictionary model) configured in Orion Health Platform. If 
there is no matching Event Type, processing stops here. 

3. When an Event Type (based on its Dictionary model) matches the triggered 
message, the data is deserialized. 

 

 

 

 

The following workflow is common to Notifications with or without Clinical 
Event support: 

1. The patient referenced in the message is checked. The patient is looked up in the 
Identity Service and the patient summary in the message is updated accordingly. If 
the patient is not found using Identity Service, processing stops here. 

This may be tested by using the Identity Search screens in Platform. You 
must search for both namespace and ID. 

2. The message is matched against rules of all Notifications based on that particular 
Event Type. 

3. The list of recipients of the notification is built from these sources: 

o The Relationship store is searched for people who have a relationship with 
the patient such as providers. 

o Additional recipients are extracted from the message using Message 
Content Resolvers. 

4. The list of matched recipients is pushed through the identity service to determine 
whether the system actually knows about the providers. 

5. These recipients are pushed through Portal's privacy rules (entity privacy). 
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6. The subscription details of the recipients in the list are retrieved. Recipients without 
relevant subscriptions are ruled out at this point. 

7. If there are any recipients left, Notifications generates a final notification message 
for each recipient using the delivery channel the recipient is subscribed to. The 
message is then passed to the delivery channel. 

8. The delivery channel delivers the message. If the message is successfully 
delivered through the primary channel, only then it is sent to the secondary 
channels. 

There are two types of delivery channels: 

o Hard-wired such as an SMTP channel 

o Those relying on Rhapsody to deliver the message 

 

 

 

Notifications Workflow of a Typed Clinical Event with Multiple Event 
Types 

Notifications allows a recipient to subscribe to notifications within Clinical Portal. 
Depending on how the rules are configured, Notifications can send more than one 
notification message to different recipients. 

The following diagram illustrates a sample typed clinical event and how notification 
messages are sent out to different recipients. 

This diagram does not apply to XML-based events. 
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Workflow 
State 

Description 

1 An Encounter event is triggered. 

2 Notifications checks if there are any notification event types configured for the 
Encounter event. 

In this example, the following event types are configured for Encounter event: 

• Discharge Encounter for Patient - This event type is configured for the 
Patient audience. 

• Discharge Encounter for Clinician - This event type is configured for 
the Clinician audience. 

Audiences groups event types for different sets of users such as 
clinicians, patients, and administrators. Refer to Configuring Audiences 
for details. 

 

3 Notifications checks if there are any notification types that match the event 
type. Notifications evaluates the rules against Discharge Encounter for 
Patient and Discharge Encounter for Clinician event types to resolve the 
notification types that match the event. 

• Transfer Notification - Notifications matches the notification rules for 
Transfer Notification notification type. 

• Inpatient Transfer for Patient - Notifications matches the notification 
rules for Inpatient Transfer for Patient notification type. 

For a notification to be triggered, all criteria in the notification rules must 
be met. It is therefore important that the notification rule must contain 
complete and specific conditions so correct notifications are triggered as 
events occur. Refer to Configuring Notifications for details. 

 

4 Notificationsidentifiesthe recipients who are subscribed to these notification 
types. Notifications then generates the notification message for each 
recipient. 

In this example, there are two subscribers identified to receive these event 
types: 

• Recipient 1: Notification message for Patient Jane Doe is generated. 

• Recipient 2: Notification message for Clinician John Smith is 
generated. 

Notification messages vary depending on how the message formats are 
configured using the Template Processor. Refer to Template Processor 
Format Examples for details. 

 



Notifications 7.3.0 | Administration Manual v1.0  

 
 ____________________________________________________________________________________________________________  

 

 ____________________________________________________________________________________________________________  

Printed copies of this document may be out of date. Please refer to https://doki.orionhealth.com for the latest updates. 

© Copyright 2018 Orion Health Group of Companies | All rights reserved 21 

Workflow 
State 

Description 

5 The subscribed delivery channel delivers the notification messages to the 
recipients. 

• Recipient 1: Notification message is sent to Patient Jane Doe. 

• Recipient 2: Notification message is sent to Clinician John Smith. 

 

 

Notifications Workflow of an Event with Multiple Notification Types 

Notifications allows a recipient to subscribe to notifications within Clinical Portal. 
Depending on how the rules are configured, a clinical event can trigger multiple notification 
types. Each recipient receives one notification message, containing details of one or more 
notification types. 

The following diagram illustrates a sample clinical event which matches multiple 
notification types: 

 

 

Workflow 
State 

Description 

1 A Lab Result clinical event is triggered. 

2 Notifications checks if there are any notification types configured for the Lab 
Result clinical event. Notifications evaluates the notification rules against Lab 
Result to resolve the notification types that match the event. 

In this example, the Lab Result clinical event matches the following 
notification types: 

• Final Lab Result Available 

• Radiology Result Available 
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Workflow 
State 

Description 

The notification rules configured for each notification determine when the 
notification should trigger. A notification rule is made up of one or more 
rule sets, and rule sets are made up of one or more rule conditions. 
Refer to Configuring Notifications for details. 

 

3 Notifications identifies the list of recipients subscribed to these event types. 

In this example, there are two subscribers identified to receive these event 
types: 

• Recipient 1: Jane Doe is subscribed to Final Lab Result Available 
notification type. 

• Recipient 2: John Smith is subscribed to Final Lab Result Available 
and Radiology Result Available notification types. 

 

4 Notifications retrieves the subscription details and then generates the 
notification message for each recipient. 

In this example, the following notifications are generated for the following 
recipients based on the notification rules configured: 

• Recipient 1: A notification is generated for Jane Doe containing the 
Final Lab Result Available notification. 

• Recipient 2: A notification is generated for John Smith containing the 
Final Lab Result Available and Radiology Result Available notifications. 

Jane Doe who is subscribed only to Final Lab Event Result Available receives 
one notification message containing information about the Final Lab Result 
Available notification type. John Smith who is subscribed to both Final Lab 
Result Available and Radiology Result Available receives one notification 
message containing information about the two notification types. When 
Notifications generates the notification message, it will generate the message 
based on the user's subscription and the detailed message configuration of 
the event. 

Refer to Configuring Event Types for details. 

• For a notification to be generated, all criteria in the notification rule 
must be met. It is therefore important that the notification rule must 
contain complete and specific conditions so correct notifications are 
triggered as events occur. 

• Notification messages vary depending on how the message 
formats are configured using the Template Processor. Refer to 
Template Processor Format Examples for details. 
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Workflow 
State 

Description 

 

 

5 The selected delivery channel delivers the notifications to the recipients. 

The administrator can configure the delivery channels that Notifications 
supports. Refer to Configuring Notification Delivery Channels for details. 

The notification message has the following types: 

• A secure message usually contains all the relevant patient 
information of the notification, and must be delivered by a secure 
method. When sending notifications through a secure delivery 
channel, the message will contain all data available in the original 
event. Refer to Secure Message for details. 

• A non-secure message does not contain any patient information 
and is delivered by a non-secure method. Refer to Non-Secure 
Message for details. 

 

 

 

 

 

https://doki.orionhealth.com/display/NOT73/Secure+Message
https://doki.orionhealth.com/display/NOT73/Non-Secure+Message
https://doki.orionhealth.com/display/NOT73/Non-Secure+Message
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Accessing Orion Health Platform 

 

Administering and configuring Notifications is carried out in Orion Health Platform. 

1. Enter the URL, http://<server>:<port>/conductor, in your browser. 

You can look up the port number in the 
<HIE_HOME>/data/configuration/environment.properties file, 

tomcat.port.http property. 

Notifications is installed as a component of Orion Health™ Health Information 
Exchange (HIE). 

2. If you are logging on for the first time, select the Login button to set a password. 

 

 

3. Enter your new password twice, then select the Change button. 

 

The following screen is displayed: 



Notifications 7.3.0 | Administration Manual v1.0  

 
 ____________________________________________________________________________________________________________  

 

 ____________________________________________________________________________________________________________  

Printed copies of this document may be out of date. Please refer to https://doki.orionhealth.com for the latest updates. 

© Copyright 2018 Orion Health Group of Companies | All rights reserved 25 

 

 

4. The Orion Health Platform Configuration, Monitoring, and Platform menus are then 
available for use. 
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Integration with Providers in Clinical Portal 

 

Notifications can integrate with providers in Clinical Portal by loading provider information 
from Clinical Portal through the Identity service. 

The integration with providers in Clinical Portal includes the following: 

• Configuring Group Attributes with External Identifiers 

• Updating User Details 

Configuring Group Attributes with External Identifiers 

All providers addressing the information that Notifications uses are stored in Clinical Portal 
Group Attributes. When Notifications retrieves a provider from Clinical Portal through the 
Identity Service, these external identifier attributes can be retrieved as well. Refer to 
Creating or Deleting a Delivery Channel for details. 

Updating User Details 

An administrator can update Notifications details for any user in Clinical Portal, including 
any external identifier that has been configured. 

Adding an External Identifier in Clinical Portal 

1. Log in to Clinical Portal as an administrator. 

2. Navigate to Concerto > Configuration and select the Identity tab to check whether 
an identifier has been added. 
A list of available external identifiers is displayed. 

3. To add an external identifier, enter the name of the external identifier at the bottom of 

the panel and select the Add icon . 
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Adding an External Identifier to the Notifications User Details 

1. From Clinical Portal, navigate to Concerto > Users. 

2. Select the user whose details you want to update. The User External Identifiers panel 
is at the bottom of the User Details screen. 

3. Select the external identifier type from the drop-down list. 

4. Enter the user ID number to update the user details to include an external identifier. 
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Configuration 

Refer to the following sections to configure Notifications: 

• Adding Users to Notifications Group 

• Configuring Document Exchange 

• Configuring Event Types 

• Configuring Notification Delivery Channels 

• Configuring Notification Messages 

• Configuring Notifications 

• Configuring Relationship Types 

• Default Subscription Configurations 

• Configuring a Message Content Resolver 

• Configuring the Clinical Portal User Identity Source 

• Configuring Messaging 

• Configure Web Services 

• Configuring Integration Views 

• Configuring the My Subscriptions and User Subscription Entry Points 

• Configuring Audiences 

• Exporting and Importing Configuration Files 

• Configuring Metrics for Notifications 

• Configuring Communicate Webmail for Notifications 

 

Adding Users to Notifications Group 

When installing the HIE system components, the Clinicians and Notifications 
groups are added. This step involves adding existing users to these groups so they 
can access the notifications and subscriptions functionality. 

  

1. From Clinical Portal, navigate to Concerto > Users. The Concerto User Search 
screen is displayed, as shown in the following screenshot: 
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This screen displays the users that are set up during the installation of the core 
system components. By default, this list includes the administrator only. 

2. Select the first user you want to add to the HIE Groups. The User Details screen is 
displayed, as shown in the following screenshot: 
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3. From the Group Memberships panel, select Notifications In the Not a member 
of column. 

4. Select the Left Arrow icon . The Notifications group is listed in the Member Of 
column. 

5. Select the Update Preferences button. 

6. Repeat these steps until users are added to the Notifications groups. 

 

Configuring Document Exchange 

Document Exchange enables the transfer of documents to Electronic Medical Records 
(EMRs). 

Complete the following tasks to enable document exchange: 

• Configure Document Types 

• Configure Automated Document Exchange 

• Configure Manual Document Exchange 
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Configuring EMR Systems 

 

Notifications allows a health care provider to specify an Electronic Medical Record (EMR), 
where Notifications and event details are sent to. The administrator can configure multiple 
EMR systems and the document types it support. 

To configure an EMR system with a unique Id (OID), name, and the document types it 
supports, do the following: 

1. From Orion Health Platform, navigate to Configuration > Notifications and select 
Notifications (Advanced) from the left panel. 

2. Select the Receiving EMR System tab to display the EMR systems panel, as shown in 
the following screenshot: 

 

 

3. Complete configuring the EMR systems, as described in the following: 

o Adding and Deleting EMR Systems 

 

o Modifying EMR Systems 

Altering EMR configuration details (other than Display Names) almost always 
requires matching alterations to the Rhapsody configuration. Refer to EMR 
Integration with Rhapsody for details. 

 

 

Adding and Deleting EMR Systems 

 

Notifications allows a health care provider to specify an EMR where Notifications and 
Event Details are sent to. 

Adding an EMR System 

1. From Orion Health Platform, navigate to Configuration > Notifications (Advanced). 

2. Select the Add icon  and select New EMR System name from the drop-down list. 
This opens a Create an EMR system configuration dialog box. 
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3. Enter a unique Id (OID) for the new EMR system, and select the OK button to add the 
EMR system. 
This displays the EMR System Details panel. 

 

 

4. Enter the name of the EMR in the Display Name field. 

5. Select the document types the EMR system supports by selecting the checkbox in the 
Messaging Support list. Refer to Configuring Document Types for details. 

6. Select the Save button to save the EMR System details. 

Deleting an EMR System 

1. Select the EMR system and select the Delete icon . This opens the Confirm Delete 
dialog box. 

 

 

2. Select the Delete button to delete the EMR system. 
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Modifying EMR Systems 

 

Notifications allows a health care provider to specify an EMR where Notifications and 
Event Details are sent to. 

1. From Orion Health Platform, navigate to Configuration > Notifications (Advanced). 
This displays the Receiving EMR System tab with EMR systems listed in the left 
pane, as shown in the following screenshot: 

 

 

2. Select the name of the EMR system to display details of the EMR system in the right 
pane, as shown in the following screenshot: 

 

This screen has two sections: 

o EMR System Details - This allows you to update the Display Name field to 
rename the EMR System. 

o Messaging Support - This allows you to select the document types the EMR 
system supports. 

3. Select the Save button to save the changes to the EMR system. 

 

 

Configuring Document Types 

From the Notifications (Advanced) page, you can configure Document Types and the 
Document Generator in the Document Types tab. 

Document Types and Document Generator are necessary when exchanging documents 
from Notifications to the Electronic Medical Record (EMR) system. Document Types are 
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supported by the receiving EMR system. When a Notification is triggered, Document 
Types are validated in the Notifications Rhapsody Routes and handled accordingly by the 
route configuration. 

Complete the following tasks to configure document types and enable document 
exchange: 

1. Adding Document Types 

2. Adding Document Generators 

3. Associating Document Types to EMRs 

 

Adding Document Types 

Document Types help you define the available documents. Notifications supports 
Observation Result (ORU) and Continuity of Care (CCD) document types. Adding format 
code configuration is a part of adding Document Types. A format code determines the 
document type. 

Adding Document Types 

1. From Orion Health Platform, navigate to Configuration > Notifications. 

2. Select Notifications (Advanced) from the left panel. 

3. Select the Document Types tab. 

4. Select the Add icon . 

5. Select New Document Type from the list. 

6. Enter a unique document type ID in the Document Type ID field. 

 

 

7. Enter a unique document type name in the Document Type Name field. For example, 
enter Continuity of Care Document. 

8. Select the OK button. 

 

Adding Format Code Configuration 

1. Select the Add button from the Format Code Configurations section. 
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2. Enter the name for the coding system and code in the Format Code Configurations 
dialog box. For example, enter Notifications and CCD. 

3. Select the OK button. 

4. Select the Save icon  . 

 

Adding Document Generators 

1. From Orion Health Platform, navigate to Configuration > Notifications and select 
Notifications (Advanced) from the left panel. 

2. Select the Document Types tab. The Document Type panel is displayed. 

3. Select the Add icon  and select New Document Generator. 

4. Enter the document generator name in the Create a new Document Generator dialog 
box. For example, enter Generated CCD. 

 

 

5. Select the OK button. 

6. Enter a unique document generator repository name in the Document Generator 
Repository Name field. 
This name must match the name of an existing document generator repository name. 
For example, CCD Generator Document Repository. 

7. Select the Save icon . 
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Do not generate documents one after the other using the Document Generator 
because the time taken to generate multiple documents may delay the corresponding 
Notifications. 

 

Associating Document Types to EMRs 

To receive the documents, select the document types and the Electronic Medical Record 
(EMR) system where you want to receive the documents. 

1. From Orion Health Platform, navigate to Notifications > Notifications (Advanced) > 
Receiving EMR System and select an appropriate EMR System name. 

2. Select the checkbox next to the Document Type you have created for the receiving 
EMR system. 

3. Select the Save icon . 

 

Configuring Automated Document Exchange 

Automated Document Exchange enables the transfer of documents to Electronic Medical 
Records (EMRs). 

To set up the Automated Document Exchange feature, you need to do the following: 

• Set up the Prerequisite Features. 

• Configure Rhapsody Routes for Automated Document Exchange. 

• Configure Notifications to Exchange Documents. 

• Select the Send Associated Document To My EMR Option. 

• Check if the Automated Document Exchange is Working Correctly. 

 

Setting up the Prerequisite Features 

For the automated document exchange to work, you must set up other Orion Health HIE 
features. 

If you have not done so, you must set up CCDs. Refer to Generating and Sending CCDs 
in the HIE Administration Manual for details. 

You must also have configured some notifications. Refer to Configuring Notifications for 
details. 

 

Configuring Rhapsody Routes for Automated Document Exchange 

1. From the administration workstation, launch the Rhapsody IDE application. The initial 
screen is displayed. 

https://doki.orionhealth.com/display/ORS24/Set+up+Generation+and+Sending+of+CCDs
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2. Navigate to View > Rhapsody Variables Manager to display the Rhapsody 
Variables Manager screen. 

 

 

3. Configure the variables as shown in the following table: 

Name Value 

ConcertoKeyStorePassword myPassword 

ConcertoServerName For example, ohw7-lin64 

ConcertoServerName_Portal7 For example, ohw14-lin64 

EmailNotificationFromAddress For example, 
john.doe@orionhealth.com 

EmailSmtpServerName For example, zimbra.orion.internal 

NOT_Repository_Laboratory Orion - Clinical Data 

Repository/Numerical Laboratory 

Reports 

NOT_Repository_Microbiology Orion - Clinical Data 

Repository/Microbiology Reports 

NOT_Repository_Radiology Orion - Clinical Data 

Repository/Radiology Reports 
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Name Value 

NOT_Repository_TextLaboratory Orion - Clinical Data 

Repository/Text Laboratory 

Reports 

NOT_ConcertoServerName_Portal7 For example, 
<HostName>:<Port>/node1. 

NOT_emrOutputDir For example, 
/opt/orionhealth/CDRInput/Notif

ications/EmrOutput 

NOT_TestMsgRootDir For example, 
/opt/orionhealth/CDRInput/Notif

ications/TriggerMessageInput 

NOT_CDROriginalMessageOutboundPort For example, 63069. 

NOT_ConcertoKeyStorePassword For example, myPassword. 

NOT_ConcertoServerName  

NOT_DirectDocumentEmailBody Please find your document 

attached. 

NOT_DirectDocumentEmailSubject Document attached. 

NOT_DirectEmailNotificationFromAddress For example, direct@vld.com. 

NOT_DirectEmailSmtpServerName For example, zimbra.orion.internal. 

NOT_DirectEmailSmtpServerPassword  

NOT_DirectEmailSmtpServerUserName  

NOT_EmailNotificationFromAddress For example, 
<name>.<surname>@orionhealth.co

m. 

NOT_EmailSmtpServerName For example, zimbra.orion.internal. 

NOT_InputXmlTriggerEventMsgPort For example, 63007. 

NOT_messageProcessingId For example, P. 

NOT_OutputXmlNotificationMsgAsyncPort For example, 63009. 

NOT_OutputXmlNotificationMsgPort For example, 63008. 

NOT_portalVersion For example, 7. 

NOT_receivingFacilityNamespaceId For example, any. 

NOT_receivingFacilityUniversalId  
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Name Value 

NOT_receivingFacilityUniversalIdType  

NOT_RhapsodyEventEmailFromAddress For example, 
rhapsody@orionhealth.com. 

NOT_RhapsodyEventEmailToAddress For example, 
rhapsody@orionhealth.com. 

NOT_sendingApplicationNamespaceId For example, Rhapsody. 

NOT_sendingApplicationUniversalId  

NOT_sendingApplicationUniversalIdType  

NOT_sendingFacilityNamespaceId  

NOT_sendingFacilityUniversalId  

NOT_sendingFacilityUniversalIdType  

NOT_ServerName  

Portal Version 6x 
7 

4. Select the OK button. 

5. To enable the UserMessaging service in Orion Health Platform, navigate to 
Configuration > Web Services. Select the usermessagingservice and set Enabled 
to true. 

6. Start the Notification and Site Specific - Notifications components. 

Refer to Notifications Rhapsody Routes for additional details. 

When using Send to EMR feature, you will need to configure it. Refer to Configuring 
the Send to EMR Function and Customizing the Send to EMR Function for details. 

 

Configuring Notifications to Exchange Documents 

This task is required to configure Notifications to exchange documents. 

Electronic Medical Records (EMRs) can only exchange its supported types of 
documents. These are configured when you are adding an EMR. Refer to Adding 
Electronic Medical Records for details. 
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You can check which document types an EMR is set up to receive in Orion Health 
Platform by navigating to Configuration > Notifications > Notifications 
(Advanced) > Receiving EMR System tab. 

Configure a notification type by following the instructions in Configuring Notifications. In 
the Document to Exchange field, specify the types of document to be exchanged. 

 

Selecting the Send Associated Document To My EMR Option 

For the Automated Document Exchange to work, the clinician must select the Send 
Associated Document to my EMR option for the relevant notifications. 

1. Log in to Clinical Portal as the clinician, and navigate to Notifications > My 
Subscriptions to display the Subscriptions screen. 

 

 

2. Select the Change link on the specific notification you want to update and select the 
Send associated document to My EMR checkbox. 
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This option is available only for notifications configured to support Automated 

Document Exchange. These notifications display the  icon. 

3. Select the Save button. 

 

Checking if Automated Document Exchange is Working Correctly 

To check whether the HIE feature is working correctly, Orion Health recommends you to 
complete the following steps: 

• Specify how you want to receive patient updates; refer to Subscribing to 
Notifications for details. Select the Send any associated document to My EMR  
and Send any associated document to Direct options in the By Default 

section. 

• Specify the patient updates you want to receive; refer to Subscribing to Notifications 
for details. Select at least one information type. 

• Ensure an update of the selected type is generated, and check if is sent to the 
specified Electronic Medical Record (EMR) or secure channel, for example 
Direct. 

 

Configuring Manual Document Exchange 

Complete the following to configure manual document exchange: 

• Configuring EMR Systems 

 

Configuring the Send to EMR Function 

This section describes how to set up the system to send results to Electronic Medical 
Records (EMRs). 

To set up Send to EMR for Results: 

1. Complete the following steps, referring to the HIE Administration Manual: 

a. Configure EMRs for Results. 

b. Create Adhoc Database Pointing to Results. 

c. Create Document Repositories for Results. 

d. Configure Document Repositories for Results. 

2. When the prerequisite steps are completed, merge the SendToEMR.c6x.xml merge 

file. Refer to Download, Edit and Merge SendToEMR.c6x.xml File for details. 

3. Orion Health strongly recommends you to make sure the Send to EMR functionality is 
working correctly. Refer to Check Results are being Sent in the HIE Administration 
Manual for details. 

https://doki.orionhealth.com/display/NOT73/Subscribing+to+Notifications
https://doki.orionhealth.com/display/NOT73/Subscribing+to+Notifications
https://doki.orionhealth.com/display/NOT73/Subscribing+to+Notifications
https://doki.orionhealth.com/display/ORS24/Configure+EMRs+for+Results
https://doki.orionhealth.com/display/ORS24/Create+Adhoc+Database+Pointing+to+Results
https://doki.orionhealth.com/display/ORS24/Create+Document+Repositories+for+Results
https://doki.orionhealth.com/display/ORS24/Configure+Document+Repositories+for+Results
https://doki.orionhealth.com/display/ORS24/Check+Results+are+being+Sent
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In addition to these configuration tasks, you can also customize the Send to EMR 
feature. Refer to Customizing the Send to EMR Function for details. 

 

Enabling the SendToEMR Function in Clinical Portal 

This task enables the Send to EMR function in Clinical Portal by downloading, editing and 
merging the SendtoEMR.c6x.xml file. 

To download, edit, and merge the SendtoEMR.c6x.xml file: 

1. Download the file: 

a. From Orion Health Platform, navigate to Attachments to display the 
Attachments tab. 

 

 

b. Select the com.orchestral.notification.document.exchange module 

to display the Module panel for this module on the right: 
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c. In the Attachment panel, select the Send To EMR attachment under 

Concerto Portal Merge Files (text/portal-merge). 

d. Select the Download Selected link to download and save the file. 

2. Edit the file: 

a. Open the SendToEmr.c6x.xml file in a text editor, for example Notepad. 

b. Edit the file by specifying your system information as described in the following 
table: 

Existing String Enter This Information: 

ENTER APPLICATION NAME HERE This refers to the name of the 
application that contains your 
document repository. 

ENTER DOCUMENT REPOSITORY 

NAME HERE 
This refers to the name of your 
document repository. 

c. Save the updated file. 

3. Transfer the file from your desktop to the merge subdirectory on the Clinical Portal 

Application Server, for example ../<PortalInstallationDirectory/merge. 

4. Merge the file: 

a. In Clinical Portal, navigate to Concerto > Database Utilities.  

b. In the Merge drop-down list, select the .xml file that you want to merge.  
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c. Select the Merge button. 
The Merge Database From File dialog box is displayed. 

 

 

d. Ensure that all fields are selected. 
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e. Select the Merge button. 

 

Log off and log in again to refresh the Clinical Portal menus. 

 

Customizing the Send to EMR Function 

You can customize the Send to EMR function by doing the following: 

• Disabling the Send to EMR functionality - If you do not want the system to send 
information to a clinician's Electronic Medical Record (EMR) you can remove that 
delivery channel and remove the Send to EMR button so that it does not appear in 
Clinical Portal. Refer to Disabling the Send to EMR Function for details. 

• Associating Clinicians with EMRs - To associate clinicians with EMRs, refer to 
Associating Clinicians with EMRs for details. 

• Adding Electronic Medical Records (EMRs) - To add Electronic Medical Records 
(EMRs) you want to exchange documents with to the Orion Health HIE system, 
refer to Adding Electronic Medical Records for details. 

• Sending Results and generated CCDs to EMRs automatically - You can configure 
the system so that all relevant results and generated CCDs (or 'Patient Snapshots') 
are automatically sent to a clinician's Electronic Medical Record (EMR). Refer to 
Send CCDs, Results, and Documents to EMRs Automatically for details. 

 

Disabling the Send to EMR Function 

This section describes how to remove the Send to EMR option within Clinical Portal so 
clinicians cannot manually send information to their Electronic Medical Record (EMR). 

1. Remove the Send to EMR button from Clinical Portal: 

This step hides the Send to EMR button, so it is not available to users when they 
are viewing CCDs, results, or documents. 

a. From Clinical Portal, navigate to Concerto > Applications. The Applications 
screen is displayed. 

b. Select the Select icon to the left of the application that contains the document 
repositories used by Send to EMR. 

If you are using the default repositories, you must select the Select icon 

 to the left of Orion - Clinical Data Repository. 

The details for the selected application are displayed, an example is shown in 
the following screenshot: 
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c. Select the Document Repositories tab. 

 

 

d. Select the Select icon . For example, CCD Summary Repository 

e. Select the Control Bar tab. 
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f. In the Control Bar Buttons panel, select False into the Display field for Send 

to EMR. 

g. Select the OK button. 

h. If required, repeat these steps for the remaining document repositories. 

If you are using the default system setup, this includes: 

• Microbiology Reports 

• Numerical Laboratory Results 

• Outstanding Orders 

• Radiology Reports 

• Textual Laboratory Reports 

 

2. Hide the My EMR attribute: 

This step disables the My EMR field in the subscriptions page, so Clinicians 
cannot specify an Electronic Medical Record. 

a. From Clinical Portal, navigate to Concerto > Roles & Groups. 

 

 

b. Select the Select icon  to the left of Notifications. The Notifications screen 
is displayed: 
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c. In the Group Attributes panel, clear the Display checkbox for EMR. 

d. Select the OK button. 

3. Check that all Notifications are set not to exchange documents: 

a. From Orion Health Platform, navigate to Configuration > Notifications > 
Notifications. The Notifications tab is displayed. 

 

 

b. Select the first notification in the list. For example, A new document (imaging 
report) is available. The Notification Details panel is displayed. 
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c. In the Document To Exchange field, select None from the drop-down list. 

d. Select the Save icon . 

4. Disable the EMR Delivery Channel to hide the option of sending Documents on the My 
Subscriptions screen. 

a. From Orion Health Platform, navigate to Configuration > Notifications > 
Delivery Channels. The Delivery Channels tab is displayed. 

 

 

b. Select EMR to display the details to the right. 
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c. Clear the Channel enabled checkbox. 

d. Select the Save icon . 

 

Associating Clinicians with EMRs 

This step is only required if you intend to set up Electronic Medical Record (EMR) features. 
This is optional. 

Clinicians can be associated with an EMR in one of two ways: 

If you are... Refer to ... 

An Administrator Setting an EMR Association by an Administrator for details. 

A Clinician Setting an EMR Association by a Clinician for details. 

 

Setting an EMR Association by a Clinician 
1. From Clinical Portal, navigate to Notifications > Subscriptions. The subscriptions 

screen is displayed. 
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2. Complete the following fields: 

Field Description 

Direct Specify the e-mail address that has 
permission to send secure messages 
through the Direct system. For example, 
direct@lin64-1.com. 

This e-mail address has to be 
registered on the Direct server. 

 

My EMR Select the appropriate Electronic Medical 
Record (EMR). For example, Auckland 

Central. 

This list includes all of the 
Electronic Medical Records 
(EMRs) that have been set up 
in your Orion Health HIE 
system. If the EMR you want to 
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Field Description 

select is not listed, contact your 
system administrator. 

For more information about the 
other options on this screen, 
refer to Subscribing to 
Notifications. 

 

3. Select the Save button. 

 

Setting an EMR Association by an Administrator 
 

1. From Clinical Portal, navigate to Concerto > Users. The Users screen is displayed. 

2. Find the user that you want to associate with an EMR: 

a. Complete one or more of the search fields. 

b. Select the Search button. A list of matching users is displayed. 

3. Select the user. The details for that user are displayed: 

 

https://doki.orionhealth.com/display/NOT73/Subscribing+to+Notifications
https://doki.orionhealth.com/display/NOT73/Subscribing+to+Notifications
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4. If the user is not a member of the Notifications Group, add the user to that group: 

This step is important because the My EMR and Direct Mail fields, which are 
required to associate an EMR, are only displayed if the user is a member of the 
Notifications group. 

 

a. In the Not a member of column in the Group Memberships section, select 
Notifications: 

 

 

b. Select the left arrow . 

c. Select the OK button. 

5. Complete the following fields: 

Field Description 

My EMR Enter the OID for the relevant EMR. 

This field is only visible if the 
user is part of the Notifications 
group. To find out how to add 
users to the Notifications group, 
refer to Adding Users to 
Notifications Group for details. 

You can find a list of EMRs, 
and their associated OIDS in 
Orion Health Platform. In Orion 
Health Platform, select 
Notifications > Notifications 
(Advanced). Then select the 
Receiving EMR System tab. 
Select an EMR to display its 
details (including OID). 
For more information on how 
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Field Description 

receiving EMRs are set up, 
refer to Configure EMRs for 
CCDs and Configure EMRs for 
Results in the HIE 
Administration Manual for 
details. 

 

DirectEmail Specify the email address that has 
permission to send secure messages 
through the Direct system. 

This email address has to be 
registered on the Direct server. 

 

6. Select the OK button. 

 

Adding Electronic Medical Records 

For the Send function to Electronic Medical Records (EMR) to work, you must add the 
EMRs that you want to exchange documents with to the Orion Health HIE system. 

If you want to enable the Send to EMR functionality for Results (ORU messages) as 
well as CCDs, you are required to set up at least one additional document repository 
for those documents. Refer to Configure EMRs for Results in the HIE Administration 
Manual for details. 

To specify the Electronic Medical Record (EMR) systems that you want to be able to 
receive notifications: 

1. Obtain an OID for each EMR in the system: 

An Object Identifier (OID) is a unique global identifier. Only registered OIDs can 
be used. This identifier helps the system to distinguish between multiple 
Electronic Medical Records (EMRs). Refer to OID Repository - FAQ for details. 

2. Configure each EMR: 

a. From Orion Health Platform, navigate to Notifications > Notifications 
(Advanced). 

There are two versions of Orion Health Platform: 

https://doki.orionhealth.com/display/ORS24/Configure+EMRs+for+CCDs
https://doki.orionhealth.com/display/ORS24/Configure+EMRs+for+CCDs
https://doki.orionhealth.com/display/ORS24/Configure+EMRs+for+Results
https://doki.orionhealth.com/display/ORS24/Configure+EMRs+for+Results
https://doki.orionhealth.com/display/ORS24/Configure+EMRs+for+Results
http://www.oid-info.com/faq.htm#10
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• The first is installed on the Orion Health Platform Application server 
which was set up as part of setting up the system infrastructure. This 
version is used to configure and maintain the core system elements. 

• The second is installed on the Orion Health HIE Application Server. 
This version is used to configure and maintain the system elements 
that are unique to Orion Health HIE including Notifications. 

 

b. Select the Receiving EMR System tab. 

3. Select the Add icon . The Create a EMR system configuration dialog is displayed: 

 

 

a. Enter the OID for this EMR system. 

When specifying the OID, this value must not be changed once it is set. 
This is because documents are saved using this OID and if the OID is 
subsequently changed, future messages will be saved using the new OID. 

b. Select the OK button. An entry for the Receiving EMR system is created and 
listed. 

c. Select the newly created Receiving EMR system. The details for that system are 
displayed on the right side of the panel. 
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d. Complete the following fields: 

Field Description 

Display Name Enter a name for the Receiving EMR 
system. For example, Statewide EMR. 

OID This displays the OID that you specified 
when you created this entry. 

HL7 ORU Select this checkbox if the receiving 
system supports the HL7 messaging 
format. 

Continuity of Care(CCD) Select this checkbox if the receiving 
system supports the CCD messaging 
format. 

e. Select the Save icon . 

 

Sending CCDs, Results, and Documents to EMRs Automatically 

You can configure your system so that CCDs, results, and documents are automatically 
sent to the relevant Electronic Medical Record. 

To do this, you must enable the Automated Document Exchange option. Refer to 
Configuring Automated Document Exchange for details. 

To enable the Automated Document Exchange function, you must set up the 
following Orion Health HIE features: 

• CCD Generation Sending 

• Sending Results to EMRs 

• Notifications 

The Automated Document Exchange feature relies on these functionalities to work. 

 

Configuring Event Types 

 

Notifications allows a healthcare provider to subscribe to types of notifiable events. The 
administrator can configure the types of event that Notifications supports, for example, 
admission, discharge, and Radiology results. 

Once the notifications associated with the event types are also configured, a provider can 
subscribe to any of the notifications within Clinical Portal. 
Notifications can also be triggered by Typed Clinical Events, for example, many 
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applications publish Typed Clinical Events when new clinical information is available for a 
patient and Notifications can listen to these events. 

The administrator can also configure system events in order to keep track of changes 
made to the configuration of notifications. Only users belonging to the System Audience 
will receive notifications triggered by system events.  

The API bundle that exports a Typed Clinical Event, which Notifications has been 
configured to listen, must be present on the same platform instance as Notifications. 

• Depending on how the rules are configured, a clinical event can trigger multiple 
notification types. Each recipient receives one notification message, containing 
details of one or more notification types. Refer to Notifications Workflow of an 
Event with Multiple Notification Types for details. 

• Depending on how the rules are configured, Notifications can also send more 
than one notification message to different recipients. Refer to Notifications 
Workflow of a Typed Clinical Event with Multiple Event Types for details. 

 

Configuring Event Types includes: 

• Adding and Deleting Event Types 

• Modifying Event Types which includes downloading inbound and outbound XML 
schemas 

• Configuring Event Data Model 

Displaying Event Types 

1. From Orion Health Platform, navigate to Configuration > Notifications (Advanced). 
This displays the Events tab with the event types listed in the pane on the left, as 
shown in the following screenshot: 

 

 

2. Enter search characters in the field at the top of the Notification Events pane to 

search for event types. Select the Clear icon  beside this field to clear the search. 
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Configuring Event Data Model 

 

Notifications allows a healthcare provider to subscribe to types of notifiable events. The 
administrator can configure the types of event that Notifications supports, including 
configuring the data model for the triggered message sent to Notifications by an event that 
occurred. 

Data Models based on Typed Clinical Events cannot be modified. 

When an event type is created, it contains the following: 

• A patientSummary attribute which the administrator cannot modify. 

• A documentMetaData attribute which the administrator cannot modify. 

• An eventContent attribute where the administrator can edit attributes of 
eventContent and its sub-attributes. The administrator can do the following: 

o Add attributes to eventContent or its composite children. 

o Specify whether attributes are repeating or required. 

o Specify the Comparison Type for date attributes. 

o Add or delete values in Lookups. 

The administrator cannot modify or delete any other attributes. 

Configuring Event Data Model includes the following: 

• Adding Attributes 

• Modifying Attributes 

• Downloading Schemas 

 

Adding Attributes 

 

Notifications allows a healthcare provider to subscribe to types of notifiable events. The 
administrator can add attributes of the eventContent attribute in the event type data 
model for an event. 

You can do the following: 

• Add an attribute or composite attribute of the eventContent attribute. 

• Add an attribute of a composite Child of the eventContent attribute. 

You cannot delete an attribute. 
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1. From Orion Health Platform, navigate to Configuration > Notifications (Advanced). 
This displays the Events tab on the left side of the panel, as shown in the following 
screenshot. Refer to Configuring Event Types for details. 

 

 

2. Select the name of the event type. This displays the event type's details in the right 
pane, including the event type data model in a tree you can expand, as shown in the 
following screenshot: 
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3. Select the eventContent attribute. 

4. Select the Add Attribute button to open the Add New Attribute dialog box. Specify 
the Name and Data Type of the new attribute, as shown in the following screenshot: 

 

 

5. Select the OK button to create the attribute and display the Edit group of fields for the 
attribute. Refer to Modifying Attributes for details. 

6. Select the Save button to save the attribute. 
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Modifying Attributes 

 

Notifications allows a healthcare provider to subscribe to types of notifiable events. The 
administrator can modify attributes or composite attributes of the eventContent attribute, 
in the event type data for an event. 

1. From Orion Health Platform, navigate to Configuration > Notifications (Advanced). 
This displays the Events tab, with the event types in the pane on the left, as shown in 
the following screenshot. Refer to Configuring Event Types for details. 

 

 

2. Select the name of the event type. This displays the details of the event type, as shown 
in the following screenshot: 
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3. Expand the eventContent attribute and select the attribute you want to edit to display 
the Edit fields of the attribute. 

 

Then you can: 

o Select the Required checkbox when available. 

o Select the Repeating checkbox when available. 
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4. Select the Save icon  to save the changes. 

 

Editing an Attribute with an Attribute Data Type of DATE_TIME 

1. Select the attribute to display the Edit fields. 

2. Select the appropriate value from the Comparison Type drop-down list, to set which 
type of display is used in the Rule condition for a Notification, as shown in the following 
screenshot: 
 
 

 

 
 
The Comparison Type values are described in the following table: 

Name Description 

PARTIAL_DATE Compare the date with a specific date on 
the notifications screen that is defined in 
the notifications rules. 

DATE_OFFSET Compare the date with x days before or 
after a specific date on the notifications 
screen that is defined in the notifications 
rules. 

3. Select the Save icon  to save the changes. 

Adding or Deleting Values for a Lookup Attribute 

1. Select the attribute to display the Edit fields. 

2. Select the Show Values link to display the Edit Lookup values dialog, as shown in 
the following screenshot: 
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o To delete a value, select the value and then select the Delete Value button. 

o To add a value, do the following: 

i. Select the Add Value button, as shown in the following screenshot: 

 

 

ii. Enter the Code, Coding system, and Description field details of the 
new value. The Code and Coding system fields are required. Every 
Code and Coding system combination must be unique within this 
lookup. 

iii. Select the OK button to add the new value. 

iv. Select the OK button to close the Edit Lookup Values dialog. 

v. Select the Save button to save the lookup value. 
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Downloading Schemas 

 

Notifications allows a healthcare provider to subscribe to types of notifiable events. The 
administrator can download a compressed file that contains the XML schemas for both 
inbound and outbound messaging for events. 

1. From Orion Health Platform, navigate to Configuration > Notifications (Advanced). 
This displays the Events tab, with the event types in the pane on the left, as shown in 
the following screenshot: 

 

 

2. Select an event type's name. This displays the event type's details and the Download 
Inbound and Outbound XML Schemas link in the right pane. 

3. Select the Download Inbound and Outbound XML Schemas link to download the zip 
file containing the XML schemas for inbound and outbound messaging for all event 
types. The schemas can be found in the files listed in the following table: 

Schema File 

Inbound inbound.xsd 

Outbound com.orchestral.notification.del

ivery.xmltcp.XmlTcpDeliveryChan

nel-outbound.xsd 

 

Adding and Deleting Event Types 

Notifications allows a healthcare provider to subscribe to types of notifiable events. Once 
the notifications associated with the event types are also configured, the provider can 
subscribe to any of the notifications within Clinical Portal. 

The administrator can add and delete the types of event that Notifications will support, for 
example, admission, discharge, and Radiology results. 



Notifications 7.3.0 | Administration Manual v1.0  

 
 ____________________________________________________________________________________________________________  

 

 ____________________________________________________________________________________________________________  

Printed copies of this document may be out of date. Please refer to https://doki.orionhealth.com for the latest updates. 

© Copyright 2018 Orion Health Group of Companies | All rights reserved 66 

The administrator can also add and delete system events to keep track of changes made 
to the configuration of notifications. Only users belonging to the System Audience will 
receive notifications triggered by system events.  

Adding Event Types 

1. From Orion Health Platform, navigate to Configuration > Notifications (Advanced). 
This displays the Events tab, with event types listed in the pane on the left, as shown 
in the following screenshot: 

 

 

2. Click the Add icon  at the top of the Notification Events pane to open the Create a 
New Event dialog box, as shown in the following screenshot: 

 

 

3. Enter the Event Type name. 

4. To trigger this EventType from a Typed Clinical Event, select the Triggered by Typed 
Clinical Event checkbox, and then select the Typed Clinical Event from the drop-down 
list. 

5. Check the System Event option to create a system event. 

6. Select the audience to receive notifications associated with the event. 

Allowed Audiences 

Only System Audience is allowed for system event types. 
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Only non-system audiences are allowed for non-system event types. 

 

7. Select the OK button to add the event, and display the event type details in the right 
pane. 

8. Complete the details for the new event type in the right pane. Refer to Modifying Event 
Types for details. 

9. Select the Save button to save the new event type. 

10. Configure Rhapsody for the new event type. Refer to Configuring Rhapsody for Event 
Types for details. 

Deleting Event Types 

1. From Orion Health Platform, navigate to Configuration > Notifications (Advanced). 
This displays the Events tab with event types listed in the pane on the left. 

2. Select the event type to be removed and click the Delete icon  at the top of the 
Notification panel. This opens the Confirm Delete dialog box, as shown in the 
following screenshot: 

 

 

3. Select the Delete button to delete the event type. 

Deleting an event type will also delete any associated notifications. 

Deleting Event Types During Data Migration 

When uploading data in bulk into your clinical database, you can delete event types to 
prevent any degradation in system performance as a result of Notifications listening to all 
of the data that is being put into the system.  Deleting event types will prevent notifications 
from listening to clinical events during data migrations. 

Carry out the following configurations to disable notifications for any event type before 
uploading data in bulk into your clinical database. 

1. Back up Notifications event types configurations using the Configuration Explorer in 
Platform.  Refer to Exporting and Importing an Event Type Configuration for details. 

2. Delete all event types.  Refer to Deleting Event Types for details. 

You can restore all the Notifications event types by importing the configuration backup into 
Platform.  Refer to Importing Event Type Configurations for details. 
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Modifying Event Types 

 

Notifications allows a health care provider to subscribe to types of notifiable events. The 
administrator can configure the types of event that Notifications will support, including 
modifying the event types. 

The administrator can also export the XML schemas to assist synchronizing the 
Notification data models with the upstream data mapping. 

1. From Orion Health Platform, navigate to Configuration > Notifications > 
Notifications (Advanced). This displays the Events tab, with the event types in the 
pane on the left, as shown in the following screenshot: 

 

 

2. Select the name of the event type to display its details in the right pane, as shown in 
the following screenshot: 
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o Event Type 
Update the fields described in the following table as required, and then select 
the Save button. 

Field Description 

Name An identifying name for the event type. 
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Field Description 

Description The description of the event type. 

Subject Format The Template Processor expression 
that determines the subject line of any 
notifications sent (for example, the 
subject line of an email). 

Detail Message Format The Template Processor configuration 
control for the format to be used for the 
detail (secure) notification message of 
this event type. Refer to Template 
Processor Format Examples for details. 

System Event A checkbox indicating whether or not 
the selected event is a system event.  
 

Audience The audience that will receive 
notifications associated with the event 
type. 

Allowed Audiences 

Only System 
Audience is allowed 
for system event 
types. 

Only non-system 
audiences are 
allowed for non-
system event types. 

 

 

You can use the Template Processor to configure the common notification 
message header and footer formats and to configure the summary body 
message format. Refer to Configuring Notification Messages for details. 
 
Variables can be used in the template processor. Refer to Template Processor 
Variables for Messages and Activity Stream for details. 

o Activity Stream 
Update the fields described in the following table as required, then select the 
Save button. 
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Field Description 

Send this Event to the Activity 
Stream 

Each event for which this Template 
Processor expression returns the String 
true is passed as a new activity 

update to the Activity Stream 
component. In this case, the following 
fields in this section are evaluated to 
determine the values to pass to the 
Activity Stream. Refer to Overview for 
details. 

Update Type Name This Template Processor expression 
determines the Update Type that this 
event maps to. If there is a one-to-one 
correlation between Notification Types 
and Update Types, this expression is 
based on the notificationTypeNames 
variable. Refer to Template Processor 
Variables for Messages and Activity 
Stream for details. 

Title This Template Processor expression 
determines the title of any activity 
stream updates generated. 

Summary This Template Processor expression 
determines the summary of any activity 
stream updates generated. 

External Id This Template Processor expression 
determines the external Id of any 
activity stream updates generated. 
External Ids are used when 
determining which Activity Updates a 
user can see. The format of this field is 
determined by the authorizer in use for 
the Update Type. In general, this 
means that this field will only need to 
be altered when the Update Type is 
using the Generic Privacy Authorizer. 
Refer to Generic Document Authorizer 
for details. 

Parameters This list of Template Processor 
Expressions determines the 
parameters of any activity stream 
updates generated. Parameters are 
used inside the Activity Stream 
component to build up a translated 
message to describe the update to the 

https://doki.orionhealth.com/display/AST10/Overview
https://doki.orionhealth.com/display/AST10/Generic+Document+Authorizer
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Field Description 

user. The indexes of the parameters 
must match the indexed expressions in 
the translation keys referenced by the 
Activity Update Type. 
For example: if the Update Type Name 
field points to the Warning Activity 

Update Type, the Translation Key field 
of the Warning Activity Update Type is 

activityStream.warning and the 

Translation of 
activityStream.warning is 

ALERT:{0}, then the user would 

always see ALERT: followed by the 

content of the first parameter to 
describe the Warning Activity Update 

Type. Refer to Activity Update Types 
for details. 

Variables can be used in the template processor to describe the current event. 
Refer to Template Processor Variables for Messages and Activity Stream for 
details. 

o Event Type Data Model 
Configure the Event Type Data Model as required, then select the Save button. 
Refer to Configuring Event Data Model for details. 

Data Models based on Typed Clinical Events cannot be modified. 

o Event Type Additions 
You can export the XML schemas to assist with synchronizing the Notification 
data models with the upstream data mapping. 
 
You can add the required data elements to the respective event models in the 
exported file. When these are complete, import them into Rhapsody™ 
Integration Engine (Rhapsody) (or other middleware), to synchronize any 
upstream data mappings and XML trigger event message generation into 
Notifications. 
 
When you add a new event type or modify an existing event type, you need to 
export the schemas as described in the following tables and update Rhapsody. 
Refer to Configuring Rhapsody for Event Types for details. 
 
To download the XML schemas: 

i. Select the Download Inbound and Outbound XML Schemas link. This 
downloads a zip file containing the XML schemas for both inbound and 
outbound messaging, as described in the following table. The link 

https://doki.orionhealth.com/display/AST10/Activity+Update+Types
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downloads the inbound schema with input and matching output 
definitions for all event types, not just the currently selected one. 

ii. In the File Download dialog, select the Save button. Save the archive to 
a temporary directory; for example, <temp-
dir>/NotificationXMLSchemas.zip 

File Description 

NotificationInboundTriggerEvent.xsd This refers to the inbound XSD 
schema definition. This contains 
a superset of all the trigger 
event models. 

NotificationOutboundTcpDeliveryChannel.xsd The refers to the outbound XSD 
schema definition. This contains 
the trigger event models as 
child nodes, to support data 
pass through. It has 
encapsulated the relatively 
static delivery structure for 
matched notifications and 
delivery channels. 

 

Configuring Rhapsody for Event Types 

 

When a new event type is created or modified in Notifications, you must modify Rhapsody 
to provide a population mapping from source data formats to the new or updated event 
types and data. 

After creating or modifying an event type, download the inbound and outbound XML 
schemas. Refer to Modifying Event Types for details. Save the archive you downloaded to 
a temporary directory, for example, <temp-dir>/NotificationXMLSchemas.zip. 

As described in the following list: 

• Replace the trigger event message definition with the definitions you downloaded. 

• Update mappings. 

• Change message tracking. 

• Update message property filters. 

• Orion Health recommends preserving the Notifications file name for the 
definition to aid synchronization. Rhapsody can then automatically detect the 
changes. 

• It is assumed that readers have Rhapsody Mapper skills. 
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Updating Trigger Event Message Definition 

You must update the trigger event message definitions in the following mappers: 

• AppointmentHL7ToXmlMapper.mdf 

• EncounterHL7ToXmlMapper.mdf 

• ImagingReportHL7ToXmlMapper.mdf 

• LaboratoryObservationHL7ToXmlMapper.mdf 

• NotificationXmlToConcertoUserMessagingXmlMapper.mdf 

• TranscribeDocumentHL7ToXmlMapper.mdf 

To update a definition, do the following: 

1. Extract the contents of the archive you downloaded into the <temp-

dir>/NotificationXMLSchemas/* temporary directory. 

2. Open the Rhapsody IDE program. 

3. Select the Definitions tab at the bottom of the Rhapsody IDE workspace sidebar, as 
shown in the following screenshot: 
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4. Double-select the mapper to open the Check Out Definitions window. 

5. Select the Check Out button to check the mappings out. 

6. Open the My Documents/Definition Storage/<machine 

name>/Definitions folder in the local file system. Find the definition and overwrite it 

with the definition you extracted to the temporary directory. 

7. Right-click the checked-out mapper and select Check In. 
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Updating Mappings 

You need to update the mappings associated with Notifications input or output messages, 
including any custom mappings you have added. In the default package these mappings 
are: 

• AppointmentHL7ToXmlMapper.mdf 

• EncounterHL7ToXmlMapper.mdf 

To update a .mdf mapping: 

1. Open the Rhapsody IDE program. 

2. Select the Definitions tab at the bottom of the Rhapsody IDE workspace sidebar. 

3. Right-click the .mdf mapper and select Check Out to check the mappings out. 

4. Double-click the mapping you want to update to open the Update Message 
Definitions window. 

5. Select the OK button to display the list of maps. 

6. Double-click the map you want to edit. Edit the map and select the Save icon . If any 
fields have been added, deleted or modified, implement the mapping code to match 
this. 

7. Select the Compile icon  to compile the mapping. This will produce a list with any 
warnings or errors. Fix any errors and compile again until the mapping is correct. If any 
definitions are updated, you need to implement the associated mapping logic to 
populate these fields. 

8. Select the Test icon  to test the mapping. Apply a suitable local message appropriate 
for your environment through the test. 

9. Check whether the mapping is correct. 

10. Check in the mapper file. 

If any new trigger events have been added, add the new mappings and route paths, 
following the existing route patterns. 

Changing the Message Tracking 

If an event type is modified, but the definition file names remain the same, then the next 
restart will pick up the new definitions for message tracking. Unless field locations are 
changed, there is unlikely to be any impact. 

Each event type needs its tracked message configuration, so new event types need to 
have this setup. 

To change the message tracking for a new event type: 

1. Open the Rhapsody IDE program. 

2. From Rhapsody IDE, navigate to View > Tracking Scheme Manager. This opens the 
Scheme Manager dialog. 

3. In the Schemes section, select NotificationInboundTriggerEvent, as shown in 

the following screenshot: 
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4. Select the Message Tracking Scheme icon   to display the Message Tracking 
Scheme dialog, as shown in the following screenshot: 

 

 

5. From the Messages tab in the Tracked Messages section, select the Add icon , to 
display the Edit Tracked Messages dialog, as shown in the following screenshot: 
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a. From the Tracked Messages section, do the following: 

i. Select the Add icon  to display the Message Selection Dialog. 

ii. Select the new event type you created and then select the OK button. 

b. From the Message Control ID section, do the following: 

i. Select the Selected fields option. 

ii. Select the Add icon  to display the Field Selection Dialog. 

iii. Navigate to <new-event-type>/messageInformation/messageId, and 
select the OK button. 

c. From the Valid Responses section, do the following: 

i. Select the Add icon  to display the Message Selection Dialog. 
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ii. Select eventAcknowledgement and then select the OK button. 

d. Select the OK button. 

6. Select the OK button. 

7. Select the Close button. 

Updating Message Property Filters 

When you add or change an event type, review all routes looking for Property filters. 

These are filters with the  icon. There are various message properties that use the 
definition by name. If the path is unchanged, the routes will still function. If the path 
changes, there will be an error in the log or when checking in. 

To update filters, do the following: 

1. Open the Rhapsody IDE program. 

2. Select the Configurations tab at the bottom of the Rhapsody IDE workspace sidebar. 

3. Right-click the route with the filters you want to update to open the Check Out 
Definitions window. 

4. Select the Check Out button to check the filters out and list them. 

5. Check the filters back in again to pick up the new definitions. As the definition name is 
the same, this is normally automatic during the next restart or route processing. 

 

Configuring Notification Delivery Channels 

Notifications allows a health care provider to subscribe to notifiable events in Clinical 
Portal, and select from the available delivery channels for the notifications. 
An administrator can configure the delivery channels that Notifications supports, such as 
Clinical Portal inbox and email. 

1. From Orion Health Platform, navigate to Notifications > Delivery Channels in the 
Configuration menu. 
The Delivery Channels tab lists the delivery channels in the Delivery panel. 
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The Direct Delivery Channel is added in Orion Health Platform. 

2. Enter the characters in the Search field to search for delivery channels. 

To clear the Search field, select the Clear   icon.  

3. To update a delivery channel, select the name to display the delivery channel's details 
on the right-hand pane. 

4. Make any changes that you require and then select the Save icon at the top of the 
panel. 
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Configured Settings 
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Field Description 

Channel  Code This refers to the unique code that identifies the delivery channel. This 
code is defined when the delivery channel is created, and it cannot be 
changed. 
Outgoing XML notification messages contain this code so specific 
handling can be created in the Rhapsody configuration to implement the 
actual delivery mechanism. 

Channel  
enabled 

When this checkbox is selected, the provider can select this delivery 
channel as a delivery method. 

Name This refers to the name to be displayed for the delivery channel. 

Address  
Label 

This refers to the Translation key used to translate the delivery channel 
address label on the My Subscriptions screen. 

Use Attributes When this checkbox is selected, the delivery channel determines the 
recipient's address from the user attributes. 
When this checkbox is cleared, the delivery channel determines the 
address from the current identifier of the namespace specified in the 
Identifier Namespace field. 

Address  
Schema 

This refers to the case-sensitive name of the attribute schema to use for 
the delivery channel when Use Attributes is Yes. 

Address 
Property 

This refers to the case-sensitive name of the attribute that contains the 
recipient's address when Use Attributes is Yes. 

Identifier  
Namespace 

This refers to the case-sensitive namespace used by the delivery 
channel to determine the identifier of the recipient when Use Attributes 
is No. 

The default Concerto login namespace is portal6x-login. 

Address  
Displayed 

When this checkbox is selected, the address is displayed on the My 
Subscriptions screen. 

Address  
Editable 

When this checkbox is selected, the address is editable on the My 
Subscriptions screen. 

Making the address editable could allow users to enter invalid 
delivery addresses. The Rhapsody route that handles message 
delivery for this delivery channel must be set up to send messages 
with invalid delivery addresses to the error queue. An administrator 
must monitor the error queue to ensure that notifications are 
delivered correctly. 

 

Read  Only  
Explanation 

When the Address Editable checkbox is not selected, you can enter text 
in this field to explain why the address cannot be edited. 
The explanatory text should also tell the user how they could edit the 
address. 
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Field Description 

Text  
Notifications 

When this checkbox is selected, text notifications can be sent to this 
channel. 

You can configure primary delivery channels to handle text 
notifications, documents, or both. 
Secondary delivery channels, however, can only send one 
notification type which is text notifications or document. 
If you select both notification types in a secondary delivery channel, 
document notifications take precedence and are the only 
notifications sent in that channel. 

 

Supported  
Methods 

The supported method options for the delivery channel are the following: 

• Detail - This channel supports secure delivery and accepts 
messages that could contain patient data. The channel can be 
selected as a detail or non-detail delivery method. 

• Non-detail - This channel is non-secure and supports only 
selected summary messages that cannot contain patient data. The 
channel can be selected only as a non-detail delivery method. 

• Daily Summary - When selected, this channel supports digest 
delivery. 

When configuring a notification delivery channel, make sure the 
correct delivery method is selected. 

Do not use the Detail delivery method when configuring a non-
secure delivery channel to ensure messages sent through this 
delivery channel do not contain patient data. 

 

Documents When this checkbox is selected, document notifications can be sent to 
this channel. 

The channel receives notifications only for documents that are sent 
to external systems such as Lab Results and CCDs. The document 
notifications are used only by machines receiving the notification; 
they are not meant to be viewed by caregivers. 

 

The delivery service has been updated so that primary delivery channels can be 
configured to handle text notifications, documents, or both. 

Secondary delivery channels, however, can only send either a text notification or 
document.  If the Documents checkbox is selected for a secondary delivery channel, 
then document notifications take precedence and will be the only notification sent in 
this channel. 
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Additional Properties 

Field Description 

Properties A list of Key and Value pairs to be serialized in the outgoing XML notification 
message. 

Adding a New Entry 

1. Select the first free row. 

2. Enter values in the Key and Value fields. 

Only key-value pairs with a non-empty key are used in the notification 
message. 

Deleting an Entry 

1. Select the key. 

2. Delete its value. 

 

  
Use of Channel in Audiences 

This refers to audiences to which this channel will deliver the notifications. Only users in 
the selected audiences can subscribe to or see this channel. 
 Refer to Configuring Audiences and Specifying the Primary Delivery Channel for an 
Audience for details about assigning the primary and allowed channels for audiences. 

Creating or Deleting a Delivery Channel 

This section explains how to configure Clinical Portal and Orion Health Platform to pass 
addressing information to Rhapsody to implement a new Delivery Channel. 

It assumes that the new Delivery Channel is based on a new address attribute. If it is not 
based on a new address attribute, then the initial steps may be unnecessary. 

Creating a Delivery Channel 

1. Find or create the User Attribute that you want to use for addressing in Clinical Portal. 

2. Add the New Attribute in Orion Health Platform in the following: 

o Concerto Roles and Groups 

o Attribute Schema Details. 

3. Create the Delivery Channel by referencing the new Identity Attribute you created in 
the Address Schema and Address Property fields and completing all relevant 
details. 
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Finding or Creating the User Attribute 

Finding the User Attribute 

1. Log in to Clinical Portal. 

2. Navigate to Concerto > Roles & Groups. 

3. Select the Group that you want to add the user attribute to. 
The General tab displays the available Group Attributes. 

 

 

 

Creating the User Attribute 

1. Enter the new user attribute in the field provided. 

 

 

2. Select the Add icon to create the new user attribute. 
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3. Configure the following fields with the appropriate values: 

o Display Name 

o Input Type 

o Display 

o User Editable 

o Encrypt. 

4. Select the Save button to save the new user attribute. 

Adding the New Attribute in the Attribute Schema Details 

1. Log in to Orion Health Platform. 

2. Navigate to General > Identity from the Configuration menu. 

3. Select the Identity Schema tab to display the attribute schemas. 

 

 

4. Select the NotificationsRecipient attribute schema to display the attribute schema 
details in the right panel. 
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5. Select the New... button. 
Th Add Attribute dialog box is displayed. 

 

 

6. Enter the new attribute name in the My Attribute field. 

7. Select the OK button to add the new attribute to the attribute schema details. 

8. Select the Save button to save the change. 

Adding the New Attribute in Orion Health Platform 

1. Log in to Orion Health Platform. 

2. Navigate to General > Identity in the Configuration menu. 

3. Select the Concerto Identity Source Configuration identity source in the Identify 
Sources tab. 
Concerto Identity Source Details is displayed in the right panel. 
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4. Select the Add new attribute button. 
The Specify schema and attribute name dialog box is displayed. 
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5. Enter NotificationsRecipient in the Schema field. 

6. Enter the attribute name in the Attribute field. 

7. Select the OK button to create the new attribute. 
The new attribute is displayed in the Standard Attribute Configuration panel. 

8. Enter the Concerto group name in the Concerto Group Name field. 

9. Enter the Concerto attribute name in the Concerto Attribute Name field. 

 

 

10. Select the Save button to save the new attribute. 

Creating the Delivery Channel 

 

When you add or modify a delivery channel, you must update the mappings 
associated with the Notifications input and output messages in Rhapsody. Refer to 
Notifications Rhapsody Routes for details. 

 

1. Navigate to Notifications > Delivery Channels from the Configuration menu. 

2. Select the Add icon  at the top of the Delivery Channels tab. 
The Create Delivery Channel dialog box is displayed. 
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Delivery Channels using the SMTP channel can be unreliable and may cause the 
OHP to hang when processing. Refer to the SMTP channel is inherently 
unreliable section in Warnings and Recommendations for details. 

3. Enter a unique code to identify the delivery channel. 

4. Select the OK button. 
The Delivery Channels tab is displayed with the delivery channel details in the right 
panel. 

Every channel code needs specific handling configured in Rhapsody 
configuration to implement the actual delivery mechanism. Refer to Notifications 
Rhapsody Routes for details. 

https://doki.orionhealth.com/display/NOT73/Warnings+and+Recommendations
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5. Configure the Delivery Channel Details. Refer to Configuring Notification Delivery 
Channels for details. 

6. Select the Save icon at the top of the panel to save the delivery channel details. 

7. Configure the Delivery Channel Use as an allowed or the Primary Channel for 
Audiences. Refer to Configuring Audiences and Specifying the Primary Delivery 
Channel for an Audience for details about assigning the primary and allowed channels 
for audiences. 
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Configuring Delivery Channel Use in Audiences 

Only users in audiences that specify the given Delivery Channel as allowed or 
primary will be able to see or subscribe to this channel. The Delivery Channel will 
not deliver notifications to users from other audiences. 

 

Deleting a Delivery Channel 

1. Select the delivery channel and select the Delete icon  at the top of the Delivery 
panel. 
The Confirm Delete dialog box is displayed. 

 

 

2. Select the Delete button to delete the delivery channel. 

 

Specifying the SMTP Configuration 

The SMTP channel is inherently unreliable. 

The SMTP channel is implemented to provide a way of sending notifications through 
email if Rhapsody is unavailable in the environment. This channel is inherently 
unreliable and should not be used as a primary delivery channel in a production 
environment. 

If the delivery of a notification fails, for example, because of a wrongly configured 
recipient email address, then Notifications drops the message and the original 
message is untraceable. As such, emails should be delivered through the email 
delivery channel. 

 

If you are using Platform version 8.9 or earlier and the SMTP server becomes 
unresponsive for more than one minute during the SMTP message delivery, the 
connection used by the SMTP Delivery Channel will not be removed. 

To prevent running out of ports in the Notifications server, it is recommended that you 
upgrade to Platform 8.10 or later. 

1. Log in to Orion Health Platform as an administrator. 
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2. From the left pane, select Notifications > Delivery Channels. The Delivery Channels 
are displayed. 

3. Select the SMTP Configuration tab. The SMTP Configuration screen is displayed: 

 

 

4. Complete the following fields as required: 

Field Description 

SMTP Server Specify the name of your mail server 
hostname. For example, YourHostName. 

SMTP Port Specify your mail server SMTP port. 

By industry convention, this is 
typically port 25. 

 

From Address Specify the email address that you want to 
appear in the sender field in email 
notifications, for example 
<Joe.Bloggs@OrionHealth.com>. 

From Display Name If required, specify the name that you want 
to appear in the Sender field in email 
notifications, for example Joe Bloggs. 

Reply To Address To send replies to an address other than 
the one specified in the From Address 
field, specify the alternate address. 

If this field is left blank, it 
defaults to the address 
specified in the From Address 
field. 
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Field Description 

Test Address To test this configuration, specify an email 
address. 

5. To verify the configuration, select the Test button. 

6. Select the Save button. 

 

Configuring Notification Messages 

 

Notifications allows a healthcare provider to subscribe to notifications of events, for 
patients the provider has a relationship with. If the provider has subscribed to such an 
event, then when an event of this kind occurs, a notification message is sent to the 
provider. 

The administrator can use the Template Processor to configure the formats of these 
messages. 

Configuring Notification Messages includes: 

• Configuring Digests 

• Configuring the Header, Footer and Summary 

• Template Processor Format Examples 

• Template Processor Variables for Messages and Activity Stream 

 

Configuring Digests 

 

Notifications can send a digest notification to healthcare providers. Refer to Digest for 
details. 

The administrator can use the Template Processor to configure the message formats of 
the body of notification digests. 

1. From Orion Health Platform, navigate to Configuration > Notifications (Advanced). 

2. Select the Digests tab to display the digests, as shown in the following screenshot: 

https://doki.orionhealth.com/display/NOT73/Digest
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3. To display the digest properties in the Properties panel, select the digest you want to 
configure, as shown in the following screenshot: 

 

 

4. You can update the Name and Digest Format fields. Enter the appropriate template 
processor code in the Digest Format field. 

Field Description 

Id The unique identifier of the digest. 

Secure Delivery A checkbox that when selected, specifies 
that the digest is delivered by the secure 
delivery method. 

Name The name of the digest. 

Subject The Template Processor configuration 
control for the digest subject line. 
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Field Description 

Digest Format The Template Processor configuration 
control for the digest body. 

• A digest is delivered only if the user has subscribed to receive a digest. 

• A digest will only include notifications that occurred since the user has 
subscribed to the digest. 

• If the user has subscribed to receive a digest and no new notifications are 
received since the last digest, then no digest will be sent. 

• The delivery time of the digest may vary as Notifications will process the 
digest one user at a time. 

 

Refer to Modifying Event Types for details on specifying the message format. 

Refer to Template Processor Variables for Messages and Activity Stream for details of the 
objects that can be used in the Template Processor configuration control for messages. 
Refer to Template Processor Format Examples for further details and message examples. 

Refer to Scheduling Digests for details on scheduling the timing of digests. 

 

Scheduling Digests 

 

Notifications allows a health care provider to subscribe to digests of notifiable events 
within Clinical Portal. 

The administrator can configure the scheduling of the task that generates these digest 
notifications. By default, this runs once a day at 5 a.m. 

1. Log in to Orion Health Platform. The main screen opens with the Configuration option 
selected. 

2. From the left pane, select Scheduled Tasks. This displays the scheduled task page, 
as shown in the following screenshot: 
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3. Select NotificationDigestTask. The details display in the right panel, as shown in the 
following screenshot. 

 

 

4. Update the settings as required: 

To disable the task Select the Disabled option. 

To specify how often the digest should be 
created in an hour, day, month, or year 

Select the Simple option. 
In the Scheduled For field, specify the 
number of times per hour/day/month/year. 

To use Cron Timing to specify the 
schedule 

Select the Advanced option. 
In the Cron Timing field, specify how often 
you would like to schedule the digest. 
This field uses the following format: 
<Minutes> <Hour> <Day> <Month> 
<Year>. 
For example, to schedule the digest to be 
generated at 5:18am every day, type 18 5 

* * *. 

For example, to schedule the digest to be 
generated at 5am, 10am and 10pm every 
day, type 0 5,10,22 * * *. 

For example, to schedule the digest to be 
generated at 5am on the first day of every 
month, type 0 5 1 * *. 

5. Select the Save icon  to save the changes.. 
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Formatting Plain Text and HTML Notifications 

 

Notifications allows a healthcare provider to subscribe to notifications of notifiable events 
within Clinical Portal. Refer to Notification Messages in the Notifications User Manual for 
details. 

The administrator can use the Template Processor to configure the message formats of 
the notification message header and footer formats and the summary message body 
format. 

The summary message, header, footer, and HTML template must not contain any 
patient information since these may be delivered through channels that are not 
secure, such as the email delivery channel. 

To configure the notification message header and footer formats, and the summary body 
format: 

1. From Orion Health Platform, navigate to Configuration > Notifications. 

2. Select the Message Formats tab to display the Message Formats panel as shown in 
the following screenshot: 

 

 

3. Update the Summary Body, Message Header, and Message Footer fields described 
in the following table, by entering the appropriate template processor code. 

https://doki.orionhealth.com/display/NOT73/Notification+Messages
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Field Description 

Summary Body This refers to the Template Processor 
configuration for the notification message 
summary. 

Message Header This refers to the Template Processor 
configuration for the notification message 
header. 

Message Footer This refers to the Template Processor 
configuration for the notification message 
footer. 

HTML Template This refers to the Template Processor 
configuration for the notification message 
header. 
The HTML should either be blank or 
contain the placeholder 
[TEMPLATE_MESSAGE_BODY]. 

The HTML template is only 
available when delivery is done 
using Rhapsody routes which 
are configured to use the 
template. The SMTP delivery 
channel does not use the HTML 
template. Refer to Notifications 
Rhapsody Routes for more 
details. 

 

If you want to send HTML-formatted emails, use the following sample HTML template as a 
reference to help you build your customized HTML template: 

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" 

"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> 

<html> 

  <head> 

    <meta charset="UTF-8"> 

    <title></title> 

    <style> 

    a { 

      color: #00697f; 

    } 

    </style> 

  </head> 

<body leftmargin="0" topmargin="0" marginwidth="0" marginheight="0" 

bgcolor="#f1f1ef"> <!-- Some email clients strip the bgcolor --> 

<div id="background" style="background-color:#f1f1ef; padding:30px;"> <!-- If the 

bgcolor is stripped we have a backup, and set the padding --> 

  <table border="0" align="center" cellpadding="30" cellspacing="0" 

style="border:1px solid #e1e1df; max-width:90%;"> 

    <tbody> 

      <tr> 
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        <td bgcolor="#FFFFFF" style="font-family:'Helvetica Neue', Helvetica, 

Arial; font-size:13px; color:#313130;"> 

          <h1 style="font-weight: normal; font-family:'Open Sans', 'Helvetica 

Neue', 'Helvetica', 'Arial'; font-size:32px; margin-top:0px; color:#00697f"> 

           << INSERT HEADING HERE >> 

          </h1> 

          <p> 

          [TEMPLATE_MESSAGE_BODY] 

          </p> 

        </td> 

      </tr> 

    </tbody> 

  </table> 

  <table border="0" align="center" cellpadding="5" cellspacing="0" style="max-

width:90%;"> 

    <tbody><tr> 

      <td bgcolor="#f1f1ef" style="font-family:'Helvetica Neue', Helvetica, Arial; 

font-size:13px; color:#636360;"> 

        <p> 

          &copy; << INSERT COPYRIGHT, DISCLAIMER AND UNSUBSCRIBE LINK HERE >> 

        </p> 

      </tr> 

    </tbody> 

  </table> 

</div> 

</body> 

</html> 

 

 

Refer to Modifying Event Types for details on specifying the detail message format. 

Refer to Template Processor Variables for Messages and Activity Stream for details of the 
variables that can be used in the Template Processor configuration control for messages. 
Refer to Template Processor Format Examples for further details and message examples. 

 

Template Processor Format Examples 

 

Notifications allows a healthcare provider to subscribe to notifications of notifiable events 
within Clinical Portal. The administrator can use the Template Processor to configure the 
message formats of the notifications. 

Template Processor Format Examples describes how to use lookup types, repeating 
types, and dates. It also provides sample detail and digest messages using the Template 
Processor. Refer to Template Processor Variables for Messages and Activity Stream for 
details on the variables available for these messages. 

Lookup Type 

Lookup types have two properties that can be used: 
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Property Name Property Description 

code This refers to the coded value of the type. 

description This refers to the description of the type. 

The following code is an example of using a lookup type property: 

Gender: <%=patientSummary.Gender.description%> (<%=patientSummary.Gender.code%>) 

Repeating Types 

The repeating types are zero-based. The following code is an example of getting the first 
FamilyName: 

<%=patientSummary.Name[0].FamilyName%> 

 

You can loop over all names instead. The list can also be obtained with the following 
example code: 

<%for each name in patientSummary.Name%> 

       <%=name.FamilyName%>, <%=name.GivenName%> 

<%end for%> 

Dates 

The dates type in the data model data wraps the actual date. This means you need to 

use the date property to get the actual date for formatting. The following code is an 

example of getting an actual date: 

<%=DateFormat.format(patientSummary.dateTimeofBirth)%> 

Sample Detail Message 

The following code is an example of a sample detail (secure) message: 

Patient Name: <%=patientSummary.Name[0].FamilyName%>, 

<%=patientSummary.Name[0].GivenName%> 

Patient Gender: <%=patientSummary.Gender.description%> 

(<%=patientSummary.Gender.code%>) 

DoB: <%=DateFormat.format(patientSummary.dateTimeofBirth)%> 

  

<%for each recipientQualifier in recipientQualifiers%> 

The following events have occurred for patients for whom you are recorded as the 

<%=recipientQualifier.name%>: 

 <%for each notificationType in notificationTypes%> 

        <%if notificationType.type = "Patient Encounter Changed - EncounterEvent"%> 

            The patient encounter details have been changed. 

        <%end if%> 
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        <%if notificationType.type = "Inpatient Discharge - EncounterEvent"%> 

            The patient has been discharged. 

        <%end if%> 

    <%end for%> 

<%end for%> 

 

Depending on how the rules are configured, a clinical event can trigger multiple 
notification types. Each recipient receives one notification message per event, 
containing details of one or more notification types. The detail message format can 
be configured to contain messages for each notification type. Refer to Notifications 
Workflow of an Event with Multiple Notification Types for details. 

Sample Digest Message 

The following code is an example of a digest message: 

One or more patients for whom you are recorded as the <%var andcnt=0%><%for each 

recipientQualifier in 

content.recipientQualifiers%><%=recipientQualifier.description%><% 

var andcnt = andcnt + 1 %><%if andcnt < content.recipientQualifiers.size%> and 

<%end if%><%end for%> have had activity at << INSERT SYSTEM NAME HERE >> within the 

last 24 hours. 

 

<%for each recipientQualifier in content.recipientQualifiers%> 

The following events have occurred for patients for whom you are recorded as the 

<%=recipientQualifier.description%>: 

<%for each notificationType in content.notificationTypes%> 

<%=content.getEventCount(recipientQualifier, notificationType)%> 

<%=notificationType.type%> 

<%end for%><%end for%> 

 

To view the detail for these events, please login to << INSERT SYSTEM NAME HERE >>  

at << INSERT URL HERE >> 

 

 

Template Processor Variables for Messages and Activity Stream 

 

Notifications allows a healthcare provider to subscribe to notifications of notifiable events 
within Clinical Portal. The administrator can use the Template Processor to configure the 
message formats of the notifications. 

Template Processor Variables for Messages and Activity Stream lists variables that 
are available to the Template Processor for configuring the message formats and Activity 
Stream. 
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Not all variables in the Template Processor are available for Notifications messages. 
Refer to Common Variables for details on the available variables in the Template 
Processor. 

Summary Message Variables 

The variables in the following table and their properties can be used in the Template 
Processor when configuring the summary (insecure) notification message format. Refer to 
Variable Types for details of variable types. 

Variable Name Variable Type Description 

recipient Identity This refers to the recipient of the 
notification. 

eventType EventType Ths refers to the event type of the 
notification. 

recipientQualifiers Set<RecipientQualifier> Recipients receive notifications based 
on a set of qualifiers. When these 
qualifier conditions are met, a 
notification is triggered. This variable is 
a set of qualifiers that triggered the 
current notification which can be 
formatted into the message. 

notificationTypes Set<NotificationType> This refers to the set of notification 
types the incoming event has 
triggered. 

Detail Message Variables 

The variables and their properties available for Summary Messages and the variables 
listed below can be used in the Template Processor when configuring the detail (secure) 
notification message format. 

Variable Name Description 

eventTypeName This refers to the name of the event type. 

documentMetaData This refers to the document metadata object. 

patientSummary This refers to the patient summary object. 

eventContent This refers to the event content object. 

 

The documentMetaData, patientSummary, and eventContent variables 

correspond to the top level attributes available in the event type model. Removing a top 
level attribute from the model means that it will not be available in the Template Processor. 
Any new top-level attribute that is added is available in the Template Processor. 
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Activity Stream Variables 

The variables and their properties available for Summary Messages and Detail Messages 
and the variables listed below can be used in the Template Processor when configuring 
the activity stream: 

Variable Name Variable Type Variable Type Description 

notificationTypeNames Collection<String> The names of the notification types the 
incoming event has triggered. 

Digest Message Variables 

The following variables and their properties can be used in the Template Processor when 
configuring the digest notification message format: 

Variable 
Name 

Properties Property Description 

content digest 
recipient 
notificationTypes 
recipientQualifiers 

This refers to the digest. 
This refers to the recipient identity. 
This refers to the set of all notification types of the 
message. 
Recipients receive notifications based on a set of 
qualifiers. When these qualifier conditions are met, a 
notification is triggered. This variable is a set of 
qualifiers that triggered the current notification which 
can be formatted into the message. 

The following variables and their methods are available to the Template Processor for 
configuring the digest notification message format. 

Variable 
Name 

Methods Method Description 

content List getEvents(recipientQualifier, 

notificationType) 

int 

getEventCount(recipientQualifier, 

notificationType) 

This returns the list of 
notification events that 
matches the specified 
recipient qualifier and 
notification type. 
This returns the number of 
notification events that 
matches the specified 
recipient qualifier and 
notification type. 

Refer to Digest Message Example for a sample message using methods. 
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Variable Types 

The following variable types and their properties are available in the Template Processor 
when configuring message templates: 

Variable Type Properties Description 

TriggerEvent eventData 
eventTypeName 

All top level attributes such as 
patientSummary. For 

example, 
myEvent.patientSummary 

This refers to the dictionary 
event data. 
This refers to the name of the 
event type. 

EventType name 
description 
system 

This refers to the name of the 
event type. 
This refers to the description of 
the event type. 
This refers to a flag specifying if 
the event type is a system 
event. 

NotificationType uniqueId 
type 
system 

This refers to the unique 
identifier of the notification type. 
This refers to the user readable 
notification type. 
This refers to a flag specifying if 
the notification type is a system 
type. 

RecipientQualifier uniqueId 
name 
description 

This refers to the unique 
identifier of the recipient 
qualifier. 
This refers to the user readable 
name. 
This refers to the description of 
the recipient qualifier. 

Identity emailAddress 
fullName 

This refers to the email address 
of the user. 
This refers to the name of the 
user. 

 

Common Variables 

The following variables can be used on all templates. 

Variable Name Description 

DateFormat This refers to the date. 
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Variable Name Description 

TimeFormat This refers to the time. 

DateTimeForm

at 
This refers to the date and time. 

CodeSetLookU

pHelper 
This refers to the helper variable with single function, 
getDescriptionFromCodeSetService, which returns the 

description of a code definition using the code set service (refer to Code 
Sets for details on code sets and the code set service). For example, if 
the code set com.orchestral.notification.blah contains a 

code definition with code 01, codingSystem ORION and description an 

example description, then the following script creates the variable 

codeSetDescription with the value of an example description: 

<%var codeSetDescription = 

CodeSetLookUpHelper.getDescriptionFromCodeSetService("01","ORION",

"com.orchestral.notification.blah")%> 

 

If the code set service cannot find a matching code definition or one 
without a description, the above script creates the variable 
codeSetDescription with the value of null. 

These tables are too wide to print in PDF. A printable version is available as an Excel 
spreadsheet. Click here to download the spreadsheet. The spreadsheet is also available in 
Printable Documents. 

Refer to Template Processor Format Examples for sample formats. 

Some Detail Message formats for default Event Types include code set lookups 
using the CodeSetLookUpHelper variable. However, there is no guarantee that the 

relevant code definitions are present when retrieved. Code definitions may need to 
be manually inserted into a code when Notifications is retrieving code definitions from 
the code set service since these code definitions are not automatically added. 

 

Configuring Notifications 

 

Notifications allows a provider to subscribe to notifiable events. Once event types and their 
associated notifications are configured, the provider can subscribe to any of these 
notifications within Clinical Portal. 

Before configuring a notification, the event type that triggers the notification needs to be 
defined. Refer to Configuring Event Types for details. 

https://doki.orionhealth.com/display/OHP74/Code+Sets
https://doki.orionhealth.com/display/OHP74/Code+Sets
https://doki.orionhealth.com/display/NOT73/Printable+Documents
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• Depending on how the rules are configured, a clinical event can trigger multiple 
notification types. Each recipient receives one notification message, containing 
details of one or more notification types. Refer to Notifications Workflow of an 
Event with Multiple Notification Types for details. 

• Depending on how the rules are configured, Notifications can also send more 
than one notification message to different recipients. Refer to Notifications 
Workflow of a Typed Clinical Event with Multiple Event Types for details. 

 

The administrator can then configure the notifications for this event type. Refer to the 
following topics: 

• Viewing Notifications 

• Adding and Deleting Notifications 

• Configuring Notification Types 

• Configuring Notification Rules 

Viewing Notifications 

1. From Orion Health Platform, navigate to Configuration > Notifications. This displays 
the Notifications tab, with the notifications listed in the left pane, as shown in the 
following screenshot: 



Notifications 7.3.0 | Administration Manual v1.0  

 
 ____________________________________________________________________________________________________________  

 

 ____________________________________________________________________________________________________________  

Printed copies of this document may be out of date. Please refer to https://doki.orionhealth.com for the latest updates. 

© Copyright 2018 Orion Health Group of Companies | All rights reserved 108 

 

 

2. Enter characters in the search field at the top of this panel to search for notifications. 

Select the Clear icon  to clear the search. 
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Adding and Deleting Notifications 

 

Before adding a notification, the event type that triggers the notification needs to be 
defined. Refer to Configuring Event Types for details. 

Adding Notifications 

1. From Orion Health Platform, navigate to Configuration > Notifications. This displays 
the Notifications tab, with the notifications listed in the pane on the left, as shown in 
the following screenshot: 
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2. To add a notification, select the Add icon  at the top of the Notification panel and 
select New Notification from the drop-down menu. This opens a Create a new 
Notification dialog, as shown in the following screenshot: 
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3. Select the event type the notification relates to from the Parent Event Type drop-down 
list. 

4. Enter the name of the new notification in the Name field, and select the OK button to 
add the notification. 

5. Select the Save button to save the new notification. 

Deleting Notifications 

1. From Orion Health Platform, navigate to Configuration > Notifications. This displays 
the Notifications tab, with the notifications listed in the pane on the left. 

2. Select the notification and select the Delete icon  at the top of the Notification 
panel. This opens the Confirm Delete dialog, as shown in the following screenshot: 

 

 

3. Select the Delete button to delete the notification. 

 

Configuring a Notification 

 

To be able to exchange documents with the EMR system from the My 
Subscriptions page, the clinician must select the EMR from the My EMR drop-down 
list that is configured on the Receiving EMR System page. 
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Notifications does not support the Incoming Documents option for any clinical event 
type. 
Do not use the Incoming Documents option when configuring notifications. Refer to 
Configuring Notification Types for details. 

Configuring Notification Types 

1. From Orion Health Platform, navigate to Configuration > Notifications. This displays 
the Notifications tab, with the notifications listed in the pane on the left, as shown in 
the following screenshot: 

 

 

2. Select the name of the notification in the left pane, to display details of the notification 
in the right pane, as shown in the following screenshot: 
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This screen has the following groups of fields: 

o  

▪ Notification Type 

Field Description 

Parent Event Type This refers to the name of the event 
type that triggers the notification. 

Name This refers to the name to be 
displayed for the notification. 

Enabled This refers to the checkbox that 
determines whether the notification 
is enabled. If the checkbox is not 
selected the notification is disabled 
and is not sent. 

System This refers to the read-only 
checkbox indicating whether the 
parent event is a system or not. 

Document to Exchange This indicates if documents are sent 
to document-enabled delivery 
channels.  This field contains the 
following options: 

• None - No document is sent. 
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Field Description 

• Incoming Document - The 
original document is sent. 
 

• Generated CCD (generated 
document) - A generated 
CCD is sent. 
 

Notification
s does not 
support the 
Incoming 
Document 
option for 
any clinical 
event type. 
If you 
configure a 
notification 
with 
Document 
to 
Exchange 
set to 
Incoming 
Document, 
a 
notification 
will not be 
generated 
and an 
error is 
logged. To 
prevent 
errors, do 
not use the 
Incoming 
Document 
option. 

 

 

You can also do the following: 

• Update the Name field to rename the notification. 

• Select or clear the Enabled checkbox to enable or disable the 
notification. 
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• Specify that you would like either the original document or a 
generated CCD, to be sent. 

 

▪ Notification Rules 
Refer to Configuring Notification Rules for details. 

Configuring Notification Rules 

Notifications allows a provider to subscribe to notifiable events within Clinical Portal. 

Before configuring notification rules, the notification needs to be defined. Refer to 
Configuring Notifications for details. The administrator can then configure the rules to 
determine when the notification should trigger. 

A notification rule is made up of one or more rule sets, and rule sets are made up of one or 
more rule conditions. The notification is evaluated as described in the following list: 

• When a notification is enabled: 

o Rule conditions within a rule set are logically evaluated together with AND. This 
means for a rule set to be evaluated as true, all rule conditions within the rule 
set must be evaluated as being true. 

o Rule sets are logically evaluated together with OR. This means if any rule set is 
evaluated as true, then the notification is triggered. 

o If a notification has no rules, it is triggered. 

• When a notification is disabled, it is not triggered. 

Configuring Notification Rules includes the following topics: 

• Rule Conditions 

• Adding or Deleting Rule Conditions 

• Adding Rule Sets 

• Modifying Rule Conditions 

• Repeating Composite Data Rules 

 

 

Rule Conditions 

 

Notifications allows a provider to subscribe to notifiable events within Clinical Portal. Once 
an event and an associated notification are created, an administrator can configure the 
rules of the notification to determine when it should be triggered. 

A notification is made up of rule sets, and rule sets are made up of rule conditions for 
notification attributes. 
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Configuring Rule Conditions 

Rule conditions can be configured by: 

• Adding or Deleting Rule Conditions 

• Modifying Rule Conditions 

An attribute cannot be selected for notification rules evaluation where: 

• The data type of the selected attribute is not supported for rules evaluation, or 

• The comparison type has not been configured for the attribute on the event builder 
screen. For example attributes of the data type DATE_TIMEsupport two comparison 

types: 

Comparison Type Description 

PARTIAL_DATE This refers to the date to evaluate the 
attribute against. 

DATE_OFFSET This refers to the period in days before or 
after the date to evaluate the attribute 
against. 

Evaluation of Missing Data 

When a rule condition includes a field that contains no data, the way the condition is 
evaluated depends on whether it is a positive or a negative condition. Positive conditions 
consider missing data not to match, while negative rules consider missing data to match. 

• When a rule is defined on a field with no data, positive conditions such as is, 

contains, greater_than etc, do not match. 

• Because negative rule conditions are intended for exclusions, negative conditions 
such as is_not, not_contains, do match when no data is supplied. 

 

Adding or Deleting Rule Conditions 

 

Notifications allows a provider to subscribe to notifiable events within Clinical Portal. Once 
an event and an associated notification are created, an administrator can configure the 
rules of the notification to determine when it should be triggered. 

Adding Rule Conditions 

1. From Orion Health Platform, navigate to Configuration > Notifications. This displays 
the Notifications tab, with the notifications listed in the pane on the left. 

2. Select the name of the notification, to display details of the notification in the right pane, 
including the Notification Rules details. The details include the rule sets with their rule 
conditions, as shown in the following screenshot: 
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3. Select the Add Rule Condition link of the rule set where the rule condition should 
appear. This opens the Add a new rule condition dialog, displaying the event type 
data model in a tree. Expand the model, as shown in the following screenshot: 

 

 

4. Select the attribute within the model to create the rule condition on. 

5. Select the OK button on the notification details pane to add the selected attribute to its 
rule condition to the data set. 

6. Complete the details of the rule condition. Refer to Modifying Rule Conditions for 
details. 

Deleting Rule Conditions 

To delete a rule condition of a notification rule set, do the following: 

1. From Orion Health Platform, navigate to Configuration > Notifications. This displays 
the Notifications tab, with the notifications listed in the pane on the left. 

2. Select the name of the notification to display the details of the notification in the right 
pane. The details include the rule sets with their rule conditions. 
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3. Select the Delete icon  beside the rule condition to be deleted. If there are no more 
rule conditions in the rule set, the rule set will also be deleted. 

 

Modifying Rule Conditions 

 

Notifications allows a provider to subscribe to notifiable events within Clinical Portal. Once 
an event and an associated notification are created, an administrator can configure the 
rules of the notification to determine when it should be triggered. 

To modify a rule condition for an attribute of a notification rule set, do the following: 

1. From Orion Health Platform, navigate to Configuration > Notifications. This displays 
the Notifications tab, with the notifications listed in the pane on the left. 

2. Select the name of the notification, to display details of the notification in the right pane, 
including the Notification Rules details. The details include the rule sets and their rule 
conditions, as shown in the following screenshot. 

 

 

3. Modify the rule condition details of the attribute: 

o Select the rule operator for the rule from the first drop-down list. The rule 
operators available depend on the data type of the attribute. If the incoming 
trigger message is missing the data for the attribute, then positive operators will 
be evaluated as false, and negative operators will be evaluated as true. 

o Define the comparison value the attribute will be compared against. The way the 
comparison value is input depends on the data type of the attribute. For 
example, if the data type is a string, a text field is displayed; if the data type is a 
lookup, a drop-down list of configured lookup values is displayed. 

 

Adding Rule Sets 

 

Notifications allows a provider to subscribe to notifiable events within Clinical Portal. Once 
an event and an associated notification are created, an administrator can configure the 
rules of the notification to determine when it should be triggered. 
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Notification rules are made up of rule sets, and rule sets are made up of rule conditions. 
The rule sets determine whether the notification is triggered. 

1. From Orion Health Platform, navigate to Configuration > Notifications. This displays 
the Notifications tab, with the notifications listed in the pane on the left. 

2. Select the name of the notification, to display details of the notification in the right pane, 
including the Notification Rules details. The details can include one or more rule sets, 
each of which can include one or more rule conditions. 

 

 

3. Select the Create OR rule set link. This link is hidden if a rule set with no rule 
conditions already exists. Selecting this link creates an Add Rule Condition link, 
related to the rule set above it with OR. 

 

Repeating Composite Data Rules 

 

Notifications enables a healthcare provider to subscribe to types of notifiable events within 
Clinical Portal. Providers can subscribe to available notifications, and a set of notification 
rules based on the provider's subscription choices determine which notifications the 
provider receives. 

For repeating events, for example laboratory results, the rules are evaluated for each 
repeat. If all the rules are met for any repeat, then all the repeat results are passed to the 
detail formatting stage of processing. This stage determines what the provider is notified 
of. 

Sample Rule Evaluation 

This section explains the rule evaluation for a repeating event. A repeating laboratory 
result includes: 

• TestName 

• TestValue 

• Abnormality 

If the subscription rule for the laboratory result is: 

• TestName IS_NOT HbA1c 

• Abnormality CONTAINS Abnormal 
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Then the following incoming data for a repeating lab result gets evaluated as described in 
the following table: 

Incoming Data Result 
Evaluation 

Reason 

TestName = Eyesight 

TestValue = 20/20 

Abnormality = 
Abnormal 

Matches Both individual conditions are evaluated as 
true, 
so the entire condition is evaluated as true for 
the 
matching rule. 

TestName = HbA1c 

TestValue = 20/20 

Abnormality = 
Abnormal 

Does not match Only one of the two individual conditions 
matches, 
so the entire condition is evaluated as false 
for 
the matching rule. 

TestName = HbA1c 

TestValue = 20/20 

Abnormality = 
Abnormal 

 
TestName = Eyesight 

TestValue = 20/20 

Abnormality = 
Abnormal 

Matches Both individual conditions match on the 
second 
repeating lab result, so the entire condition is 
evaluated as true for the matching rule. 

TestName = Eyesight 

TestValue = 20/20 

Abnormality = Normal 

 
TestName = HbA1c 

TestValue = 20/20 

Abnormality = 
Abnormal 

Does not match Even though on each of the repeats one of 
the 
individual conditions matches, there is no 
repeat 
where both individual conditions match, so 
the 
entire condition is evaluated as false for the 
matching rule. 

No Repeats Does not match Because there are no repeats, there is no 
single 
repeat that matches both individual 
conditions, 
so the entire condition is evaluated as false. 

 

 

Configuring Relationship Types 
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Notifications allows a health care provider to subscribe to notifiable events, depending on 
the type of relationship between the provider and the patient. For example, the types of 
events the provider receives for patients they are the Primary Care Provider for can be 
different to those they receive for patients for which they are the referrer. 

The administrator can add, modify and delete the types of relationship that Notifications 
supports, for example, Primary Care Provider and Referring Provider. 

Configuring Relationship Types includes: 

• Adding or Deleting Relationship Types 

• Modifying Relationship Types 

Viewing Relationship Types 

1. From Orion Health Platform, navigate to Configuration > General > Relationship 
Types to display the Relationship Types tab, as shown in the following screenshot: 

 

 

2. Enter search characters in the field at the top of the Relationship Types panel to 

search for relationship types. Select the Clear icon  beside this field to clear the 
search. 

 

Adding or Deleting Relationship Types 

 

Notifications allows a health care provider to subscribe to notifiable events, depending on 
the type of relationship between the provider and the patient. The administrator can add 
and delete the types of relationship that Notifications supports. 

Adding a Relationship Type 

1. From Orion Health Platform, navigate to Configuration > General > Relationship 
Types to display the Relationship Types tab, as shown in the following screenshot: 
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2. Select the Add icon  at the top of the Relationship Types panel and select New 
Type from the drop-down menu. 
The Create Relationship Type dialog box is displayed. 

 

 

3. Enter a Relationship Type in the field. 

4. Select the OK button to add the relationship type and display the details of the new 
relationship type in the Relationship Type pane on the right. Refer to Modifying 
Relationship Types for details on how to update the relationship type. 

5. Select the Save button to save the relationship type. 

 

Deleting a Relationship Type 

1. From Orion Health Platform, navigate to Configuration > General > Relationship 
Types. 
The Relationship Types tab is displayed. 

2. Select the relationship you want to delete. 

The Delete icon  is enabled. 

 

 

3. Select the Delete icon . The Confirm Delete dialog box is displayed. 



Notifications 7.3.0 | Administration Manual v1.0  

 
 ____________________________________________________________________________________________________________  

 

 ____________________________________________________________________________________________________________  

Printed copies of this document may be out of date. Please refer to https://doki.orionhealth.com for the latest updates. 

© Copyright 2018 Orion Health Group of Companies | All rights reserved 123 

 

 

4. Select the Delete button. 
The relationship type is deleted. 

 

Modifying Relationship Types 

 

Notifications allows a health care provider to subscribe to notifiable events, depending on 
the type of relationship between the provider and the patient. The administrator can modify 
the types of relationship that Notifications supports. 

1. From Orion Health Platform, navigate to Configuration > General > Relationship 
Types to display the Relationship Types tab, as shown in the following screenshot: 

 

 

2. Select the name of the relationship type displayed in the Relationship Types panel. 
The details of the relationship type are displayed in the Configured Settings panel. 
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3. Update the fields as described in the following table: 

Field Description 

Display Name This refers to the name to be displayed for 
the relationship type. This field is 
mandatory and defaults to the value of 
Code. 

Code Ths refers to the unique code that 
identifies the relationship type. Defined 
when the relationship type is created and 
may not be edited. 

Description This refers to the description of the 
relationship type. 

Identity Type This refers to the identity type that 
describes the relationship with the patient. 
If no identity type is selected, the 
relationship can be established between 
the patient and identities of any type. All 
the identity types are available by default. 
To add an identity type, select the identity 
type from the Identity Type drop-down list. 

Valid For This refers to the period of days for which 
the relationship between the provider and 
the patient is valid. For example, if a 
patient is registered with a referred patient 
relationship with the provider, and the 
relationship is valid for 30 days, then the 
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Field Description 

provider will only receive notifications 
based on this relationship for 30 days after 
the relationship is created. 

This relationship type is supported for 
Notification Subscriptions 

When this checkbox is selected, the 
relationship type can be used for 
Notifications subscriptions. 

The Relationship Type Code 
configured to support 
Notifications must not be used 
as the Message Content 
Resolver name. Refer to 
Configuring a Message Content 
Resolver for details. 

 

4. Select the Save button to save the changes. 

 

Adding a New Relationship 

HIE does not provide a full relationship store. Instead, it reads from a database schema 
that can be used as a starting point for a real relationship store; thus, relationships are site 
specific. 

Default Core Package Configuration 

The information is stored in the Relationships table, which can be found in Orion Health 
Conductor by navigating to Databases > RelationshipStoreGeneric. A sample Rhapsody 
route which works with an Oracle Database is attached to this page. Contact Orion Health 
Support if you cannot download the attachment. 

Custom Relationship Store 

A template for creating views on another system can be found and downloaded as an 
example. 

1. From Orion Health Platform, navigate to General > Attachments and select 
com.orchestral.i12e.relationship.source.internal. The Module 

Attachments screen is displayed. 

2. Select create-relationshipstore-generic-view-schema.sql and select the 

Download button. 

3. Open the file in a text editor such as Notepad, and save the file with a new name. 

4. Check the file and replace information as required. 

5. Run the file against the database to create the view. 
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Default Subscription Configurations 

 

There are two ways a healthcare provider can receive a notification of an event that occurs 
relating to one or more patients: 

1. Subscriptions - The provider identifies the events to which the provider wants to 
subscribe. These are specified by logging into Clinical Portal as a user and navigating 
to My Subscriptions from the Notifications menu. 

2. Standard Subscriptions - The administrator identifies the events for which a 
notification will be sent to all providers who have a defined the relationship with one or 
more patients. These are specified by logging into Orion Health Platform. Refer to 
Standard Subscriptions for details. 

A provider's subscriptions list overrides the standard subscription list made by an 
administrator. When a provider is automatically subscribed to an event such as 
Inpatient Admission but chooses to unsubscribe to that event on their Notifications 
screen, the provider will no longer receive a notification when one of the patients is 
admitted. 

In addition, an administrator group can receive notifications of system events. 

Standard Subscriptions Overview 

Before a provider can receive a patient-related event notification, a relationship must be 
defined between the provider and the patient. When it has been done by an administrator, 
notifications can be configured in any of the following: 

1. Subscriptions for all patients - Notifications is generated for all patients with whom 
the provider has any type of defined relationship. 

2. Relationship-specific notifications - Notifications is generated for all patients with 
whom the provider has a specified relationship, for example, Assigned Doctor or 
Primary Care Provider. 

The administrator can configure one or more notification events and subscribe all 
providers to these notification events in standard subscriptions. These events can include 
the completion of an appointment or the arrival of a new laboratory result. The 
administrator can configure standard subscriptions for all patients and for those with a 
specified relationship with the provider. 

Refer to Standard Subscriptions for details on configuring these notification options. 

System Notifications Overview 

An administrator group can receive notifications of system events; for example, Default 

delivery methods changed, and Notification added. 

Refer to Standard Subscriptions for details on configuring these notification options. 

Refer to  Configuring the System Audience for details of specifying the system notification 
user group for this option. 
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Standard Subscriptions 

On the Standard Subscriptions tab, you can view and edit subscriptions to event 
notifications that are sent to healthcare providers. 
You can configure the following: 

• Default delivery methods - The default methods by which notifications are sent to 
users. 

• Subscriptions for System Notifications - Default subscription settings for 
notifications about configuration changes to notifications. 

• General Subscriptions - Default subscription settings for general notifications. 

• Default subscriptions for patients they have a relationship with - Default 
subscription settings for notifications concerning people with whom the provider has 
a relationship. 

To access the Standard Subscriptions tab, do the following: 

1. Log in to Orion Health Platform. 

2. Navigate to Configuration > Notifications > Notifications. 

3. Select the Standard Subscriptions tab at the top of the page. 
The Standard Subscriptions tab displays System and standard notifications. 
The System Event Recipient Group receives System notifications and a healthcare 
provider sees the standard notifications on their Notifications screen in Clinical Portal. 
Beside each notification type is the Audience that can receive that type of notification 
and its default delivery methods. 
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Your screen layout may differ from this image. 

Default Delivery Methods 

The Default Delivery Methods identify the default settings for providers subscribing to 
one or more notifications. Beside each delivery method is the Audience that can receive 
notifications by this delivery method. 
Refer to Default Delivery Methods in the Notifications User Manual for details on how to 
specify default delivery methods. 

To select additional or alternate delivery options for a notification, do the following: 

1. Select the Change link for the required notification. 

2. Select the relevant delivery option checkboxes. 
 

 

https://doki.orionhealth.com/display/NOT73/Default+Delivery+Methods
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Subscriptions for System Notifications 

The Standard Subscriptions tab is the only location in Orion Health Platform where 
you can configure System Notifications and their delivery options. Unlike the other 
options on this screen, System Notifications and Audiences are never displayed on 
the My Subscriptions screen. 

The Subscriptions for System Notifications panel identifies the event notifications that 
the System Event Recipient Group receives. System event notifications track 
configuration changes made to Notifications by other administrators. The following 
diagram shows the users who receive notifications for system events: 

 

Refer to Subscribing to Notifications for a User for details on how to configure notifications 
on behalf of a user. 
System Notification rules are configured in the same way as other notifications. Refer to 
Subscribing to Notifications in the User Manual for details. 

Default Subscriptions for Patients They Have a Relationship With 

The Default subscriptions for patients they have a relationship with panel identifies 
the notification events a provider can subscribe to for a patient that the provider has a 
relationship with. If the checkbox next to a notification event is selected, then this event will 
be selected by default in the provider's Notifications screen. 

Refer to Subscribing to Notifications in the User Manual for details about configuring the 
rules associated with notifications. 

Change to Subscribe by Relationship Type 

Selecting the Change to subscribe by Relationship Type link at the bottom of the 
screen switches the view to list the default subscriptions for each available relationship 
type. 

 

https://doki.orionhealth.com/display/NOT73/Subscribing+to+Notifications
https://doki.orionhealth.com/display/NOT73/User+Manual
https://doki.orionhealth.com/display/NOT73/Subscribing+to+Notifications
https://doki.orionhealth.com/display/NOT73/User+Manual
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Default subscriptions are configured in the same way as the previously described 
subscriptions. It controls which notification events a provider can subscribe to for each 
relationship type they have with a patient. 

Refer to Subscriptions by Relationship Type in the User Manual for details. 

 

Configuring a Message Content Resolver 

 

Notifications allows a health care provider to receive notifications based on the content of 
events. The administrator can configure a new recipient resolver based on paths in the 
notification message to allow a notification to go to a recipient identified in that path in the 
message. 

Enable the Cache groups on the Identity Source Management screen to boost 
performance when Message Content Resolver is used and configured. 

Configuring a Message Content Resolver includes: 

• Adding a Message Content Resolver 

• Modifying a Message Content Resolver 

• Deleting a Message Content Resolver 

Adding a Message Content Resolver 

1. From Orion Health Platform, navigate to Configuration > Notifications and select 
Notifications (Advanced) on the left panel. 

2. Select the Message Content Resolver tab. 

 

 

3. Select the Add icon  at the top of the panel, and select New Message Content 
Resolver from the drop-down list. This opens a Create a message Content Recipient 
Resolver dialog box. 

https://doki.orionhealth.com/display/NOT73/Subscriptions+by+Relationship+Type


Notifications 7.3.0 | Administration Manual v1.0  

 
 ____________________________________________________________________________________________________________  

 

 ____________________________________________________________________________________________________________  

Printed copies of this document may be out of date. Please refer to https://doki.orionhealth.com for the latest updates. 

© Copyright 2018 Orion Health Group of Companies | All rights reserved 131 

 

 

4. Enter the display name of the new recipient resolver, and select the OK button to add 
the Content Recipient Resolver. This displays the Event Type Paths panel. 
 
 

 

The Message Content Recipient Resolver name must not be the same as the 
Relationship Type Code used for Notifications Subscriptions. When this happens, 
the following message is displayed on the screen: 

 

 

5. Enter a description of the new Content Recipient Resolver in the Description field. 

6. Select the Add button to add the event type path details. This opens the Event Path 
Configuration dialog box. 
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7. Update the fields as described in the following table: 

Field Description 

Event Type Name Select the relevant event type from the 
drop-down list. The events are configured 
in the Events tab. 

Base Path Enter an XPath to the base node of the 
identifier. The base node is the parent 
node of the identifier and namespace 
attributes. 

Namespace The name of the attribute, that is a child of 
the base node, that contains the Identity 
namespace. The value should always 
match the namespace of an Identity 
Service defined in the Identity 
configuration page. 

Identifier The name of the attribute, that is a child of 
the base node, that contains the Identity 
identifier. This identifies the Notifications 
user that will be the recipient of the 
notification. 

This information can be obtained from the XML code of the notification message, for 
example: 

<?xml version="1.0" encoding="UTF-8" standalone="yes"?> 

<LaboratoryResult> 

  <messageInformation> 

    <messageId>2</messageId> 

    <dateTimeOfMessage>2009-09-22T13:56:30.381+12:00</dateTimeOfMessage> 

  </messageInformation> 

  <content> 

    <patientSummary> 

      ... 

    </patientSummary> 
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    <eventContent> 

      ... 

      <OrderingClinician> 

        <namespace>portal6x-login</namespace> 

        <id>hart</id> 

      </OrderingClinician> 

      ... 

    </eventContent> 

  </content> 

</LaboratoryResult> 

8. Select the OK button to add the event path details. 

9. Select the identity class from the Identity Class drop-down list. 

10. Select the Save button to save the Content Recipient Resolver details. 

Modifying a Message Content Resolver 

1. Select the Message Content Resolver. This opens the Event Type Paths details in the 
right pane: 

 

 

o Description 
Change the description of the Content Recipient Resolver as required. 

o Event Type Paths Table 
Select the Edit button and change the fields as required. Refer to Adding a 
Message Content Resolver for details. 

o Identity Class 
Select the identity class from the Identity Class drop-down list. 

2. Select the Save button to save the Content Recipient Resolver details. 

Deleting a Message Content Resolver 

1. Select the Message Content Resolver and select the Delete icon  at the top of the 
panel. This opens the Confirm Delete dialog box. 
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2. Select the Delete button to delete the Message Content Resolver. 

 

 

Configuring the Clinical Portal User Identity Source 

Delivery Channels require the address information of Portal users in order to send them 
Notifications. This information is set through the users' My Details pages and is retrieved 
by Notifications by querying the Identity Service. 

The Identity Service should be configured with one Identity Source that provides Clinical 
Portal Users, such as the Remote Clinical Portal 7.x. Users Identity Source. This Identity 
Source needs to point to the information stored in the My Details screen and expose it as 
attributes that can be retrieved by any application calling the Identity Service. 

Configure the Identity Sources 

Configure the Clinical Portal Users identity source: 

• Add the following attribute mappings: 

o Global DirectEmail, NotificationsRecipient attribute map to Source 

DirectEmail, Notifications attribute. 

o Global EMR, NotificationsRecipient attribute map to Source EMR, 

Notifications attribute. 

 

Refer to Adding Attribute Mapping for details. 

• Add the following group mappings: 

o Global Notifications group map to Source Notifications group. 

o Global Notifications Admin group map to Source Notifications 

Admin group. 

Refer to Adding Group Mapping for details. 

Ensure that an identity source for patients is configured. 

https://doki.orionhealth.com/display/NOT73/My+Details
https://doki.orionhealth.com/display/OHP74/Portal7x+Web+Service+Provider+Identity+Source
https://doki.orionhealth.com/display/OHP76/Adding+Attribute+Mapping
https://doki.orionhealth.com/display/OHP76/Adding+Group+Mapping
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Configuring the Identity Sources by Importing Config.XML File 

1. From Orion Health Platform, navigate to Configuration > General > Identity. 
Note the Identity Source that provides the "Clinical Portal User" Identity Type (for 
example, Remote Clinical Portal 7.x. Users). 

2. Navigate to Configuration > General > Configuration Explorer. 

3. Search for 
com.orchestral.core.identity.config.IdentitySourceConfig. 

4. Select the Identity Source noted earlier and select Export Selected. 

5. Extract config.xml from the downloaded zip file, open it in an editor and make the 

following changes: 

o In the Identity Source's 
mapping/com.orchestral.core.identity.config.IdentitySchemaM

apping/globalToSourceAttributeNames element, add the following 

entries. 
Refer to Sample Clinical Portal Users Configuration File for details. 

<entry> 

 <key> 

 

 <com.orchestral.core.identity.source.api_6_4.AttributeName> 

   <identifier>EMR</identifier> 

   <schemaName>NotificationsRecipient</schemaName> 

 

 </com.orchestral.core.identity.source.api_6_4.AttributeName> 

 </key> 

 <value> 

 

 <com.orchestral.core.identity.source.api_6_4.AttributeName> 

   <identifier>EMR</identifier> 

   <schemaName>Notifications</schemaName> 

 

 </com.orchestral.core.identity.source.api_6_4.AttributeName> 

 </value> 

</entry> 

<entry> 

 <key> 

 

 <com.orchestral.core.identity.source.api_6_4.AttributeName> 

   <identifier>DirectEmail</identifier> 

   <schemaName>NotificationsRecipient</schemaName> 

 

 </com.orchestral.core.identity.source.api_6_4.AttributeName> 

 </key> 

 <value> 

 

 <com.orchestral.core.identity.source.api_6_4.AttributeName> 

   <identifier>DirectEmail</identifier> 

   <schemaName>Notifications</schemaName> 

 

 </com.orchestral.core.identity.source.api_6_4.AttributeName> 

 </value> 

</entry> 

<entry> 

 <key> 
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 <com.orchestral.core.identity.source.api_6_4.AttributeName> 

   <identifier>inactive</identifier> 

   <schemaName>IdentityStatus</schemaName> 

 

 </com.orchestral.core.identity.source.api_6_4.AttributeName> 

 </key> 

 <value> 

 

 <com.orchestral.core.identity.source.api_6_4.AttributeName> 

   <identifier>inactive</identifier> 

   <schemaName>IdentityStatus</schemaName> 

 

 </com.orchestral.core.identity.source.api_6_4.AttributeName> 

 </value> 

</entry> 

o In the Identity Source's 
mapping/com.orchestral.core.identity.config.IdentitySchemaM

apping/globalToSourceGroupNames element, add the following entries: 

<globalToSourceGroupNames> 

 <entry> 

  <key>Notifications Admin</key> 

  <value>Notifications Admin</value> 

 </entry> 

 <entry> 

  <key>Notifications</key> 

  <value>Notifications</value> 

 </entry> 

 <entry> 

  <key>Responsible Clinicians</key> 

  <value>Responsible Clinicians</value> 

 </entry> 

 <entry> 

  <key>Result Sign-off</key> 

  <value>Results SignOff</value> 

 </entry> 

</globalToSourceGroupNames> 

6. From Orion Health Platform, navigate to Configuration > General > Configuration 
Explorer. 

7. Import the modified config.xml file. 

Inactive Users 

When a Portal user is deleted, the user is not actually deleted, instead, a flag (attribute) is 
set to indicate that the user is inactive. This allows a user to be reinstated in Portal at a 
later stage. 

Notifications on Portal Versions Later Than 7.4 

In Portal versions 7.4 or later, when evaluating the relationships for notification delivery, 
the identity source returns both active and inactive users with a relationship for the 
notification being processed. Any inactive recipients are then filtered out so that 
notifications are not sent to these users. 
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Notifications on Portal Versions Prior to 7.4 

Identity sources in versions of Portal prior to 7.4 should not return inactive or deleted 
users. 

Sample Clinical Portal Users Configuration File 

<?xml version="1.0" encoding="UTF-8"?> 

<com.orchestral.core.configuration.api_6_0.ConfigurationService 

xmlns="http://www.orionhealth.com/configuration" version="3" date="2012-10-

30T17:47:01.365" platformId="454765572" type="SNAPSHOT" username="core-

platform:administrator"> 

    <com.orchestral.core.identity.source.api_6_4.IdentityType id="5391" 

version="1"> 

        <identityClass>INDIVIDUAL</identityClass> 

        <name>Clinical Portal User</name> 

    </com.orchestral.core.identity.source.api_6_4.IdentityType> 

    

<com.orchestral.bespoke.identity.source.portal7webservice.config.ConcertoIdentitySo

urceConfiguration id="5399" version="3"> 

        <alternateNamespaces/> 

        <appliesToAllIdentityTypes>false</appliesToAllIdentityTypes> 

        <appliesToAllNamespaces>false</appliesToAllNamespaces> 

        <cacheGroups>false</cacheGroups> 

        <cacheIdentities>true</cacheIdentities> 

        <disabled>false</disabled> 

        

<identitySourceId>com.orchestral.bespoke.identity.source.portal7webservice.config.C

oncertoIdentitySourceConfiguration:Portal 7 Web Service User</identitySourceId> 

        <identityTypes> 

            <value> 

                <com.orchestral.core.identity.source.api_6_4.IdentityType 

refId="5391" version="1"/> 

            </value> 

        </identityTypes> 

        <loginNamespace>clinical-portal-user</loginNamespace> 

        <mapping> 

            <com.orchestral.core.identity.config.IdentitySchemaMapping> 

                <globalToSourceAttributeNames> 

                    <entry> 

                        <key> 

                            

<com.orchestral.core.identity.source.api_6_4.AttributeName> 

                                <identifier>EMR</identifier> 

                                <schemaName>NotificationsRecipient</schemaName> 

                            

</com.orchestral.core.identity.source.api_6_4.AttributeName> 

                        </key> 

                        <value> 

                            

<com.orchestral.core.identity.source.api_6_4.AttributeName> 

                                <identifier>EMR</identifier> 

                                <schemaName>Notifications</schemaName> 

                            

</com.orchestral.core.identity.source.api_6_4.AttributeName> 

                        </value> 

                    </entry> 

                    <entry> 

                        <key> 

                            

<com.orchestral.core.identity.source.api_6_4.AttributeName> 

                                <identifier>DirectEmail</identifier> 
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                                <schemaName>NotificationsRecipient</schemaName> 

                            

</com.orchestral.core.identity.source.api_6_4.AttributeName> 

                        </key> 

                        <value> 

                            

<com.orchestral.core.identity.source.api_6_4.AttributeName> 

                                <identifier>DirectEmail</identifier> 

                                <schemaName>Notifications</schemaName> 

                            

</com.orchestral.core.identity.source.api_6_4.AttributeName> 

                        </value> 

                    </entry> 

                    <entry> 

                        <key> 

                            

<com.orchestral.core.identity.source.api_6_4.AttributeName> 

                                <identifier>emailAddress</identifier> 

                                <schemaName>IdentityStandard</schemaName> 

                            

</com.orchestral.core.identity.source.api_6_4.AttributeName> 

                        </key> 

                        <value> 

                            

<com.orchestral.core.identity.source.api_6_4.AttributeName> 

                                <identifier>E-mail</identifier> 

                                <schemaName>Users</schemaName> 

                            

</com.orchestral.core.identity.source.api_6_4.AttributeName> 

                        </value> 

                    </entry> 

                    <entry> 

                        <key> 

                            

<com.orchestral.core.identity.source.api_6_4.AttributeName> 

                                <identifier>fullName</identifier> 

                                <schemaName>IdentityStandard</schemaName> 

                            

</com.orchestral.core.identity.source.api_6_4.AttributeName> 

                        </key> 

                        <value> 

                            

<com.orchestral.core.identity.source.api_6_4.AttributeName> 

                                <identifier>Full Name</identifier> 

                                <schemaName>Users</schemaName> 

                            

</com.orchestral.core.identity.source.api_6_4.AttributeName> 

                        </value> 

                    </entry> 

                    <entry> 

                        <key> 

                            

<com.orchestral.core.identity.source.api_6_4.AttributeName> 

                                <identifier>inactive</identifier> 

                                <schemaName>IdentityStatus</schemaName> 

                            

</com.orchestral.core.identity.source.api_6_4.AttributeName> 

                        </key> 

                        <value> 

                            

<com.orchestral.core.identity.source.api_6_4.AttributeName> 

                                <identifier>inactive</identifier> 

                                <schemaName>IdentityStatus</schemaName> 
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</com.orchestral.core.identity.source.api_6_4.AttributeName> 

                        </value> 

                    </entry> 

                </globalToSourceAttributeNames> 

                <globalToSourceGroupNames> 

                    <entry> 

                        <key>Notifications Admin</key> 

                        <value>Notifications Admin</value> 

                    </entry> 

                    <entry> 

                        <key>Notifications</key> 

                        <value>Notifications</value> 

                    </entry> 

                    <entry> 

                        <key>Responsible Clinicians</key> 

                        <value>Responsible Clinicians</value> 

                    </entry> 

                    <entry> 

                        <key>Result Sign-off</key> 

                        <value>Results SignOff</value> 

                    </entry> 

                </globalToSourceGroupNames> 

            </com.orchestral.core.identity.config.IdentitySchemaMapping> 

        </mapping> 

        <name>Remote Clinical Portal 7.x Users</name> 

        <namespaces> 

            <value>clinical-portal-user</value> 

        </namespaces> 

        <primaryNamespace>clinical-portal-user</primaryNamespace> 

        <useMapping>true</useMapping> 

        <useOverlay>false</useOverlay> 

        <useOverlayAsSearchCache>false</useOverlayAsSearchCache> 

        <userManagerServiceId>ClinicalPortalUserStoreService</userManagerServiceId> 

    

</com.orchestral.bespoke.identity.source.portal7webservice.config.ConcertoIdentityS

ourceConfiguration> 

</com.orchestral.core.configuration.api_6_0.ConfigurationService> 

 

 

Configuring Messaging 

1. From Orion Health Platform, navigate to Configuration > General > Messaging to 
display a list of the default messages: 
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2. Configure Outbound messaging: 

a. Select Asynchronous Notification XML over TCP and configure the outbound 
endpoints. Refer to Configuring Outbound Endpoints for details. 

It is recommended to use port 63009. 

b. Select Synchronous Notification XML over TCP and configure the outbound 
endpoints. Refer to Configuring Outbound Endpoints for details. 

It is recommended to use port 63008. 

 

Configure Web Services 

Notifications uses a web service called UserMessagingService for delivery of 

notifications through the Concerto User Messaging delivery channel. This web service is 
called by Rhapsody when delivering messages using this channel. However, by default, it 
is disabled. Refer to Configuring a Published Web Service to enable this web service. 

 

https://doki.orionhealth.com/display/OHP76/Configuring+Outbound+Endpoints
https://doki.orionhealth.com/display/OHP76/Configuring+Outbound+Endpoints
https://doki.orionhealth.com/display/OHP76/Configuring+a+Published+Web+Service
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Configuring Integration Views 

When Notifications is installed, it includes the RDE Orion Views and Relationship 

Store databases. These databases are preconfigured to point to a database that is not a 

supported production configuration. 

Each database must be configured to connect to the following: 

• An existing server 

• The users created for the respective database 

Perform the following tasks as part of configuring the integration views: 

• Configuring Relationship Store 

• Configuring RDE Orion Views 

 

 

Configuring RDE Orion Views 

When configuring the Notifications RDE Orion Views database as described in 

Configuring Databases, do one of the following: 

• If your site has an existing RDE 2.x install, then select the server of your existing 
RDE Orion Views database. 

• Select an existing database server with an Orion_PatientMerges view that 

implements the new contracts. 

• Select the server of your existing RDE Orion Views database. 

 

1. Select the attachment in the 
com.orchestral.bespoke.identity.source.rde_2_0.patient module in 

the pane on the left, to display its attachments in the pane on the right, as shown in the 
following screenshot: 
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2. Download the appropriate script and update it appropriately for your environment. 

3. Run the updated script to create the views. 

 

Prerequisites 

• Select the server of your existing Relationship Store database, when 

configuring the Notifications Relationship Store database. 

Refer to Configuring Databases for more details. 

• Create a view for the Notifications Relationship Store database that is 

appropriate for your site. 

To download and update a sample .sql script file and configure the Relationship 

Store database: 

1. From Orion Health Platform, navigate to Configuration > Attachments. 

https://doki.orionhealth.com/display/OHP74/Configuring+Databases
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2. Select the com.orchestral.i12e.relationship.store.generic module in the 

pane displayed. This displays its attachments in the pane on the right, as shown in the 
following screen shot: 
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3. Under Attachment Files in the right pane, check whether the appropriate script is 
attached. 

4. Select the Download Selected link to download the script attached. This script 
contains comments describing the content. It is an example only, and will not run until 
you update it for your environment. 

5. Update the downloaded script appropriately for your environment. 

6. Run the updated script to create the views. 

 

Configuring the My Subscriptions and User Subscription Entry 
Points 

Notifications provides two Clinical Portal entry points that can be used to modify 
subscriptions: 

• The My Subscriptions entry point can be accessed by a subscriber and is used to 
manage that subscriber's notification subscriptions. 

• The User Subscription entry point allows administrators to manage subscriptions 
of Notifications users on their behalf. Refer to Subscribing to Notifications for a User 
for details about this feature. 

You can customize the parameters of these entry points. To configure an entry point, do 
the following: 

1. Log in to Clinical Portal as an administrator. 

2. Navigate to Concerto > Applications and select Notifications. 
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3. Navigate to the Entry Points tab and select either the My Subscriptions or the User 
Subscription entry point. 

4. Select the Entry Redirection link to open a configuration window. 

 

 

5. Configure the query parameters as follows: 

Parameter name Description 

subscriberId The identifier of the user whose 
subscriptions is edited. For the My 
Subscriptions entry point, the default 
value of subscriberId is the ID of the 

currently logged in user. For the User 
Subscription entry point, the default value 
of subscriberId is the ID of the user 

currently in the Clinical Portal context. 

subscriberNamespace The namespace of the user to edit the 
subscriptions for. By default, this is 
clinical-portal-user. 

notifySubscriptionsChanged This sets whether or not to trigger a User 

Subscriptions Changed system event 

and notify the user that their subscriptions 
have changed. For the My Subscriptions 
entry point, the default value is false. For 
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Parameter name Description 

the User Subscription entry point, the 
default value is true. 

6. Select OK to save changes. 

 

Configuring Audiences 

Audiences allow notifications to be sent to different sets of users such as clinicians, 
patients, administrators can receive only notifications relevant to them. 

By default, Notifications ships with two audiences: 

• Default Audience - Used for non-system notifications. 

• System Audience - Targets users that are intended to receive notifications 
triggered by system events. 

When distinct groups of users exist, an administrator must determine the notification types 
for each audience. Refer to the following: 

• Viewing Audiences 

• Adding, Editing, or Deleting Audiences 

• Configuring an Audience 

• Configuring the System Audience 

Once an Audience exists, it can be assigned to a notification type. Refer to Configuring a 
Notification. 

Viewing Audiences 

1. From Orion Health Platform, navigate to Configuration > Notifications > Audiences. 
The Audiences tab lists audiences, along with the number of groups in each audience. 
 
 

 

 

2. To search for a specific audience, enter the name in the Search field. 

3. To clear search results, select the Clear icon . 
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Adding, Editing, or Deleting Audiences 

Adding an Audience 

1. From Orion Health Platform, navigate to Configuration > Notifications > Audiences. 
The Audiences tab displays the audiences in the left panel. 

2. Select the Add icon at the top of the Audience panel. 
The Create a new Audience dialog box is displayed. 

 

 

3. Enter the following values for the new audience: 

o Key 

o Name 

4. Select the OK button to save the new audience. 

When you create a new audience, a translation key is created with its value set to the 
new audience name. If you subsequently update the audience name, you must 
update the translation database independently for each required language. 

Editing an Audience 

1. From Orion Health Platform, navigate to Configuration > Notifications > 
Notifications > Audiences. 
The Audiences tab displays audiences in the left panel. 

2. Select the Audience that you want to edit. 
The Audience Details pane is displayed. 
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3. Edit the name. 

4. Configure Groups and Delivery Channels for the Audience. 

5. Select the Save button to save your changes. 

Deleting an Audience 

You cannot delete a System Audience. 

1. From Orion Health Platform, navigate to Configuration > Notifications > 
Notifications > Audiences. 
The Audiences tab displays audiences in the left panel. 

2. Select the audience that you want to delete. 

3. Select the Delete icon at the top of the Audience panel. 
The Confirm Deletion dialog box is displayed. 
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4. Select the Delete button to delete the audience. 

 

Configuring an Audience 

You need to configure the following details for each notifications audience: 

• Groups - You must define a group before you add it to an audience. 
Refer to Configuring Identity Schema - Adding a New Group or Role and Adding 
Group Mapping in the Orion Health Platform Administration Manual for details. 

• Allowed Delivery Channels 

• Primary Delivery Channel - You must define a Delivery Channel before you add it 
to an audience. 
Refer to Configuring Notification Delivery Channels. 

 

1. From Orion Health Platform, navigate to Configuration > Notifications > Audiences. 
The Audiences tab lists the audiences in the left panel. 

2. Select the audience that you want to configure. The Audience Details section is 
displayed. 

https://doki.orionhealth.com/display/public/OHP710/Configuring+Identity+Schema#ConfiguringIdentitySchema-AddingaNewGrouporRole
https://doki.orionhealth.com/display/public/OHP710/Adding+Group+Mapping
https://doki.orionhealth.com/display/public/OHP710/Adding+Group+Mapping
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You need to add Groups to the audience. 

3. Select the Add button in the Groups section. The Add a Group dialog box is 
displayed. 

 

 

4. Select the Group that you want to add from the drop-down list. 

5. Select the OK button to return to the Audience Details section. 

6. Add other Groups as you require. 

To remove a Group, select the group, and then select Delete. 

You need to add allowed delivery channels to the audience. 

7. Select the Add button in the Delivery Channels section. The Add a Delivery Channel 
dialog box is displayed. 
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8. Select the Delivery Channel that you want to add from the drop-down list. 

9. Select the OK button to return to the Audience Details section. 

10. Add other Delivery Channels as required. 

To remove a Delivery Channel, select the Delivery Channel and then select the 
Delete button. 

You need to specify the Primary Delivery Channel for the audience. 

For more information about the Primary Delivery Channel, refer to Specifying the 
Primary Delivery Channel for an Audience. 

11. Choose the delivery channel that you require from the Primary Channel drop-down 
list. 

You can only choose an Allowed Delivery Channel as the Primary Channel. 

12. Select the OK button. 

13. Select the Save button to save your changes. 

Configuring the System Audience 

By default, Notifications comes with a System Audience that targets the Notification 
Admin user group to receive notifications triggered by system events. An administrator can 
specify other user groups to receive notifications triggered by system events to notify 
users of changes made to the configuration and the state of notifications. 

Configuring a System Notification User Group 

Before adding a group to an audience, the group needs to be defined. Refer to Configuring 
Identity Schema - Adding a New Group or Role and Adding Group Mapping in the Orion 
Health Platform Administration Manual for details. 

 To configure the system notifications user group, do the following: 

https://doki.orionhealth.com/display/public/OHP710/Configuring+Identity+Schema#ConfiguringIdentitySchema-AddingaNewGrouporRole
https://doki.orionhealth.com/display/public/OHP710/Configuring+Identity+Schema#ConfiguringIdentitySchema-AddingaNewGrouporRole
https://doki.orionhealth.com/display/public/OHP710/Adding+Group+Mapping
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1. From Orion Health Platform, navigate to Configuration > Notifications. Select 
Notifications on the left panel. 

2. Select the Audiences tab to display all audiences as shown in the following 
screenshot: 

 

 

4. Select System Audience. This opens the Audience Details pane. 
5. To add a group to System Audience, select the Add button.This opens the Add a 
Group pane as shown in the following screenshot. 

 

 

6. From the drop-down list, add the system notification user group configured in step one 
and select the OK button. This adds the group to the Groups section of the Audience 
Details pane as shown in the following screenshot: 
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7. Add other groups, if required. 

8. To add an allowed delivery channel to the System Audience, select the Add button in 
the Delivery Channels section. You will be presented with a dialog as shown in the 
following screenshot: 

 

 

To specify the Primary Delivery Channel for the System Audience, select a Delivery 
Channel from the drop-down list and then select the OK button. 
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Only an Allowed Delivery Channel can be chosen as the Primary Delivery Channel 
for the chosen Audience. 

For more information about the Primary Delivery Channel, refer to Specifying the Primary 
Delivery Channel for an Audience. 

9. Select the Save button to save your changes. 

Deleting a group from the System Audience 

To remove a group, select the group and then select the Delete button. Select the 
Save button to save your change. 

 

System Audience Deletion 

You cannot delete a System Audience. 

 

System Notification Messages 

The system notification message includes the sections described in the following table: 

Message Section Description 

Message header This refers to any message header configured by the 
organization. This is the same for all messages. 

System notification 
message body 

This refers to the body of the system notification tailored to the 
delivery method. 

Message footer This refers to any message footer configured by the 
organization. This is the same for all messages. 

 

A sample system notification message body is shown in the following image: 
 
 

 

 

 

Specifying the Primary Delivery Channel for an Audience 

You need to specify a primary delivery channel for each notifications audience so the 
members can receive notifications. The primary delivery channel is the only channel 
Notifications uses for guaranteed message delivery. Notifications considers a notification 
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as delivered only when the primary delivery channel succeeds in delivering it. Until the 
notification is delivered, Notifications continues retrying. 

Primary delivery channel messages are always sent first. When they are delivered 
successfully, messages are also sent through the configured secondary delivery channels. 
However, the secondary channels do not ensure successful delivery. Errors for secondary 
channels are reported (through logging and audit) only at the start of delivery. Errors 
related to unsuccessful delivery are not reported because secondary channels are 
asynchronous. 

Subscribed (textual) events are always sent through the primary delivery channel, but 
digest messages are never sent through this channel. Because textual notifications are 
sent through the primary delivery channel, you must secure it to send sensitive information 
by selecting the Supporting "Detail" messages option. 

You must not disable the primary delivery channel causing Notifications delivery to 
fail and exception errors to occur. 

When configuring an audience for Notifications users in Clinical Portal, make sure the 
primary delivery channel specified in an audience is the same as the primary delivery 
channel specified in other audiences. 

The Notifications users in Patient Portal, however, can have a primary delivery 
channel that is different from the primary delivery channel specified in Clinical Portal. 

For example, if there are two audiences with Patient Portal and Clinical Portal 
subscriptions respectively, Email can be used as the primary delivery channel for 
Patient Portal and Concerto User Messaging as the primary delivery channel for 
Clinical Portal. If there are two audiences with Clinical Portal subscriptions, both 
audiences should have the same primary delivery channel such as Concerto User 
Messaging. 

To specify the Primary Delivery Channel for an Audience: 

1. Log in to the Orion Health Platform. 

2. Navigate to Configuration > Notifications > Notifications > Audiences. 

 

 

3. Select the audience for which you want to configure the primary delivery channel. 
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Ensure that Allowed Delivery Channels are configured for the selected 
audience. 

4. Configure delivery channels. 

Field Details 

Primary Channel Select the channel that you want to use as 
the primary delivery channel, such as 
Concerto User Messaging. 

You can select only an Allowed 
Delivery Channel as the 
Primary Delivery Channel. 

 

Primary Channel Displayed on 
Subscriptions Screen 

Select this checkbox to display the primary 
channel on the My Subscriptions page of 
Clinical Portal. 

A hidden primary delivery 
channel configured for a 
Notifications audience will still 
appear in the Standard 
Subscriptions page of 
Platform. 
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5. Select the Save icon  to save your changes. 

 

Exporting and Importing Configuration Files 

You can update configuration data by exporting a configuration file, manually changing it, 
and importing it back into Notifications. You can also import new configuration data into 
Notifications. 
Alternatively, you may want to export your existing configuration to back it up. 

This section includes the following topics: 

• Exporting and Importing Notifications Configuration 

• Exporting and Importing an Event Type Configuration 

 

Exporting and Importing Notifications Configuration 
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This section describes the steps involved in exporting and importing the following 
Notifications configuration: 

• Exporting and importing all applications in Orion Health Platform 

• Exporting and importing only Notifications 

Exporting All Application Configurations 

1. Export all configurations: 

a. From Orion Health Platform, navigate to Configuration > Configuration 
Explorer to display the Configuration Explorer tab, as shown in the following 
screenshot: 

 

 

b. Select the Enable Export Mode icon . 

c. Select the Select All link in the pane on the right, and select the Export button 
at the bottom of the screen. 

The exported file will include all certificates. 

 

 

Exporting Notifications Configurations Only 

1. Export Notifications configurations: 

a. From Orion Health Platform, navigate to Configuration > Configuration 

Explorer and select the Enable Export Mode icon  to display the classes to 
be exported in the right pane: 
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b. Check the classes listed in Configuration Export Classes, and select the Export 
button at the bottom of the screen. 

2. Export certificates and private keys: 

a. Navigate to Configuration > Certificates, select the 
ConcertoServerCertificate certificate from the Certificate pane on the 

left and select the Download link in the Certificate pane on the right. 

b. Select the NotificationsConcertoKey private key from the Certificate 

pane on the left, and select the Download link beside Download Private Key 
and beside Download Certificate in the Certificate pane on the right. 

 

 

Importing Notifications Configuration 

1. Stop the Rhapsody™ Integration Engine (Rhapsody) service. 
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2. Stop the Notifications service. 

3. Back up the Notifications directory on the Notifications server. 

4. Start the Notifications service. 

5. Import the Notifications configurations you exported earlier. Refer to Step 1 of the 
appropriate instructions above. From the Orion Health Platform menu, navigate to 

Configuration > Explorer and select the Enable Import Mode icon . 

When importing, the certificates will be imported, but not the private key. 

 

If you get a certificate validation error, check the 
Configuration_XXX.zip/config.xml configuration file: 

1. Find the first line that is similar to the following: 

<?xml version="1.0" encoding="UTF-8"?><com.orchestral.core 

.configuration.api_6_0.ConfigurationService xmlns="http:// 

www.orionhealth.com/configuration" date="1"> 

2. Find date="1" and replace this with version="1" 

 
After the change, it should look similar to the following: 

<?xml version="1.0" encoding="UTF-8"?><com.orchestral.core 

.configuration.api_6_0.ConfigurationService xmlns="http:// 

www.orionhealth.com/configuration" version="1"> 

3. Save the modified config.xml file back into the Configuration_XXX.zip 

file, and reimport the Notifications configurations. 

 

6. Import certificates and private keys. To completely import the 
NotificationsConcertoKeyprivate key and certificate: 

a. Delete the NotificationsConcertoKey certificate you imported in Step 5. 

above, and then import it and its private key. 

b. Navigate to Configuration > Certificates, select the icon  to open the Add 
Private Key dialog box, and select the Imported option for Private Key Type. 

c. Select the Browse button to browse the key and related certificate files, then 
select the Upload button and select the OK button. 

7. Configure Clinical Portal web services: 

a. Navigate to Configuration > Portal Web Services. In the left pane, select the 
correct client certificate and server certificate for your web service configuration; 
that is, select PortalServer. 
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b. In the right pane, select the newly imported certificates from the Client 
Certificate and Server Certificate drop-down lists, as shown in the following 
screenshot: 

 

 

c. Select the Save icon at the top of the pane. 

8. Start the Rhapsody service. 

 

 

Configuration Export Classes 

 

Configuration Export Classes lists the classes to export when exporting only the 
Notifications configuration. Refer to Exporting and Importing Notifications Configuration for 
details. 

Check the classes in the following table on the Orion Health Platform configuration export 
page to perform a full Notifications configuration export: 

Notification 

Class Purpose Ma
nda
tory 
to 
Exp
ort
? 

com.orchestral.notification.conf

iguration.DocumentTypeConfigurat

ion 

Configuration of the Document Types.  

com.orchestral.notification.conf

iguration.EMRSystemConfiguration 
Configuration of the EMR System.  
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Class Purpose Ma
nda
tory 
to 
Exp
ort
? 

com.orchestral.notification.conf

iguration.EventPathConfiguration 
Configuration of the Event Path.  

com.orchestral.notification.conf

iguration.MessageContentRecipien

tConfiguration 

Configuration of the Message Content 
Recipient. 

 

com.orchestral.notification.conf

iguration.NotificationTypeConfig

uration 

Configuration of the Notification Types.  

com.orchestral.notification.conf

iguration.NotificationAudienceCo

nfiguration 

Non-system Audience configuration.  

com.orchestral.notification.conf

iguration.NotificationSystemAudi

enceConfiguration 

System Audience configuration.  

com.orchestral.notification.deli

very.configuration.DeliveryChann

elConfiguration 

Delivery Channel configuration.  

com.orchestral.notification.deli

very.smtp.SmtpDeliveryChannelCon

figuration 

SMTP Delivery Channel configuration.  

com.orchestral.notification.dige

st.configuration.Digest 
Digest configuration.  

com.orchestral.notification.even

t.configuration.EventType 
Configuration of the Event Types.  

com.orchestral.notification.form

at.configuration.MessageFormats 
Global message formats.  

com.orchestral.notification.mode

l.aspect.impl.ReusableDataTypeAs

pectBean 

Indicates which data types can be 
reused in other data types. 

 
Use
rs 
can
not 
cha
nge 
the 
def
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Class Purpose Ma
nda
tory 
to 
Exp
ort
? 

ault
s. 

com.orchestral.notification.rela

tionship.configuration.Relations

hipTypeConfiguration 

Notification add-on configuration for 
com.orchestral.relationship.s

tore.generic.configuration.Ge

nericRelationshipType, must be 

exported together. 

 

com.orchestral.notification.rule

s.impl.aspect.ComparisionTypeAtt

ributeAspectBean 

Configures which comparison type to 
use for a particular data type. Used in 
situations where more than one 
comparison type could be used for a 
data type, forexamplethe date data type 
could be evaluated within Notifications 
by either a date comparison or a date 
offset comparison. 

 
Exp
ort 
if 
dat
e 
offs
ets 
are 
use
d. 

com.orchestral.notification.rule

s.model.ComparisonType 
It encapsulates the comparison types 
that are specified by the administrator 
for evaluating notification rules, what 
class is used during rule evaluation, and 
how to store the value into the 
configuration service. 

 

com.orchestral.notification.rule

s.model.NotificationRuleConditio

nContainer 

Notification rules Condition Container.  

com.orchestral.notification.rule

s.model.NotificationRuleConfigur

ation 

Notification rules.  

com.orchestral.notification.subs

cription.configuration.DefaultDe

liveryConfiguration 

Configuration of default delivery 
channels. 

 

com.orchestral.notification.subs

cription.configuration.DefaultSu

bscriptionConfiguration 

Configuration of default global 
subscriptions. 

 



Notifications 7.3.0 | Administration Manual v1.0  

 
 ____________________________________________________________________________________________________________  

 

 ____________________________________________________________________________________________________________  

Printed copies of this document may be out of date. Please refer to https://doki.orionhealth.com for the latest updates. 

© Copyright 2018 Orion Health Group of Companies | All rights reserved 164 

 

 

Identity Service Configuration 

Class Purpos
e 

Mandat
ory To 
Export
? 

com.orchestral.core.certificate.api_6_3.OhpCertificat

e 
Securin
g of 
Concert
o Portal 
web 
services 
(User 
Manage
ment 
and 
Privacy 
services
). 

 Will 
not 
success
fully 
migrate 
to a 
new 
environ
ment 
becaus
e of the 
private 
keys. 

com.orchestral.foundation.portal6helper.webservice.co

nfig.Portal6WebserviceServer 
Definitio
n of 
Concert
o Portal 
web 
service 
servers. 

 

com.orchestral.foundation.identity.IdentityServiceExe

cutorConfig 
Thread 
pooling 
configur
ation for 
the 
Identity 
Service. 

 

com.orchestral.foundation.identity.api_6_4.Group Identity 
Service 
group 
definitio
n. 
Currentl
y it is 
not 
mandat
ory to 
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Class Purpos
e 

Mandat
ory To 
Export
? 

export 
this 
because 
the user 
cannot 
edit 
groups 
in 
anyway 
but this 
is likely 
to 
change 
in the 
future. 

com.orchestral.foundation.identity.impl.AttributeImpl Represe
nts an 
attribute 
that can 
be 
defined 
for an 
identity. 
For 
example 
email or 
login to 
some 
random 
system. 

 

 

Class Purpos
e 

Mand
atory 
To 
Expor
t? 

com.orchestral.foundation.identity.impl.AttributeSchem

aImpl 
Identity 
Service 
attribut
e 
schema 
definitio
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Class Purpos
e 

Mand
atory 
To 
Expor
t? 

n. 
Currentl
y, it is 
not 
mandat
ory to 
export 
this 
becaus
e the 
user 
cannot 
edit 
groups 
in any 
way but 
may 
change 
in the 
future. 

com.orchestral.identity.source.portal6_6_14.config.Con

certoIdentitySourceConfiguration 
Configu
ration 
for the 
Concert
o 
Identity 
Source. 

 

com.orchestral.bespoke.identity.source.rde_2_0.patient

.RdePatientIdentitySourceConfiguration 
Configu
ration 
for the 
RDE 
Identity 
Source. 

 

com.orchestral.bespoke.privacy.impl.concerto.ConcertoP

rivacyServiceConfiguration 
Concert
o 
Privacy 
configur
ation. 
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Other Configuration 

Core configurations for Notifications are shown in the following table. These configurations 
are also used by other applications. 

Class Purpose Mandat
ory To 
Export? 

com.orchestral.foundation.messaging.tcp.admin.Inbou

ndEndpointConfiguration 
Contains 
the 
notificati
ons 
inbound 
messagi
ng 
configura
tion. 

 

com.orchestral.foundation.messaging.tcp.admin.Messa

geArchiveProfile 
Contains 
the 
notificati
ons 
message 
archive 
profile 
configura
tion. 

 

com.orchestral.foundation.messaging.tcp.admin.Outbo

undEndpointConfiguration 
Contains 
the 
notificati
ons 
outboun
d 
messagi
ng 
configura
tion. 

 

com.orchestral.core.database.impl.DatabaseDriverImp

l 
Contains 
a part of 
the 
database 
configura
tion. 

 

com.orchestral.core.database.impl.DatabasePoolingPr

ofileImpl 
Contains 
a part of 
the 
database 
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Class Purpose Mandat
ory To 
Export? 

configura
tion. 

com.orchestral.core.database.impl.DatabaseServerImp

l 
Contains 
a part of 
the 
database 
configura
tion. 

 

com.orchestral.foundation.concerto4xsecurity.api_6_

0.RedirectionKey 
Concerto 
4.x 
security 
keys 

 
These 
are 
automati
cally 
generate
d during 
installati
on. 

com.orchestral.foundation.concerto4xsecurity.api_6_

0.ValidationKey 
Concerto 
4.x 
security 
keys. 

 

 

 

 

Exporting and Importing an Event Type Configuration 

Every event type is associated with a Data Model that is stored in the Orion Health 
Platform Dictionary. For example, the Appointment Event Type is associated with the 
Appointment Model. Refer to Model Explorer for details. The association between event 
types and models is defined by the event type's modelIdentifierString element that 

contains the unique ID of a model stored in the Dictionary. 

Event type configurations are stored in the Platform Configuration Service but Dictionary 
models are not. When you export or import event type configurations, you also need to 
export or import the associated Dictionary models. 

Exporting Event Type Configurations 

1. From Orion Health Platform, navigate to Configuration > General > Configuration 
Explorer. 

2. Search for the Event Type that you want to export. 

https://doki.orionhealth.com/display/OHPClin810/Dictionary
https://doki.orionhealth.com/display/OHPClin810/Dictionary
https://doki.orionhealth.com/display/OHPClin810/Model+Explorer
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3. Select the event type. 

4. Select Export Selected. 

5. Open the downloaded configuration file. 

6. Copy the modelIdentifierString element. For example, uuid_7946d9be-fb65-

45c6-b2fe-666a789e60fe in Sample Event Type Configuration. 

7. From Orion Health Platform, navigate to Configuration > Data Services > Dictionary. 

8. Search for the modelIdentifierString element that you copied in the Model 

Explorer. You may need to click Refresh from the Dictionary tab for the Model to 
appear. 

9. Select Download in the Data Type Details section. 

Importing Event Type Configurations 

1. From Orion Health Platform, import the Platform Event Type configuration using 
Configuration Import. 

2. Import the associated Dictionary Model by navigating to Configuration > Data 
Services > Dictionary > Dictionary > Import a Model. 

Sample Event Type Configuration 

<?xml version="1.0" encoding="UTF-

8"?><com.orchestral.core.configuration.api_6_0.ConfigurationService 

xmlns="http://www.orionhealth.com/configuration" version="3" date="2016-03-

17T09:59:44.562" platformId="1256431113" type="SNAPSHOT" username="core-

platform:administrator"> 

    <com.orchestral.notification.event.configuration.EventType id="4951" 

version="1"> 

        <activityStreamExternalId null="true"/> 

        <activityStreamParams null="true"/> 

        <activityStreamSummary null="true"/> 

        <activityStreamTitle null="true"/> 

        <activityStreamUpdateTypeName null="true"/> 

        

<audienceKey>com.orchestral.notifications.configuration.audience.default</audienceK

ey> 

        <clinicalEventClass null="true"/> 

        <description>Booking, scheduled appointment items</description> 

        <detailMessageFormat>A patient for whom you are recorded as &lt;%var 

andcnt=0%&gt;&lt;%for each recipientQualifier in 

recipientQualifiers%&gt;&lt;%=recipientQualifier.description%&gt;&lt;% 

var andcnt = andcnt + 1 %&gt;&lt;%if andcnt &lt; recipientQualifiers.size%&gt; and 

&lt;%end if%&gt;&lt;%end for%&gt; has had recent activity at &lt;&lt; insert system 

name here &gt;&gt; 

&lt;%if patientSummary.Name[0].GivenName!=null%&gt;&lt;% var 

formatGivenName=patientSummary.Name[0].GivenName.substring(0,1).toUpperCase() + 

patientSummary.Name[0].GivenName.substring(1).toLowerCase()%&gt;&lt;%else%&gt;&lt;%

var formatGivenName=""%&gt;&lt;%end if%&gt; 

&lt;% if  patientSummary.Name[0].MiddleInitialOrName!=null%&gt;&lt;% var 

formatMiddleName= patientSummary.Name[0].MiddleInitialOrName.toUpperCase() 

%&gt;&lt;%else%&gt;&lt;% var formatMiddleName=""%&gt;&lt;%end if%&gt; 

&lt;%if patientSummary.Name[0].FamilyName!=null%&gt;&lt;% var 

formatFamilyName=patientSummary.Name[0].FamilyName.toUpperCase()%&gt;&lt;%else%&gt;

&lt;% var formatFamilyName=""%&gt;&lt;%end if%&gt;&lt;%var fullname = 

formatGivenName + " " + formatMiddleName + " " + formatFamilyName%&gt; 
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&lt;%if patientSummary.Gender.code = "M" %&gt;&lt;%var genderStmt = "He 

was"%&gt;&lt;%elseif patientSummary.Gender.code = "F"%&gt;&lt;%var genderStmt = 

"She was"%&gt;&lt;%else%&gt;&lt;%var genderStmt = "They were"%&gt;&lt;%end if 

%&gt;&lt;%for each notificationType in notificationTypes 

%&gt;&lt;%if  notificationType.type  = "Clinic Appointment Completed" 

%&gt;&lt;%=fullname%&gt; (unique identifier 

&lt;%=patientSummary.enterpriseIdentifier.identifier%&gt;) completed a clinical 

appointment with the &lt;%if 

eventContent.Department!=null%&gt;&lt;%=eventContent.Department.description%&gt;&lt

;%end if%&gt; specialty at &lt;%=eventContent.Location-PointofCare%&gt; location on 

&lt;%=DateFormat.format(eventContent.StartsAt)%&gt;. &lt;%if 

eventContent.AppointmentReason!=null%&gt;The appointment reason was 

&lt;%=eventContent.AppointmentReason.description 

%&gt;.&lt;%end if%&gt;&lt;%end if%&gt;&lt;%end for%&gt;</detailMessageFormat> 

        <modelIdentifierString>uuid_88207361-c358-11de-8a39-

0800200c9a66</modelIdentifierString> 

        <name>Appointment</name> 

        <sendToActivityStream null="true"/> 

        <subjectFormat null="true"/> 

        <system>false</system> 

    </com.orchestral.notification.event.configuration.EventType> 

</com.orchestral.core.configuration.api_6_0.ConfigurationService> 

 

 

Setting up the Grafana Dashboard 

Grafana is an open-source software which allows you to query, visualize, alert on, and 
understand your metrics. 

To set up the Grafana dashboard for Notifications: 

1. From Platform, navigate to General > Attachments. 

2. Select notifications-metrics.json from the Attachments list. 

3. Select notifications-metrics (application/json) from the Attachment 

Files list and then select Download Selected. 
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4. Log in to Grafana and then import the dashboard. Refer to Importing a Dashboard in 
the Grafana documentation for details. 

Make sure you have a Grafana server running and the data source is set to 
prometheus. Refer to the Grafana documentation for details. 

5. Check if the following panels and their corresponding metrics graphs are present: 

Panel Metrics Graphs 

Notifications Pipeline • Event 

• Queue 

• Delivery 

• Identify Resolution 

• Privacy Resolution 

• Relationship Resolution 

 

Digest Digest Process 

Subscriptions Subscription Service 

You may customize your Grafana dashboards and panels. Refer to the Grafana 
documentation for details. 

 

http://docs.grafana.org/reference/export_import/#export-and-import
http://docs.grafana.org/guides/getting_started/
http://docs.grafana.org/guides/getting_started/
http://docs.grafana.org/guides/getting_started/
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Configuring Communicate Webmail for Notifications 

Communicate Webmail is a web-based secure mail solution for sending and receiving 
direct messages. 

To send secure notifications through Communicate Webmail: 

 

• Configure the Communicate Webmail settings in Rhapsody 

• Update the Secure Webmail delivery channel in the Audience Details 

• Update the Secure Webmail Email Address 

If you are using Rhapsody 6, you do not need to perform the steps listed below. You 
can directly add the Communicate Webmail to the Delivery Channel list. Refer to 
Upgrading Notifications from 7.2.x to 7.3 for details. 

Configure the Communicate Webmail settings in Rhapsody 

1. Add the Communicate Webmail variables in Rhapsody: 

a. From the administration workstation, launch the Rhapsody IDE application. The 
initial screen is displayed. 

b. Navigate to View > Rhapsody Variables Manager to display the Rhapsody 
Variables Manager screen. 

c. Select the New button and then add the following variables and their 
corresponding values: 

Rhapsody Variable Name Description 

NOT_CommunicateWebEmailNotifi

cationFromAddress 
This refers to the email address 
displayed in the To field. 

NOT_CommunicateWebEmailSmtpSe

rverName 
This refers to the email server address. 

NOT_CommunicateWebEmailSmtpSe

rverUserName 
This refers to the email address used to 
authenticate to the SMTP server. 

NOT_CommunicateWebEmailSmtpSe

rverPassword 
This refers to the password used to 
authenticate to the SMTP server. 

The values for 
NOT_CommunicateWebEmailNotificationFromAddress and 

NOT_CommunicateWebEmailSmtpServerUserName can be the same. 

https://doki.orionhealth.com/display/NOT73/Upgrading+Notifications+from+7.2.x+to+7.3
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d. Select the OK button. 

2. Update the Notification Delivery Channel Distribution route. 

a. Expand the Notifications tree element. 

b. Expand the 2 - Out From Notification - Delivery service tree 

element. 

c. Select the 1- Notification Delivery Channel Distribution route. 

d. Select the conditional connector (deliveryMethodType matches 'Email' 

OR deliveryMethodType matches 'Direct') between the XML 

Notification Type Splitter and Email Server Bound Xml 

Notification Forwarder no-operation filters. 

e. Select the Add new condition link. The Edit Condition screen is displayed. 

f. Update the following fields: 

▪ Property Name: deliveryMethodType 

▪ Operator: Regular expression match (GNU) 

▪ Operand: SecureWebmail 

 

g. Select the OK button to save and close the Edit Condition screen. 

h. Select the OK button to save and close the Edit Conditional Connector 
screen.  
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3. Update the Send Email To SMTP Server route. 

a. Log in to the Rhapsody server using the Rhapsody IDE. 

b. Expand the Notifications tree element. 

c. Expand the 2 - Out From Notification - Delivery service tree 

element. Make sure the folder is selected. 

d. From the menu, navigate to Insert > New Communication point. The Create 
Communication Point screen is displayed. 

e. Select the e-mail client communication point with the name Outgoing 
Communicate Webmail. 

f. Select the Create button. Make sure the e-mail client Properties window is 
displayed. 

g. Set the mode Connection Mode to Output from the drop-down list. 

h. Select the OK button to save changes. 

i. Double click the route 3b - Send Email To SMTP Server. 

j. Drag the  Outgoing Communicate Webmail e-mail client to the Output 
section. 
 

k. Draw a conditional connector from the Email Content Forwarder no-

operation filter to the Outgoing Communicate Webmail Communication 

Point. 

l. Select the no conditions set link conditional connector created recently. 

m. Update the description to Communicate Webmail and then select the OK 

button. 

n. Select the Outgoing Communicate Webmail e-mail client and then select 
Configuration to set properties. 

o. Set the following properties for Outgoing Communicate Webmail and then select 
the OK button: 
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Property Value 

Protocol SMTP 

Port 587 

SSL Protocol Mode TLS 

 

 

 

1.  

a.  

i. Select the Communicate Webmail conditional connector between the 
Email Content Forwarder filter no-operation and Outgoing 
Communicate Webmail communication point. 

ii. Ensure the Communicate Webmail conditional connector filter opens-up 

iii. Select the Add new condition link. The Edit Condition screen is 
displayed. 

iv. Update the following fields: 

• Property Name: deliveryMethodType 

 

▪  

• Operator: Regular expression match (GNU) 

• Operand: SecureWebmail 
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i. Select the OK button to save and close the Edit Condition screen. 

ii. Select the OK button to save and close the Edit Conditional Connector 
screen. 

 

 

Update the Secure Webmail delivery channel in the Audience Details 

1.  

a. From Orion Health Platform, navigate to Configuration > Notifications > 
Notifications > Audiences. 
The Audiences tab lists the audiences in the left panel. 

b. Select the audience that you want to configure. The Audience Details section is 
displayed. 

 

 

c. Select the Add button and then select Secure Webmail from the drop-down list. 

d. Select the OK button. 
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e. Specify if you want to use Secure Webmail as a Primary Channel. 

f. Select the Save icon  to save your changes. 

Update the Secure Webmail Email Address 

1.  

a. Log in to Clinical Portal as a user. 

b. navigate to Notifications > My Subscriptions.  

c. Add the secure webmail address in the My Webmail field. 

d. Select the Save button to save your changes. 

Alternatively, you can also add the secure webmail address in the My 
Details screen. Refer to My Details for details. 

 

https://doki.orionhealth.com/display/NOT73/My+Details
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Event PatientSummary Processing 

• patientSummary/enterpriseIdentifier/idType is always set to the 

same value as patientSummary/enterpriseIdentifier/namespace. 

• patientSummary/Gender/suppliedDescription is always set to the 

same value as patientSummary/Gender/description. 

• patientSummary/Name/MothersMaidenName is always set to null. 

 

Update of Demographics Information Using Identity Service 

Every event sent to Notifications contains a PatientSummary section that stores the 
demographics information about the Patient it is associated with. 

Depending on the source of this information, the demographics information may not be up 
to date with the authoritative source of Patient Information. To rectify this, Notifications 
uses the Identity Service to retrieve the Patient's authoritative Identity information and 
updates the PatientSummary element accordingly. As a result, all messages sent out from 
Notifications will contain up to date demographics information. 

The following table describes how Notifications populates each section within the 
PatientSummary based on what is returned from the Identity Service: 

PatientSummary 
element 

Format 
expected 
from 
Identity 
Service 

Identity Service 
returns Correct 
format 

Identity Service 
returns Bad 
format 

Identity Service 
returns null 

enterpriseIdentif

ier 
N/A Enterprise 

Identifier Fields 
are set using the 
Patient's Primary 
Identifier. idType 
is set to the 
namespace. 

N/A Exception is 
thrown and the 
processing of 
Notification is 
discontinued. 

dateTimeofBirth YYYYMM
DD 

dateTimeofBir

th updated. 

dateTimeofBir

th is set to null 

and the 
processing of 
Notification is 
continued. 

dateTimeofBir

th is set to null 

and the 
processing of 
Notification is 
continued. 
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PatientSummary 
element 

Format 
expected 
from 
Identity 
Service 

Identity Service 
returns Correct 
format 

Identity Service 
returns Bad 
format 

Identity Service 
returns null 

Gender HL70001 
Gender 
Code 

 

Gender code, 
codingSystem, 
and description 
updated using 
the Codeset 
lookup. 

Gender is set to 
null and the 

processing of 
Notification is 
continued. 

Gender is set to 
null and the 

processing of 
Notification is 
continued. 

Name N/A Name fields are 
set to whatever is 
returned. 

N/A Name fields are 
set to whatever is 
returned. 

Implications on Mapping of Incoming Events 

PatientSummary mapping 

Events sent into Notifications may have their PatientSummary elements set by a 
Rhapsody route or CDR 8.7 Clinical Events. All fields, however, passed to the 
PatientSummary are overwritten by values retrieved from the Identity Service. If any 
element is already set in the Patient Summary and the Identity Service provides no 
appropriate value with which to replace it, it is set to null.This will ensure that 

PatientSummary of Events sent out by Notifications are completely consistent with the 
primary source of Patient Information. 

Thus, the only fields of the PatientSummary that Event must be populated with before they 
reach Notifications are the following: 

• patientSummary/enterpriseIdentifier/identifier 

• patientSummary/enterpriseIdentifier/namespace 

Use of Identifier Type versus Namespace 

Identifier Type and Namespace are both concepts used to describe the context of a coded 
value. In CDR 6 environments (for example: Core Package 3.1.1), Identifier Type is used 
predominantly wherein CDR 8 environments (for example, Core Package 4.2 and 4.3), 
Namespace is used instead. 

The Event Model /patientSummary/enterpriseIdentifier element contains both 

an idType and a namespace element. However, only the namespace field is used when 

looking up Patient Information using the Identity Service at any point during Notifications 
processing. In addition, when updating the PatientSummary element, idType is set to the 

same value as namespace and is, therefore, redundant. 

https://doki.orionhealth.com/display/CDR87/Code+Definitions#CodeDefinitions-Gender
https://doki.orionhealth.com/display/CDR87/Code+Definitions#CodeDefinitions-Gender
https://doki.orionhealth.com/display/CDR87/Code+Definitions#CodeDefinitions-Gender
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Thus, in CDR 6 environments, the HL7 to XML Notifications mappers in Rhapsody should 
map idType to the Event namespace field, not the idType field. In CDR 8 environments, 

namespace should be mapped to the Event namespace field. 

In later versions, idType will be removed from the PatientSummary of Notifications. 
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Monitoring Notifications 

This section includes the following topics: 

• Clinical Event Processing 

• Metrics 

 

Clinical Event Processing 

When using Notifications, you run the risk of blocking the processing of clinical 
events. The clinical events are blocked if a clinical event fails and keeps retrying until 
the cause of the transient error is fixed. The state of clinical event Notifications 
processing must be monitored regularly by an administrator after installation. This 
section describes the actions that need to be taken to prevent the blocking of Clinical 
Events processing. 

Clinical Event Processing Queue 

The processing of Clinical Events by Notifications is handled using a queue. Refer to 
Persistent Queues for details on Orion Health Platform queues. 

The queue used is named: TypedClinicalEventBus-
com.orchestral.notification.messaging.impl.NotificationMessagingSe

rviceImpl. 

It is possible for errors to occur when Notifications processes clinical events. They are also 
logged in the platform log with the message "An error occurred delivering message to 
<recipient address> for notifications <notification type>, this will be retried" and an error 
stack trace. In this case, all items, apart from the one that is being processed by 
Notifications, are in waiting status in the queue. The items in waiting status error. until the 
blocking item is fully processed. 

If a queue item is blocking due to an error in Notifications or due to some intermittent 
issue, other clinical events will not be processed until the blocking issue is resolved 
or the blocking message is suspended. 

If a queue item is blocking due to a non-intermittent issue, you must contact Orion 
Health Support for assistance in resolving the error. In this case, if these messages 
are not manually suspended, Notifications will not process further clinical events. 

If the messages are manually suspended, eventually, the suspend threshold can be 
reached.  Refer to Persistent Queues for details. In this case, clinical events will not 
be processed. This may mean that Orion Health CDR will stop processing some 
incoming messages. The threshold may be increased if the threshold is likely to be 
reached before the error can be resolved. 

https://doki.orionhealth.com/display/OHP74/Persistent+Queues
https://doki.orionhealth.com/display/OHP74/Persistent+Queues
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Monitoring Clinical Event Processing 

As errors in processing Clinical Events can block processing of other incoming messages, 
it is important to monitor the processing of Clinical Events to ensure any issues with it are 
identified as soon as possible. 

• If any transient error has occurred during the processing of a clinical event, the 
processing of the clinical event is retried. This can be monitored by looking at the 
platform logs for following ERROR level message: "Handling of typed 
Clinical Event has finished with error. Please check Orion 

Health Platform's log file for details." 

Any errors found during monitoring should be addressed immediately because these 
errors prevent other message processing. We strongly recommend contacting Orion 
Health support to address these errors. 

Notifications Delivery Queue 

The delivery of notification message is handled using a queue. Refer to Persistent Queues 
for details on Orion Health Platform queues. The queue used is 
named:com.orchestral.notification.delivery.impl.DeliveryServiceImpl

. It is possible for errors to occur when Notifications tries to deliver the message. If the 
message delivery has failed due to transient or configuration based error, the delivery is 
retried. If the message delivery has failed due to some unrecoverable error, the message 
is logged and dropped or suspended. 

Monitoring Notifications Delivery 

Since it is possible for the delivery queue to drop the message in some cases, it is 
important to monitor the delivery of notification messages to ensure any issues are 
identified. 

• If any transient error has occurred during the delivery of a notification message, the 
message is retried. This can be monitored by looking at the platform logs for 
following exceptions: DeliveryTransmissionException and 

MisconfiguredDeliveryChannelException. 

• If the message does not have a valid email address but is configured to be sent via 
the SMTP delivery channel, the message is dropped. This can be monitored by 
looking at the platform logs for the following exception: AddressException. 

• There is a possibility that the notification messages could be suspended in the 
delivery queue. The causes, however, for this are highly unlikely and will be readily 
visible from other system operations. Nevertheless, it is important to monitor the 
delivery queue for any suspended messages as the number of suspended 
messages allowed in a queue is limited. 

 

https://doki.orionhealth.com/display/OHP74/Persistent+Queues
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Metrics 

Overview 

Metrics is an internal application that provides services to other Orion Health™ Java 
applications and components for capturing information around system usage and provide 
further insight into it. Notifications has been instrumented with Metrics to output a range of 
metrics data that can be consumed by external metrics consumers. Metrics give a valuable 
insight into the performance of Notifications and can be used to quickly identify areas of 
concern. 

Refer to the Metrics documentation for details on metrics and configuring the 
application. 

Key Health Indicators 

Notifications publishes a wide range of metrics across a number of functional areas, some 
of which are very fine-grained. This table provides a coarse-grained targeted set of 
metrics, referred to as Key Health Indicators (KHI), for Notifications. These can be used to 
track the product's performance at a high level to ensure overall stability. These are better 
suited for dashboards and monitoring of the system. 

All metrics are under the notification namespace. 

All Notifications metrics have corresponding error metrics. For example, the 
notifications_digest_service metric has an equivalent error metric of 

notifications_digest_service_errors. 

Name Descrip
tion 

Tags Ty
pe 

notifications_delivery This 
measur
es the 
time 
taken 
for 
queued 
notificati
on 
messag
es to be 
delivere
d. 

Outbound: 

• <DeliveryChannelName> - This 

refers to the name of the delivery 
channel. 

 

Ti
m
er 

https://doki.orionhealth.com/display/MET11/Metrics+1.1
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Name Descrip
tion 

Tags Ty
pe 

notifications_digest_s

ervice 
This 
measur
es the 
time 
taken 
for 
Notificati
ons to 
handle 
requests 
for 
storing, 
loading, 
and 
processi
ng 
digests. 

Action: 

• create 

• get 

• process 

 

Ti
m
er 

notifications_document

_repository_service 
This 
measur
es the 
time 
taken 
for 
Notificati
ons to 
access 
the 
docume
nt 
exchang
e 
reposito
ry. 

Document Repository: 

• <Repository Name> - This refers 

to the name of the document 
repository. 

 

Ti
m
er 

notifications_identity_service This 
measur
es the 
time 
taken 
for 
Notificati
ons to 
resolve 
an 
identity. 

Type: 

• individual_identity 

• patient_identity 

• user_identity 

• group 

 

Ti
m
er 



Notifications 7.3.0 | Administration Manual v1.0  

 
 ____________________________________________________________________________________________________________  

 

 ____________________________________________________________________________________________________________  

Printed copies of this document may be out of date. Please refer to https://doki.orionhealth.com for the latest updates. 

© Copyright 2018 Orion Health Group of Companies | All rights reserved 185 

Name Descrip
tion 

Tags Ty
pe 

notifications_pipeline This 
measur
es the 
time 
taken 
for 
notificati
on 
messag
es to be 
queued 
for 
delivery. 

Inbound: 

• xml_event 

• typed_event 

• generic_event 

Event Type: 

• <EventType> - This refers to the 

name of the event type. 

 

Ti
m
er 

notifications_privacy_

resolver_service 
This 
measur
es the 
time 
taken 
for 
Notificati
ons to 
handle 
requests 
for 
evaluati
ng 
patient 
and 
informati
on 
privacy. 

Access Policy: 

• patient - This measures the time 

taken for Notifications to evaluate the 
privacy access levels of a patient. 

• information - This measures the 

time taken for Notifications to evaluate 
the privacy access levels of a specific 
resource. 

 

Ti
m
er 

notifications_recipien

t_resolver_service 
This 
measur
es the 
time 
taken 
for 
Notificati
ons to 
find 
recipient
s for a 
notificati
on. 

 Ti
m
er 
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Name Descrip
tion 

Tags Ty
pe 

notifications_relation

ship_resolver_service 
This 
measur
es the 
time 
taken 
for 
Notificati
ons to 
load 
active 
relations
hips of a 
patient. 

 Ti
m
er 

notifications_subscrip

tion_service 
This 
measur
es the 
time 
taken 
for 
Notificati
ons to 
handle 
requests 
for 
processi
ng, 
loading, 
or 
storing 
subscrip
tions 
and 
subscrip
tion 
configur
ations. 

Action: 

• update 

• process 

• get 

Source: 

• combined 

• subscriber 

• standard 

Service Type: 

• web - This indicates the configuration 

change is from a subscription page. 

• rest - This indicates the configuration 

change is from a REST request. 

• osgi - This indicates the internal 

interactions with the subscription 
service. 

 

Ti
m
er 

portal_application_redirector This 
measur
es the 
time 
taken 
for 
Notificati
ons to 

Application: 

• Notifications 

Entry Point: 

• My_Subscriptions 

 

Ti
m
er 
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Name Descrip
tion 

Tags Ty
pe 

load the 
subscrip
tions 
page. 

Thi
s 
me
tric 
is 
onl
y 
su
pp
ort
ed 
wh
en 
usi
ng 
Cli
nic
al 
Po
rtal 
8.9
.10 
or 
lat
er. 

 

ohp_event_service_queu

e_head_wait_time 
This 
measur
es the 
time a 
notficati
on 
messag
e will 
wait at 
the 
head of 
the 
persiste
nt 

Name: 

• com_orchestral_notification_d

elivery_impl_DeliveryServiceI

mpl - Queue name 

 

Ti
m
er 
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Name Descrip
tion 

Tags Ty
pe 

queue 
before 
being 
process
ed. 

Thi
s 
me
tric 
is 
onl
y 
su
pp
ort
ed 
by 
Me
tric
s 
1.1 
wit
h 
foll
owi
ng 
set
up
s 
in 
Pla
tfor
m: 

OH
P > 
Mo
nit
ori
ng 
> 
Me
tric
s > 
Sel



Notifications 7.3.0 | Administration Manual v1.0  

 
 ____________________________________________________________________________________________________________  

 

 ____________________________________________________________________________________________________________  

Printed copies of this document may be out of date. Please refer to https://doki.orionhealth.com for the latest updates. 

© Copyright 2018 Orion Health Group of Companies | All rights reserved 189 

Name Descrip
tion 

Tags Ty
pe 

ect 
Sc
ala
r 
un
der 
Ev
ent 
Ty
pe
s 
dro
p-
do
wn 
me
nu 
> 
Sa
ve 
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Notifications Rhapsody Routes 

 

Overview 

The Notifications Rhapsody routes are grouped in two folders, Notifications and Site 

Specific - Notifications. The base Notifications routes shipped by default with 

Notifications are contained under the Notifications folder. Any site-specific 

modifications to routes or additional routes should be done under the Site Specific - 

Notifications folder. Any changes made to the "Notifications" folder may potentially 

break the core functionality and may be overwritten by changes in later versions of 
Notifications. 

The core Notifications routes are further divided into the following: 

• 1 - In To Notification - handles incoming HL7 messages and transforms 

them into Notification event types before sending them to Notifications. 

• 2 - Out of Notification - receives outbound notification messages from 

Notifications and delivers them, for example, by Concerto User Messaging or email. 

Outbound Notification Delivery 

In the 1 - Notification Delivery Channel Distribution route, the XML 

Notification Type Splitter sends notifications to different routes based on the 

delivery channel. For example, notifications for the Email delivery channel are sent to the 

Email sending routes. 

Any new delivery channels will need routes added to send notifications via whatever 
delivery mechanism is needed, and a branch to send messages to these routes based on 
the delivery channel. 

EMR Channel Configuration 

Documents sent to EMRs will end up in the EMR delivery routes. These are then 
manipulated further depending on the type and sent to site-specific routes for delivery. 

• ORU (Observation Result) documents have their headers automatically 
manipulated for sending (e.g. generating unique message control id). They are then 
sent on to the 3- ORU Document Delivery site-specific route. This route can 

then make any further changes necessary to the message and send it via 
whichever delivery mechanism is appropriate. By default, it is simply saved to the 
"EMR Out" directory. This should be replaced with the appropriate communication 
point, e.g. TCP if the messages are to be delivered by TCP. 

 

• CCD (Continuity of Care) documents are transformed into an XDS request and sent 
to the 4 - CCD Document Delivery site-specific route. This can then have any 

further changes necessary and be delivered by whichever delivery mechanism is 
appropriate. By default, it makes a Simple SOAP web service request. 
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• All other document types are delivered to the 5 - Other Document Delivery 

route. Any transformations and delivery methods for other document types can be 
added here. By default, this saves the unchanged message to the EMR Out 

directory. 

EMR Integration 

EMR Integration with Rhapsody 

Notifications now ships with two Rhapsody routes, one for Rhapsody 3.x and one for 
Rhapsody 4.1 and up. Only the 4.1 routes include functionality to send documents to 
EMRs, as this requires a functionality not available pre-Rhapsody 4.1. 

The 4.1 Rhapsody routes look at the value of the documentType in the 

notificationDocument and process the message further based on this. 

With ORU documents, the content of the document is extracted, some adjustments are 
made to the header information, and the message is then passed through to the 3 - ORU 

Document Delivery route (under Site Specific - Notification). The message 

at this point is now an ORU suitable to be passed on to a system capable of processing 
ORU messages. Any further processing and sending of the ORU message should be done 
on the 3 - ORU Document Delivery route, as any part of the route before this may be 

changed as part of the upgrade to a later version of Notifications. By default, this route 
simply places the ORU message into the EMR Out directory. 

With CCD documents, the content of the document is extracted, along with values of the 
document metadata from the documentEntry element, and this is transformed into an 

XDR publish & register call. Some values are placed into the XDR request based on 
values in Rhapsody lookup tables. These tables should be populated with values 
appropriate for the site that Notifications is installed.  The values are listed in the following 
table. 

XDS_String_Values_Lookup  table: 

Key Usage 

subSourceId The OID of the source of the document submission. 

submissionUniqueIdPrefix The prefix of the unique OID of the submission. The 
Rhapsody route uses an incrementing counter and 
places this incrementing counter value (unique for each 
message) after the prefix. 

documentUniqueIdPrefix The prefix of the unique OID of the document (similarly 
used as the submissionUniqueIdPrefix). 
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XDS_Coded_Values_Lookup  table: 

(This table includes three values that are looked up- code, codeSystem and 

displayName, which correspond to the values that will be used for the code.) 

Key Usage 

docClass The code of the document class. (This value has been 
chosen to be valid for CCDs so should probably be 
retained.) 

docFormat The code of the document format. 

docPracticeSetting The code of the document practice setting. 

docHealthCareFacilityType The code of the document facility type. 

subContentType The code of the submission content type. (This value 
has been chosen to be valid for CCDs so should 
probably be retained.) 

Once the CCDs have been mapped to the XDR request, this is then passed through to the 
4 - CCD Document Delivery route (under Site Specific - Notification). 

Any further processing and sending of the CCD message should be done on the 4 - CCD 

Document Delivery route, as any part of the route before this may be changed as part 

of the upgrade to a later version of Notifications. By default, this route makes a web 
service request with the message unchanged. 

For messages with a document type other than ORU or CCD, the message is passed 
without change to the 5 - Other Document Delivery route (under Site Specific 

- Notification). Any processing and delivery of documents with site-specific 

document types can be done here. 

ORU Header Mapping 

The following Rhapsody variables are used to insert new values into the appropriate parts 
of the ORU header. If a value is needed for any of these, it can be provided as a value for 
the Rhapsody variable, and this will then be inserted into the header of all outgoing ORUs 
(replacing any value already there). 

Variable Default 

NOT_sendingApplicationNamespaceId Rhapsody 

NOT_sendingApplicationUniversalId  

NOT_sendingApplicationUniversalIdType  

NOT_sendingFacilityNamespaceId  

NOT_sendingFacilityUniversalId  

NOT_sendingFacilityUniversalIdType  
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Variable Default 

NOT_receivingFacilityNamespaceId any 

NOT_receivingFacilityUniversalId  

NOT_receivingFacilityUniversalIdType  

NOT_messageProcessingId P 

In Notifications 7.2.1, the following communication points are removed in the 3b – 

Send Email to SMTP Server route: 

• Outgoing Direct Email Server 

• Outgoing Direct Email Server (Documents) 

 

 

Changes to Rhapsody Routes - ORUs with Multiple OBRs and 
Textual Lab Results 

To ensure ORUs with multiple OBR segments are processed by Notifications, do the 
following to modify Notifications Rhapsody routes : 

1. Log in to the Rhapsody server using the Rhapsody IDE. 

2. Expand the Notifications tree element. 

3. Expand the 1 - In To Notification tree element. 

4. Create a new Route called 1b - ORU-based Models Trigger Event Msg 
Entry Point. 

5. Rename the following routes: 

o 1b - LaboratoryObservation Trigger Event Msg Entry Point→ 

1ba - LaboratoryObservation Trigger Event Msg Entry Point. 

o 1c - ImagingReport Trigger Event Msg Entry Point→ 1bb - 

ImagingReport Trigger Event Msg Entry Point. 

o 1d - TranscribeDocument Trigger Event Msg Entry Point→ 1bc 

- TranscribeDocument Trigger Event Msg Entry Point. 

o 1e - Appointment Trigger Event Msg Entry Point→ 1c - 

Appointment Trigger Event Msg Entry Point. 
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6. In the newly created route, do the following: 

a. Add the rde_CDR-REF-ORU-MODEL.s3d message definition to the route and 

set Startup State to Startup Third. 

b. Navigate to the rde_CDR-REF-ORU-MODEL.s3d tab in route properties and 

add the following Context Extractions: 

▪ Property Name: SendingApplicationNS, Messages: ORUR01, Field 
Paths: MSH.SendingApplication.NamespaceID. 

▪ Property Name: SendingFacilityNS, Messages: ORUR01, Field Paths: 
MSH.SendingFacility.NamespaceID. 

c. Add a new JavaScript filter with the name ORU OBR Message Splitter and add 
the following Javascript to it: 

//loop through all incoming messages 

for (var i = 0; i < input.length; i++) { 

  var readOnlyMessage = input[i]; 

 

  log.debug("Processing ORU Message " + (i + 1) + " of " + 

input.length); 

  var patientCount = 

readOnlyMessage.getRepeatCount("ObservationMessage"); 

   

  //loop through all patients (ObservationMessage[] array) in 

ORU message 

  for (var patientIndex = 0; patientIndex < patientCount; 

patientIndex++) { 

 

    //log.debug("Processing patient " + (patientIndex + 1) + " 

of " + patientCount); 

 var obrCount = 

readOnlyMessage.getRepeatCount("ObservationMessage[" + 

patientIndex + "]/ObservationRequest"); 

 

 //loop through all OBRs for current patient 

    for (var obrIndex = 0; obrIndex < obrCount; obrIndex++) { 

       

      //log.debug("Processing OBR " + (obrIndex + 1) + " of " + 

obrCount);   

      createSingleObrMessage(readOnlyMessage, patientIndex, 

obrIndex); 

    } 
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  } 

  //var message = output.append(readOnlyMessage); 

} 

 

function createSingleObrMessage(readOnlyMessage, patientIndex, 

obrIndex) { 

  log.debug("Creating copy of ORU message for 

ObservationMessage[" + patientIndex + "]/ObservationRequest[" + 

obrIndex + "] group"); 

   

  var text = readOnlyMessage.getField("MSH"); 

  text += readOnlyMessage.getField("ObservationMessage[" + 

patientIndex + "]/PatientInformation"); 

  text += readOnlyMessage.getField("ObservationMessage[" + 

patientIndex + "]/ObservationRequest[" + obrIndex + "]"); 

  var dsc = readOnlyMessage.getField("DSC"); 

  if (dsc != null) { 

    text += dsc; 

  } 

   

  var msg = output.append(readOnlyMessage); 

  msg.text = text; 

  msg.bodyEncoding = readOnlyMessage.bodyEncoding; 

} 

d. Add a Property Population filter with the name 'Repository Property Population' 
and create a variable called NOT_ORU_Repository that maps to the 

Rhapsody Variable NOT_Repository_Laboratory. 

e. Add a No-operation with the name ORU Models Filter and Redirect. 

f. Add three additional No-operation filters to the right of ORU Models Filter and 
Redirect and link ORU Models Filter and Redirect to each one using Conditional 
Connectors: 

▪ ORU LaboratoryObservation Msg Forwarder with the condition type Filter 
messages using a message property, Property Name being 
SendingApplicationNS, Operator Is one of the following values(case 
insensitive), Operands QS-LIS, SUNQ. 

▪ ORU ImagingReport Msg Forwarder with the condition type Filter 
messages using a message property, Property Name being 
SendingApplicationNS, Operator Is one of the following values(case 
insensitive), Operands QS-RIS. 

▪ ORU TranscribeDocument Msg Forwarder with the following conditions: 

• Condition type Filter messages using a message property, 
Property Name being SendingApplicationNS, Operator Is one of 
the following values (case insensitive), Operands HPF. 

• Condition type Filter messages using a message property, 
Property Name being SendingFacilityNS, Operator Is one of the 
following values (case insensitive), Operands OMC. 

g. Add outputs and join the filters and outputs as depicted in the following 
screenshot: 
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7. Expand the Site Specific - Notifications tree element. 

8. Edit the 1- Trigger Event Msg Entry Point so that all ORU messages are sent to the 1b 
- ORU-based Models Trigger Event Msg Entry Point route as shown in the following 
screenshot and perform the following actions: 

o Remove 1ba - LaboratoryObservation Trigger Event Msg Entry 

Point route from output. 

o Remove 1bb - ImagingReport Trigger Event Msg Entry Point 

route from output. 

o Remove 1bc - TranscribeDocument Trigger Event Msg Entry 

Point route from output. 

o Add 1b - ORU-based Models Trigger Event Msg Entry Point route 

to output. 

o Remove HL7 Laboratory Observation Msg Forwarder No-operation filter. 

o Remove HL7 Imaging Report Msg Forwarder No-operation filter. 

o Remove HL7 Transcribe Document Msg Forwarder No-operation filter. 

o Add HL7 ORU Models Msg Forwarder No-operation filter. 

o Add Conditional Connector between Filter and Redirect No-operation filter and 
HL7 ORU Models Msg Forwarder with the condition type Filter messages using 
a message property, Property Name being MessageType, Operator Regular 
expression match (GNU), Operand ORU. 
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9. In 1b - ORU-based Models Trigger Event Msg Entry Point route, join the 

input and ORU OBR Message Splitter JavaScript filter. 

10. In 1ba - LaboratoryObservation Trigger Event Msg Entry Point route, 

join the input and Laboratory Observation Trigger Event No-operation filter. 

11. In 1bb - ImagingReport Trigger Event Msg Entry Point route, join the 

input and Imaging Report Trigger Event No-operation filter. 

12. In 1bc - TranscribeDocument Trigger Event Msg Entry Point route, join 

the input and Transcribe Document Trigger Event No-operation filter. 

13. Apply the mapper changes specified in the attached MapperChanges.zip file. 

o Navigate to View > File Manager.... 

o Add the following mappers from the attached file: 

▪ NOT-LaboratoryObservationHl7ToXmlMapper-Fixed.mdf. 

▪ NOT-ImagingReportHl7ToXmlMapper-Fixed.mdf. 

▪ NOT-TranscribeDocumentHl7ToXmlMapper-Fixed.mdf. 

o In 1ba - LaboratoryObservation Trigger Event Msg Entry Point 

route, update LaboratoryObservaton HL7 To XML Mapper Mapper 

Definition File to the newly added (*-Fixed.mdf) mapper. 

o In 1bb - ImagingReport Trigger Event Msg Entry Point route, 

update ImagingReport HL7 To XML Mapper Mapper Definition 

File to the newly added (*-Fixed.mdf) mapper. 

o In 1bc - TranscribeDocument Trigger Event Msg Entry Point 

route, update TranscribeDocument HL7 To XML Mapper Mapper 

Definition File to the newly added (*-Fixed.mdf) mapper. 

14. Check in the changes and restart Rhapsody. 

https://doki.orionhealth.com/download/attachments/126146488/MapperChanges.zip?version=1&modificationDate=1516666248325&api=v2
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15. Remove notifications Rhapsody variables: 

The configuration in this step is optional. 

a. Login to the Rhapsody server using the Rhapsody IDE. 

b. Open the Rhapsody Variables manager. 

c. Remove the following variables: 

 

o  

▪ NOT_Repository_Microbiology 

▪ NOT_Repository_Radiology 

▪ NOT_Repository_TextLaboratory 

 

Changes to Rhapsody Routes - Clinical Events Support 

With the upgrade to new clinical event-based models (the default configuration), In to 
Notifications  routes are no longer required. Customers who decide not to use clinical 
event support still require these routes. 

Details on how to upgrade Notifications routes is described in Changes to Rhapsody 
Routes - Handling New Clinical Event-Based Models. 

 

https://doki.orionhealth.com/display/NOT73/Changes+to+Rhapsody+Routes
https://doki.orionhealth.com/display/NOT73/Changes+to+Rhapsody+Routes
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Privacy, Relationships, and Security 

 

This section includes: 

• Patient and Document Privacy 

• Relationship Service 

• Security 

 

 

Patient and Document Privacy 

 

Overview 

Notifications relies on Patient and Information Privacy in Orion Health Platform to control 
sensitive patient information being delivered to providers. Secure notification messages 
are delivered only when the evaluated access level is above a certain value. 

When an event message is received, a notification is generated if the message matches 
any of the notification rules. Privacy is then evaluated to determine which recipients are 
allowed to be notified. The recipient must have: 

• A relationship with the patient that corresponds to the incoming event. 
For example, the recipient is the patient's Primary Care Provider. 

• An appropriate level of access to the patient. 

To evaluate the access level, Notifications sends the following details to the Privacy 
Service: 

• The Patient's identifier 

• The Recipient's identifier 

• The event itself 

The Privacy Service evaluates privacy rules configured for the patient and the information 
type and returns the access level to Notifications. 

Configuring Privacy in Orion Health Platform 

For details on how to configure the Privacy Service in Orion Health Platform, refer to 
Privacy Service in the Clinical Infrastructure Implementation Guide. 

https://doki.orionhealth.com/display/public/CIPT812/Privacy+Service
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Information Type privacy configurations are not fully available when privacy service is 
in legacy mode. Refer to Privacy Service in Legacy Mode in the Clinical Infrastructure 
Implementation Guide for details. 

When a Non-system Event is created in the Notifications (Advanced) configuration, a 
corresponding Resource Type is created in the Privacy configuration. This resource type 
should be configured to apply the appropriate information type based on the content of the 
Notification object. 

When you configure information typing for Notifications Event Types, ensure that the 
logic is the same as the information typing for the data type itself. Using the same 
logic ensures that users are not notified about data they cannot view and are notified 
of all new data they should view. 

In the Resource Type script, your logic can reference information from within the 
Notification Data Model. For more information about the Notification Data Model, refer to 
Configuring Event Data Model. 

Use the following type of code to access data from within the Data Model in your Resource 
Type: 

var content = resource.getEvent().getEventData().getContent(); 

var labServiceCode = 

content.getValueOfAttributeAtPath("eventContent/service/code"); 

var labServiceCodingSystem = 

content.getValueOfAttributeAtPath("eventContent/service/codingSystem"); 

Privacy Access Level 

The following table shows privacy access levels and indicates whether Secure messages 
are delivered to them. 

Access 
Level 

Secure Message 
Is Delivered 

Reason 

No 
Access 

 

 

Provider does not have access to the information, so they 
are not notified. 

Locked  

 

Provider can see the information exists, but cannot access 
it, so they are not notified. 

Sealed  

 

Provider has to open the privacy seal to see the 
information, but can eventually access it, so they are 
notified. 

List More  

 

Provider has to open the privacy seal to see that the 
information exists, but can eventually access it, so they are 
notified. 

https://doki.orionhealth.com/display/CIPT812/Privacy+Service+in+Legacy+Mode
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Access 
Level 

Secure Message 
Is Delivered 

Reason 

Full 
Access 

 

 

Provider has unrestricted access to the data, so they are 
notified. 

 

Relationship Service 

The relationship store service relies on a database view to retrieve relationships between 
the patient who an incoming event is for and providers. 

Configuring the Relationship Data Source 

The relationship data source needs to be configured to connect to a database, which has 
a Relationship View or Table. 

Ensure that patient identity is validated against the EMPI / Demographic source 
before registering a relationship between that patient and a clinician in the 
RelationshipStoreGeneric relationship database. 

Relationship View/Table Schema 

The following table describes the relationship store view: 

Column Type Nullable Description 

patientidentifier VARCHAR2(255 
CHAR) 

 The identifier of the patient. This is 
the unqualified patient ID combined 
with the patientnamespace which 
uniquely identifies the patient 
involved in the relationship. 

patientnamespace VARCHAR2(255 
CHAR) 

 The namespace or assigning 
authority that issued the 
patientidentifier. This is used to 
scope the patientidentifier to form 
a unique id for the patient involved 
in the relationship. 

relatedEntityidentifier VARCHAR2(255 
CHAR) 

 The identifier of the entity that has a 
relationship with the patient. 
Generally, this is a provider but 
could also be an organization or 
team. As with patientidentifier, this 
is the identifier part of the ID that is 
qualified with 
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Column Type Nullable Description 

relatedEntitynamespace to form 
the unambiguous ID. 

relatedEntitynamespace VARCHAR2(255 
CHAR) 

 The namespace or assigning 
authority that issued the 
relatedEntitynamespace. This is 
used to scope the 
relatedEntityidentifier to form a 
unique identifier or the entity that 
has a relationship with the patient. 

relationshipType VARCHAR2(255 
CHAR) 

 The code identifying the type of 
relationship between the patient and 
the related entity. To be used this 
must match a relationship type 
defined in the relationship service. 
Refer to Additional Constraints for 
details. 

endDate DATETIME  The date when this relationship 
ceases to be valid. This is allowed 
to be null in which case the 
endDate is inferred from the 
startDate by applying a validity 
period determined by the 
relationshipType. 

startDate DATETIME  The date when this relationship 
becomes valid. This is allowed to be 
null in which case the relationship is 
assumed to be valid at any time 
until the endDate. 

 

Additional Constraints 

Constraint Description 

Uniqueness There should be a unique constraint across the following fields: 

• patientidentifier 

• patientnamespace 

• relatedEntityidentifier 

• relatedEntitynamespace 

• relationshipType 
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Constraint Description 

This is to ensure there is only ever a single relationship between a 
given patient and entity for a particular relationship type. 

 

Identifier 
References 

Both the patient and related entity identifiers (qualified by their 
namespaces) are resolved using the Identity Service. Therefore, whatever 
values are stored in these columns must correspond to the identifiers in the 
systems that the Identity Service loads from. 

Relationship 
Types 

Relationship types need to correspond to the codes of relationship types 
configured in the Relationship Service. It is permissible to have other 
relationship types in this view but they will be ignored by the Relationship 
Service. 

Indexes It is recommended the following be indexed in the underlying store since 
these are the fields the relationship service filters on: 

• patientidentifier or patientnamespace - It is recommended that 
there be a composite index on these fields as this is the primary 
selection criteria. 

• startDate - It is recommended the start date be indexed as it is used 
to filter the patient's relationships. 

• endDate - It is recommended the end date be indexed as it is used 
to filter the patient's relationships. 

 

 

 

Security 

 

Merging the configurations of Notifications into Clinical Portal adds a user group 
Notifications to Clinical Portal. By default, this user group has access to the Notifications 
Subscription screen. 

For a user or healthcare provider to be able to manage their own subscriptions to 
notifications, the user has to be added to the Notifications user group. 

To assign a user to the Notification user group, do the following: 

1. Log in to Clinical Portal as administrator and navigate to Concerto > Users. 

2. Search for and select the user you want to assign to the group. 

3. In the User Details screen, add the group Notifications to the Member Of list, as 
shown in the following screenshot: 
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Utilities 

 

This section includes the following: 

• Message Archive Datasource 

• Audit Logs 

• Enabling Performance Monitoring Using JAMon 

 

Message Archive Datasource 

 

Orion Health™ Platform stores a copy of every incoming and outgoing message in a 
message log. You can use this to investigate problems such messaging notification or 
rules evaluation. A message log data source is used to store messages. By default, this 
data source is based on an embedded database in Orion Health Platform. However, this 
should have been configured to point to an external Database during the installation 
process.  Oracle® and Microsoft® SQL Server are supported. Refer to the HIE Installation 
Manual for details. 

Accessing the Message Log 

To browse the archived messages, do the following: 

1. Log in to Orion Health Platform and navigate to Monitoring > Message Log to open 
the Message Log tab, as shown in the following screenshot: 
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2. Select a message port from the Message Log pane on the left to display the Endpoint 
Details in the pane on the right, as shown in the following screenshot: 
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3. Carry out any required actions: 

o Start and stop the messaging ports. 

o See archived messages for the messaging ports. 

o Select a message to display the request and response data of the message, as 
shown in the following screenshot: 
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The contents of the <notificationDocument><document> tag is base-64 
encoded. 

 

 

Audit Logs 

 

Notifications creates audit logging at various points while processing an event and sending 
the messages. The audit logs are stored in a shared audit database. Where Clinical Portal 
also uses the same database, you can review the audit logs from Notifications through the 
Clinical Log and Current Activity Log in Clinical Portal. 

Viewing Notification Audit Log with Clinical Log 

1. Log in to Clinical Portal as an administrator. 

2. Navigate to Monitoring > Clinical Log. 

3. Select Notifications from the Application drop-down list. 

4. Select the Search button to display the results. 

5. Use the other filter criteria to filter further the audit log set being returned. For example, 
selecting event types in the Other Events field and selecting the Search button again 
will display only audit logs of the selected event types. Some useful filter criteria for 
viewing Notification Audit Logs are listed in the following table: 

Filter Criterion Description 

Other Events Refer to Notification Audit Events for a list 
of event types for Notifications. 

Date Filter the audit logs by a date range. The 
start date and end date or both can be 
selected from the calendar control. 

6. Select a column header to sort the results based on the selected column. 
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Notification Audit Events 

Notification audit event types are listed in the following table: 

Audit Event Type Description 

Delivery channel 

created 
Audit the creation of a new delivery channel. 

Delivery channel 

deleted 
Audit the deletion of a delivery channel. 

Delivery channel 

updated 
Audit changes to an existing delivery channel. 

DeliveryConfiguration 

CREATE 
Audit the creation of a new delivery configuration for 
subscriptions. 

DeliveryConfiguration 

UPDATE 
Audit changes to the delivery configuration for 
subscriptions. 

DroppedTriggerEvent Audit the dropping of an incoming event when the 
evaluation of notification rule does not result in any 
notification type. 

DroppedNotification Audit the dropping of a notification which is about to be 
delivered to a provider who does not have the right to 
access the information of that patient due to patient 
privacy. 

EventType NEW Audit the creation of a new event type. 
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Audit Event Type Description 

EventType UPDATE Audit the changes to an existing event type. 

EventType DELETE Audit the deletion of an event type. 

NotificationDelivery Audit the success of delivering a notification to a recipient. 

NotificationType CREATE Audit the creation of a new notification type. 

NotificationType DELETE Audit the deletion of a notification type. 

NotificationType UPDATE Audit changes to an existing notification type. 

Subscription CREATE Audit the creation of a subscription. 

Subscription DELETE Audit the deletion of a subscription. 

Subscription UPDATE Audit changes for an existing subscription. 

GlobalFormatUpdate Audit changes to global message formats. 

Audit Event Details 

Select an entry in the audit log search result to open the audit log details dialog, as shown 
in the following screenshot. The details dialog displays additional information about the 
audit log and a list of audit log parameters. 
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Enabling Performance Monitoring Using JAMon 

 

Java Application Monitor (JAMon) is a Java monitoring tool that allows you to monitor the 
application behavior using the predefined modules such as SQL, HTTP page requests, 
Log4j, and exceptions.   

To enable performance monitoring using JAMon: 

1. From Orion Health™ Platform, navigate to Configuration > Authentication > User 
Domains and select the conductor security domain from the list. 

 

 

2. Under the Security Domain Details, select the  button and then select jamon from 

the context path list. 

 

 

3. Open a new browser window and then enter the URL in this format: http://server 

name>:<port>/jamon. 

The JAMon home page is displayed. 
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4. Select the Enable Monitoring button to enable performance monitoring using JAMon. 
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Notifications REST Services 

This page provides information about the Notifications REST Services used by Patient 
Portal's Notifications Manager screen. 

The information provided on this page can be used only for Patient Portal. 

REST Services 

Path Metho
d 

Parameters Return type Description 

/subscription-

rs/ping 
GET - String - "OK" Method to validate 

whether the service 
is accessible. 

/subscription-

rs/enable 
POST EnableSubscription

Dto 
String - "OK" Set global 

notifications 

enabled 

preference for the 
logged in user. 

/subscription-

rs/related/save 
POST SaveSubscriptionD

to 
String - "OK" Update the 

subscription 
preference for the 
logged in user to 
the specified 
identity. 

/subscription-

rs/related/enable 
POST EnableSubscription

Dto 
String - "OK" Set per patient 

notifications 

enabled 

preference for the 
logged in user. 

/subscription-

rs/notifications/rel

ated 

GET - Notifications
Dto 

Retrieves the 
subscription 
notification 
information 
including: 

• Notification 
subscription 
types 

• Delivery 
methods 
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Path Metho
d 

Parameters Return type Description 

• Subscription 
settings for 
each 
relationship 
the identity is 
related with 

• User 
preferences 
for 
notification 
enabled/disa
bled state: 

o Global for 
the user 

o Specific 
to each 
related 
identity 

 

 

Sample Response Data Transfer Object (DTO) 
 

"payload":{ 

  "groups":[ 

    { 

      "id":"AppointmentEvent", 

      "label":"AppointmentEvent", 

      "options":[ 

        { 

          "id":"83a4783e-2554-4dfe-948f-055151309675", 

          "label":"appointment cancelled" 

        } 

      ] 

    } 

  ],  

  "defaultSubscriptions":[ 

    { 

      "notification": 

        { 

          "id":"83a4783e-2554-4dfe-948f-055151309675", 

          "label":"appointment cancelled" 

        }, 

     "deliveryMethods":[], 

     "enabled":false, 

     "relationshipType":"Patient" 

   } 

  ], 

  "enabled":true, 
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  "subscriptions": 

   { 

    "84568-3168@OHCP": 

      { 

        "subscriptions":[ 

          { 

            "notification": 

              { 

                "id":"83a4783e-2554-4dfe-948f-055151309675", 

                "label":"appointment cancelled" 

              }, 

            "deliveryMethods":[ 

              "NoDeliveryChannel" 

            ], 

           "enabled":true, 

           "relationshipType":null 

          } 

       ], 

       "enabled":true 

      } 

   } 

} 
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Subscribing to Notifications for a User 

Notifications administrators can subscribe to notifications on behalf of a user. 

In the User Subscriptions screen of Clinical Portal, administrators can do the following: 

• Search for a Notifications user. 

• View and update the user subscription details when a user is selected from the 
User Subscription page. 

 

When selecting a user row from User Subscriptions Search, the User Subscriptions 
page is displayed. The administrators can do the following: 

• View the user's notification subscription page as users would do on the My 
Subscriptions page. 

• Update the user's delivery details and subscriptions as users would do on the My 
Subscriptions page. 
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Viewing an inactive user's subscriptions 

Inactive user subscriptions are read-only. The user's account must not be in the 
deleted state if you want to update the user subscription details. Refer to Deleting a 
User chapter in the Clinical Portal Administration Manual for details. 

 

When you change the subscriptions, a User Subscriptions Changed system event is 

triggered and a notification may be sent to the affected user. Refer to Adding and Deleting 
Event Types and Modifying Event Types for information about configuring events. 

 

 

 

https://doki.orionhealth.com/display/CP84/Deleting+a+User
https://doki.orionhealth.com/display/CP84/Deleting+a+User

